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If you have problems 

First make sure to check the “Troubleshooting” section in this document and the Knowledge 
Base on our website: www.palmsens.com/knowledgebase/ 
This page contains support information on installation, software updates, and training. 

Please make sure your software and firmware are up-to-date.  

In case of persistent problems: 
Use the contact form:    www.palmsens.com/contact/ 
Give us a call:    +31 30 2459211 
Or send an email:   info@palmsens.com 

Try to describe the problem as detailed as possible. Sending us the relevant method files, data 
files and screenshots can be helpful. 

Please include your instrument model and serial numbers, as well as any applicable software 
and firmware version you are using.  

Disclaimers  

PalmSens BV cannot guarantee that its instruments will work with all computer systems, 
operating systems, and third-party software applications hardware/software. The information 
in this manual has been carefully checked and is believed to be accurate as of the time of 
compiling. However, PalmSens BV assumes no responsibility for errors that might appear.  

 

See Appendix A for CE declarations of conformity. 

Copyrights  

PSTrace5 User Manual. Copyright © 2024, PalmSens BV, all rights reserved.  

PSTrace, MultiTrace, PalmSens, EmStat, MultiEmStat and Sensit are trademarks of PalmSens BV. 

No part of this document may be copied or reproduced in any form without the prior written 
consent of PalmSens BV. 
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1 Getting Started 

1.1 Software requirements 
System requirements for PSTrace: 

▪ Windows 10 or 11 (64-bit) 
▪ 2 GB RAM 
▪ Minimum display resolution: 1366 × 768 pixels 

Instrument requirements: 

▪ a single channel or multiplexed instrument from PalmSens BV; 
▪ or a multi-channel instrument from PalmSens BV (for controlling a single channel). 

Required for test measurements: 

▪ a sensor cable with crocodile clips and the PalmSens Dummy Cell. 

1.2 Making a reliable USB connection 
For a reliable and steady USB connection between your PC and the instrument, it is crucial to 
consistently employ the USB cable provided with the instrument by PalmSens BV. It is strongly 
advised against the use of USB cable extenders. Similarly, if feasible, it is recommended to 
refrain from utilizing a USB hub or docking station. 

Please make sure to always use the USB cable that was supplied 
with the instrument by PalmSens BV.  

1.3 Which model do I have? 
The instruments listed below can be used with PSTrace.  

Multi-channel instruments like MultiEmStat, MultiPalmSens and 
EmStat3-4WE are used with the MultiTrace software.  
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EmStat1  
(sold until 2010) 

 

 
EmStat2  
(sold until 2013) 

 
EmStat3 or EmStat3+  
(sold until 2022) 

 
EmStat4S LR or EmStat4S HR 

 
EmStat3 or EmStat3+ Blue  
(sold until 2023) 

 
EmStat4X LR or EmStat4X HR 

 
EmStatGo / EmStat4R 

 

 
EmStatMUX8 or EmStatMUX16  
(sold until 2017) 

 
EmStatMUX8-R2 
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PalmSens1 or 2  
(sold until 2013) 

 
PalmSens3  
(sold until 2017) 

 
PalmSens4  

 

 
Sensit Smart, based on EmStat Pico 

 

 
Sensit BT, based on EmStat Pico 

 
Sensit Wearable, based on EmStat Pico 

 

 
EmStat Pico Development Board 

 
EmStat4M Development Board 
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1.4 Installation 
Install PSTrace by running the setup.exe from the media that came with the instrument or, 
when downloaded, from the location where the downloaded ZIP file was extracted. 

After installation, a folder ‘PSData’ is created in your ‘My Documents’ folder. This folder 
contains some example method and data files. A PSTrace shortcut is placed in the Start menu 
and on the desktop. 

1.5 PSTrace basic principles 
The main window of PSTrace shows a Method Editor on the left-hand side which contains all 
measurement parameters and related information and a Plot area on the right-hand side which 
contains everything post-measurement related, including measurement results and analytical 
tools. 

 

 

Figure 1 PSTrace main window 

1.5.1 Methods 

PSTrace uses ‘Methods’ as a starting point for a measurement. A Method contains all 
measurement parameters like which Technique (Linear Sweep Voltammetry, Square Wave 
Voltammetry, Electrochemical Impedance Spectroscopy, etc.) is used and information about 
post-measurement actions like data smoothing and peak searching. All these parameters can 
be edited in the Method Editor which is found at the left-hand side of the PSTrace window.  
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The parameters can be saved to and loaded from a ‘.psmethod’ file using the menu: ‘Method’. 
These files do not include any data and only contain the measurement parameters settings as 
shown in the Method Editor.  

Switching between techniques or changes parameters in the 
Method Editor has no effect on anything that has already been 
measured and is displayed in the Plot. 

1.5.2 Measurement data 

As soon as a measurement is started a new ‘Measurement’ node appears in the Legend 
containing the default Curve for the corresponding technique. The Measurement contains the 
following information: 

▪ Method parameters (as was defined in the Method Editor) 
▪ Raw measurement data 
▪ One or more curves 

By clicking the Measurement in the Legend, the following window is shown: 

 

 

Figure 2 Pop-up window shown when clicking a Measurement in the Legend 

The window allows to change the Measurement title and notes directly. The notes shown here 
are a copy from the original Method used for this measurement. Also, the window allows to add 
new curves to the Plot based on the available Measurement data.  

The “View method parameters” button shows the original Method used for this Measurement. 
This Method is a copy from the original Method defined in the Method Editor that was used 
with the selected Measurement. 

1.5.3 Curves 

A measurement can contain one or more Curves. By clicking a Curve in the Legend a window is 
shown with information about the Curve. It allows you to directly change the title of the Curve 
as shown in the Legend or change its appearance or view the Data used for this curve.  
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Figure 3 Pop-up window shown when clicking a Curve in the Legend 

1.5.4 Saving your data 

All available Measurement data and curves as well as the Method as shown in the Method editor 
can be saved to a single ‘Session’ file (.pssession). Use the menu ‘Data’ to save and load Sessions. 
Any titles changed or customised Curve appearances like colour and symbols used are saved as 
well. 

1.6 Configuring PSTrace 
Before you start using PSTrace it is important that all settings are determined. The Settings 
window is always shown at the first start of PSTrace. 

The Settings window can also be found in the menu ‘Tools’ → ‘General settings…’. 

 

 

Figure 4 General settings in the Tools menu 
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Figure 5 Settings window 

1.6.1 Program modes 

PSTrace can run in three different modes.  
The mode can also be set using the button in the main window at the left corner. 
 

 

Figure 6 Mode-select buttons 

1.6.1.1 Scientific mode 

PSTrace operates primarily in Scientific mode, which serves as its default setting. This mode 
encompasses all the electrochemical techniques supported by the connected instrument and 
general tools designed for curve analysis. Users can engage in both automated and manual 
peak searches, facilitating the determination of peak potential, peak height, peak area, and 
peak width. Furthermore, users have the capability to conduct curve subtraction and apply 
linear regression to designated curve segments. 

1.6.1.2 Analytical mode  

The Analytical mode extends PSTrace for Voltammetric Analysis providing the possibility to do 
quantitative analysis by means of: 

▪ Standard addition 
▪ Using a calibration curve 

See also section: Analytical mode on page 213. 
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1.6.1.3 Corrosion mode  

The Corrosion mode of PSTrace translates the supported techniques to naming conventions 
generally used with Corrosion Analysis. Secondly a tab with analytical tools is added to the user 
interface for: 

▪ Linear polarization, from which the polarization resistance is obtained; 
▪ Tafel plots, from which the corrosion rate is obtained; 
▪ and Impedance data analysis by means of equivalent circuit fitting for determining 

values like polarization resistance and corrosion rate. 

See also section: Corrosion mode on page 221. 

1.6.2 Hardware configuration 

The tab ‘Hardware’ allows for setting the connected hardware configuration, so that the 
PSTrace interface shows the correct options. 

If the connected device does not have the option or functionality you select, the option will 
appear, but no measurement / data will be possible with the respective tab. Thus, you can let it 
checked if you are using alternately more than one device with different hardware options. 

1.6.2.1 Mains frequency 

The Mains Frequency is used by PalmSens or EmStat to eliminate noise induced by electrical 
appliances. 

1.6.2.2 BiPotentiostat module (BiPot) 

If PalmSens is equipped with a BiPot module, a second WE (Working Electrode) can be used. 
Enabling the BiPot will add a new tab to the Method Editor for settings the BiPot parameters 
and it is supported in the Manual Control tab. 

See also section: BiPotentiostat on page 44. 

1.6.2.3 Stirrer 

PalmSens or EmStat can be used with a stirrer which is activated during the conditioning and 
deposition phase of a measurement. It can also be controlled manually in the Manual Control 
tab. The stirrer is normally controlled using a Switchbox from PalmSens BV. In case a stirrer from 
BVT is used, its speed can be specified in the Manual Control tab. 

See also section: Manual Control tab on page 209. 

1.6.2.4 Multiplexer 

Check the ‘Multiplexer present’ checkbox if you are using a MUX8, MUX16 or MUX8-R2 
multiplexer. All multiplexers can either be in the form as an accessory with the potentiostat or 
have an integrated EmStat potentiostat. 

Use the button ‘Help select’ to see which model you are using. 

1.6.2.5 Comm options 

Check the ‘Bluetooth present’ checkbox if you are using an instrument that is Bluetooth 
enabled. Enabling this checkbox adds a small button with a Bluetooth icon in the Connection 
box, found in the upper left corner of PSTrace. 
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See also section: Connecting using Bluetooth on page 14. 

1.6.2.6 Auxiliary input 

Some instruments have an auxiliary input port that can be used to measure an external signal 
simultaneously with a measurement. The standard accessories provide by PalmSens BV that 
make use of the auxiliary port are listed when clicking the ‘Change aux. input’ button. 

 

 

Figure 7 The auxiliary input selection window 

A custom auxiliary input can also be added, for example the output of a spectrometer. If the 
analog output of any external device is linear, it can be translated to any given unit by setting 
the slope, offset and unit information. Alternatively, the ‘Calibrate’ button for calibration can 
be used to determine the offset and slope. 

 

 

Figure 8 Calibrate the selected auxiliary input 

Calibration can be done by setting two points to determine both offset and slope of the linear 
relation, or by just adjusting the offset. 
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A temperature sensor for example can be calibrated with a high precision thermometer used 
in a low temperature and high temperature medium to enter two different values, e.g. room 
temperature and in boiling water at around 100 degree Celsius. By using the ‘set point 1’ and 
‘set point 2’ buttons both the offset and slope will automatically be determined based on the 
given values. 

1.6.3 Plot and data 

The ‘Plot and data’ tab shows options on how to display and export measurement data. 

 

Figure 9 Settings window – Plot and data tab 

1.6.3.1 Preferred number format 

In case the local decimal separator is a comma instead of a point, the checkbox ‘Use local 
default decimal separator’ can be used to override this. 

1.6.3.2 Peak search options 

▪ ‘Automatic peak search’: If checked, automatic peak search is done on measured data 
or when data is loaded from a file. 

▪ ‘Use alternative peak search algorithm’: If checked, a different peak search algorithm 
is used which performs better on curves on a steep slope with no clear valleys. 
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Figure 10 Peaks found with the Alternative Peak Search option enabled. 

1.6.3.3 Enable options for selecting reference electrodes 

The checkbox ‘Enable options for E corrections’ adds options to specify the reference 
electrode used to the user interface of PSTrace. These new options can be found in the Method 
Editor and in the Plot toolbar: 

 

 

Figure 11 Set reference electrode used in the Method Editor. 

 

 

Figure 12 Extra toolbar added in plot with options to plot curves with potential values 
corrected for the reference electrode used.  

1.6.3.4 Data visualization convention 

 

Figure 13 Plot options for axes behavior 
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There are two common conventions for Voltammetric plots both of which are supported in 
PSTrace: 

▪ The IUPAC (International Union of Pure and Applied Chemistry) makes sure that anodic 
currents are plotted in positive direction and cathod currents in negative direction. 

▪ If the The Polarographic convention (also known as the North American, 
Polarographic, or Classic convention) is used, anodic currents will be plotted in 
negative direction and cathodic currents in positive direction. 

1.6.3.5 Export data to ZView 

Please take note that PSTrace offers an advanced built-in EIS 
spectrum analysis tool. The use of third-party tools such as 
ZView or EIS Analyser is entirely optional. 

Measured EIS data can be exported with one click to ZView. The location for ZView is detected 
automatically. If for some reason PSTrace cannot detect the location of ZView automatically, 
browse to the location of the .exe file manually. Please note that some older versions of ZView 
may not be compatible. However, you can still export the data through the 'Data' menu. 

See also section: ZView on page 130. 

1.6.3.6 Export data to EIS Spectrum Analyser 

Measured EIS data can be exported with one click to the free program EIS Analyser. To use the 
one-click-export button next to the plot, the location of this program needs to be set manually. 

See also section: EIS Spectrum Analyser on page 129. 

1.6.3.7 Export data to Origin 

Measured data can be exported with one click to Origin. To use the one-click-export button 
next to the plot, the location of this program needs to be set manually. Please note that some 
older versions may not be compatible. However, you can still export the data through the 'Data' 
menu. 

See also section: Exporting Curves on page 207. 

1.7 Connecting using a USB cable 
Make sure your instrument is powered on and connected to the PC using the USB cable that 
was supplied. Search for your instrument name on the displayed list and select it. However, 
note that certain first-generation PalmSens instruments may not be listed by their names but 
rather as a COM port. In such cases, choose the corresponding COM port associated with your 
instrument. 

 

Figure 14 Connecting with a device 
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If a USB cable was plugged in or switched on after PSTrace was started, use the ‘Refresh’ button 
 to reinitialize the list. 

PSTrace displays all available COM ports, inclusive of those not 
assigned to a PalmSens potentiostat. Attempting to establish a 
connection with unassigned COM ports or those associated with 
other devices may result in a connection error. 

1.7.1 Using a USB to serial converter 

This section only applies to PalmSens1 and PalmSens2 or an OEM 
product. 

In case a USB – RS232 adapter is used; the driver of the adapter has to be installed according to 
the manual of the adapter. The COM number used can be found in Windows’ Device Manager. 
This adapter requires a null-modem adapter (female-female) between the cable and PalmSens. 

To open the Device Manager quickly, press the Windows key  and the Pause/Break key on 
the keyboard of your computer simultaneously. Click the Hardware tab, and then click Device 
Manager. The installed COM port and its number are listed under Ports.  

Specify this number in the COM textbox in PSTrace if necessary. 

 

  

Figure 15 Make sure the right COM port is used in PSTrace 
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1.8 Virtual EmStat Pico 
This option is accessible in the instrument list, allowing for the development of 
MethodSCRIPT™ scripts without the need for a physical instrument. When connected, the 
software can generate MethodSCRIPT scripts for your methods, which can be viewed by 
clicking on the ‘Show MethodSCRIPT’ button below the Method Editor.  

See also section: MethodSCRIPT Sandbox on page 107. 

It's important to note that the virtual instrument lacks support for additional features available 
in our physical instruments, such as running measurements and controlling the cell. In 
instances where these actions do not result in an error message, the results are likely to be 
trivial. 

1.9 Connecting using Bluetooth 
To make a connection using Bluetooth, please follow these steps: 

1. In case of a PalmSens1 or 2; make sure your PalmSens1 or 2 is Bluetooth ready. This can 
be checked by a marking with ‘BT’ at the bottom of the instrument.  

2. Connect the provided Bluetooth dongle to the AUX port of the instrument or use an 
instrument with built-in Bluetooth capabilities, like the PalmSens4, Sensit BT or 
EmStat4X. 

3. Make sure your PC is equipped with Bluetooth capabilities. 
4. Make sure the ‘Bluetooth present’ is checked in the Settings window of PSTrace (see 

menu ‘Tools’ → ‘General settings…’)   

 

Figure 16 “Bluetooth present” check box 

5. Click the small button with the Bluetooth icon in the Connection box at the upper left 
corner of the main window. 
 

 

Figure 17 Search Bluetooth devices-button in the Connection box 
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If the device is not listed, wait briefly, and click the ‘Refresh’ 
button again. It can take some time before Windows has 
initialized all available Bluetooth devices.  

6. Select the Bluetooth instrument you want to connect to. The name consists of the 
letters PS, followed by the last four characters of the MAC address:  
PS-####. This address can usually be found on the instruments display or printed on 
the bottom of the housing. 

7. Click ‘Connect’. If this is the first time the PC is connecting to the Bluetooth extension, 
Windows will ask for pairing.  

In Windows 7 the message appears “A Bluetooth device is trying to connect.” 

In Windows 8, 10 or 11, the message appears “Add a device”. 

 

Figure 18 Message appearing in Windows 8, 10 or 11 

Click on this message and click “Allow”. When prompted for a code, enter 1234. 

Use pairing code: 1234 

8. If the pairing procedure took too long, the connection might have timed out. In this 
case repeat the last few steps starting with step 5. 

9. If the connection fails, try to remove the respective device PS-#### from the Bluetooth 
list, and start over. Pairing Bluetooth devices on Windows may present challenges, and 
it's not uncommon to encounter certain issues during this process. It's important to 
note that these challenges primarily stem from the Windows operating system itself 
and are not indicative of any problems with your device. 
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2 First measurements 

To get acquainted with the instrument, a TestSensor (until late 2017) or Dummy Cell (since late 
2017) is supplied to perform reproducible measurements.  

2.1 Which dummy cell do I have 
Before proceeding, please make sure to verify which dummy cell you have. See the next two 
images below for reference. 

 

Figure 19 PalmSens TestSensor A (shipped until late 2017) 

 

Figure 20 PalmSens Dummy Cell 

2.1.1 PalmSens TestSensor A 

The old PalmSens ‘TestSensor A’ has three stripped wires to connect to the electrodes using 
the provided croc clips. This test sensor simulates a RedOx circuit. The circuit contains two 
diodes in series in opposite direction with a cap in parallel and a series resistor. It simulates a 
non-diffusion limited RedOx system with a formal potential of 0 V. This circuit delivers i-E-
curves, for example with Linear Sweep Voltammetry, that show an S-shape. That means the 
curve follows the Nernst equation. This circuit is prone to noise and thus can be used to 
investigate the noise in your measuring environment. 
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2.1.2 PalmSens Dummy Cell 

The PalmSens Dummy cell offers three different circuits to check your system. To use the 
dummy cell, connect the croc clips to the corresponding connection pads on the dummy cell. 
The counter electrode (CE, black) and the reference electrode (RE, blue) are always connected 
to the same pads labelled CE and RE. The working electrode (WE, red) should be combined with 
the sense electrode (S, yellow/white) if present. For connecting the WE there are three 
different options.  

 

Figure 21 Schematics of the PalmSens Dummy Cell circuits 

▪ The WE A pad connects the working electrode to the same RedOx simulating circuit as 
found on the old TestSensor A. This circuit contains two diodes in series in opposite 
direction with a cap in parallel and a series resistor. It simulates a non-diffusion limited 
RedOx system with a formal potential of 0 V. This circuit delivers i-E-curves, for 
example with Linear Sweep Voltammetry, that show an S-shape. That means the curve 
follows the Nernst equation. This circuit is prone to noise and thus can be used to 
investigate the noise in your measuring environment. 

▪ The WE B pad connects the working electrode to a 0.1% accurate 10 kΩ resistor. This 

resistor delivers a straight line as i-E-curves, for example as a result of a Linear Sweep 
Voltammetry measurement, following Ohm’s law. 

▪ The WE C pad connects the working electrode to a simplified Randles circuit. This 
circuit will show in a Nyquist plot of an Electrochemical Impedance Spectroscopy (EIS) 
experiment a semi-circle, which is characteristic for an RC system (resistor and 
capacitor in parallel). 
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2.2 First measurement on the TestSensor 
This section describes how to do a first Linear Sweep measurement with any PalmSens BV 
instrument (EmStat or PalmSens-series) using the PalmSens TestSensor. 

Please follow these steps if you have a PalmSens TestSensor as shown in the picture below. 

 

Figure 22 PalmSens TestSensor A 

1. Make sure the instrument is on and connected to the PC 
2. Open PSTrace and connect to the instrument 
3. Load the following method file (menu: ‘Method’ → ‘Load’): 

‘User Name\Documents\PSData\PSDiffPulse.psmethod’  
4. Connect the TestSensor using the croc clips as shown in the picture above. 
5. Start measurement by clicking the start button in the toolbar. 

 

 

Figure 23 The Start measurement button in the toolbar 

6. See the picture below for the expected results. 

 

Figure 24 PSTrace  showing the expected results. 
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The TestSensor gives a current response in the order of nano 
amperes. This means that proper shielding is of significant 
importance. In case the curve shows a different shape than the 
one shown in the picture above, make sure to use a Faraday cage 
and connect the green GND lead to the Faraday cage.  
 
See also section: Reducing noise on page 51. 

2.3 First measurement on the Dummy Cell 
This section describes how to do a first Linear Sweep measurement with any PalmSens BV 
instrument (EmStat or PalmSens-series) using the PalmSens Dummy Cell. Please follow these 
steps if you have a PalmSens Dummy Cell. 

See also section: Which dummy cell do I have on page 17. 

1. Make sure the instrument is on and connected to the PC 
2. Open PSTrace and connect to the instrument 
3. Load the following method file (menu: ‘Method’ → ‘Load’): 

‘User Name\Documents\PSData\PSDummyCell_LSV_2V.psmethod’  
4. Connect the Dummy Cell using the croc clips: CE, RE to the corresponding pads and 

WE to pad WE_B (10k resistor). 
5. Start measurement by clicking start in the toolbar: 

 

 

Figure 25 The Start measurement button in the toolbar 

6. See the picture below for the expected results. 

 

 

Figure 26 PSTrace in Scientific mode 
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2.4 First EIS measurement on the Dummy Cell 
This section describes how to do a first impedance measurement with any PalmSens-series 
instrument using the PalmSens Dummy Cell. 

Please follow these steps if you have a PalmSens Dummy Cell.  

See also section: Which dummy cell do I have on page 17. 

1. Make sure the instrument is on and connected to the PC 
2. Open PSTrace and connect to the instrument 
3. Load the data file (menu: ‘Data’ → ‘Load data file…’): 

‘[USER]\Documents\PSData\EIS examples\ 
EIS on PS Dummy Cell WE_C.pssession’  

4. Connect the Dummy Cell using the croc clips: CE, RE to the corresponding pads and 
WE to pad WE_C (Randles Circuit). 

5. Select ‘Overlay’ in the drop-down next to the green start button: 
 

 

Figure 27 Selecting ‘Overlay’ in the drop-down list 

6. Start measurement by clicking start in the toolbar.  
7. See the picture below for the expected results. 

 

Figure 28 PSTrace in Scientific mode running EIS measurement 

2.4.1 Fitting your data 

Follow these additional steps to fit an equivalent circuit to your measurement data. 
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8. When the EIS measurement is finished, click the Circuit Fitting button at the top of the 
plot: 

 

Figure 29 The ‘Circuit Fitting’ button for opening the ‘Equivalent Circuit Analysis’ window. 

9. In the menu click ‘Circuit → Load’ and select the Simplified Randles circuit: 

 

Figure 30 The ‘Load circuit’ window 

10. Click the ‘Load’ button. 

11. Now click the ‘Fit Mode’ button. 

12. Click the ‘Fit’ button. 

13. The found results should be similar to the results shown in the table below. 

Table 1 Expected results when fitting the EIS data on a simplified Randles circuit 

Element Fitted Value Min Value Max Value Unit Error% 

R 1 557.5 1.00E-6 1.00E+12 Ω 0.065 

R 2 9966 1.00E-6 1.00E+12 Ω 0.035 

C 1 0.033 1.00E-6 1.00E+3 μF 0.064 

Chi-Squared: 4.60E-6 Iterations: 26 
  

See also section: Electrochemical Impedance Spectroscopy on page 113. 

2.5 Readings 
The status bar always shows the measured potential and the current as well as the noise if the 
cell is on. 

 

 

Figure 31 Status bar 
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The measured potential, current (BiPot current if present), and noise readings are shown right 
at the bottom of each channel’s Manual Control tab when the cell is set to ON. 

 

Figure 32 Readings window 

2.5.1 Underloads, overloads and oversteps 

The box showing the status is used to note whether the measured values contain a current 
overload, current underload, voltage overload or timing overstep. 

Measured current values are wrong when a current overload warning is shown in red. This 
occurs when the current is out of the range of the selected current range. A warning is given in 
orange for values that are exceeding 80% of the selected potential or current range. During a 
measurement with multiple ranges selected, the next current range, if available, will 
automatically be selected if this 80% threshold is exceeded. 

If currents are below 4% of the selected current range, a current underload warning is given, 
since a lower current range can be applied. An underload will yield measurements with a low 
resolution and accuracy. Select lower current ranges if available to increase the available 
current resolution and accuracy.  

See also section: Resolution and optimal current range selection on page 34. 

The noise bar shows the noise level at the current range in use. In case the bar shows orange or 
red, it is advised to look for ways to limit the noise level.  

See also section: Reducing noise on page 51. 

Voltage overload means that the impedance between the counter and the reference electrode 
is too high. This can be found when: 

▪ the counter or the reference electrode is not properly connected, 
▪ the conductivity of the solution is too low, which is overcome by adding an electrolyte, 
▪ an air bubble isolates the reference electrode from the solution. 

An overstep occurs when the anticipated interval duration cannot be achieved, resulting in a 
time between two data points that surpasses the interval time. This can happen if there is a 
glitch in the communication, for example due to a bad Bluetooth connection. Or if too many 
instructions are added in the measurement loop of a MethodSCRIPT, when using the 
MethodSCRIPT Sandbox. Another reason can be setting an interval time that is lower than the 
interval time supported by the hardware.  
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3 Measurements 

PSTrace allows to run all techniques supported by the connected instrument. This section 
explains how to set up a measurement. The options and limitations for each technique are 
described in the section: Electrochemical techniques on page 53. 

For information about impedimetric measurements, see section: Impedance Spectroscopy 
(EIS) on page 113.  

More theoretical background information about electrochemical techniques can be found in: 

▪ Christopher M.A. Brett and Ana Maria Oliveira Brett, Electroanalysis (Oxford Chemistry 
Printers, 64) Oxford Science Publications, ISBN-13: 978-0198548164 

▪ Joseph Wang, Analytical Electrochemistry 3rd ed, John Wiley & Sons, ISBN-13 978-
0471678793 

3.1 Connecting a cell to the potentiostat 
PalmSens potentiostats are delivered with a cell cable terminated with 2-mm banana plugs as 
the lead connectors for the cell / electrodes / sample (excluding some models that come with 
SPE connectors). Each lead is accompanied by a crocodile (alligator) clip of the same color. 

We advise keeping an unused lead connected with its crocodile 
clip. This practice prevents accidental electrical contacts with 
the exposed banana plug, minimizing the risk of unintended 
electrical contacts. 

See the following table for PalmSens’ standard cable lead colors. 
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Table 2 PalmSens standard cable lead colors 

Connector color Function Label 

Red Working Electrode W 

Black Counter / Auxiliary Electrode C 

Blue Reference Electrode R 

Green Ground ⏚ 

Black with yellow or 
Black with white* 

Sense lead S 

Yellow* Working Electrode 2 / BiPot (if BiPot module is installed) W2 

*Note: these leads are not present in all models, refer to your potentiostat model specification 
for more details.  

Most of PalmSens’ instruments offer a 2- or 3-electrode cell setup. Some models (i.e. EmStat3+ 
and EmStat4 HR series) also are compatible with a 4-electrode setup. 

Each electrode cable is individually shielded, and the entire cable features an external shielding 
mesh. The shielding extends up to the beginning of the banana plug. When you are using a 
Faraday cage, it is advisable to keep the entire banana plugs inside the Faraday cage housing to 
ensure the cage shields the banana plug.  

See also section: Reducing noise on page 51. 

3.1.1 2-electrode cell connection 

For a 2-electrode setup, combine the counter and reference electrode leads. The counter 
electrode plug of PalmSens cables is stackable, allowing for convenient combination. 
Subsequently, connect the working electrode lead to one electrode and the combined counter 
and reference electrode leads to the other.  

In models with a Sense lead, combine it with the working electrode, utilizing its stackable 
feature similar to the CE lead. 

 

 

Figure 33 2-electrode cell connection 

During a measurement in a 2-electrode setup, the potential will be applied between the two 
electrodes and the current will flow between the same two electrodes. This means the applied 
potential includes the potential drop across the working electrode’s interface, the potential 
drop across the solution, and the potential drop across the counter electrode’s interface. Any 
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changes at the counter electrode will influence the result. If your counter electrode is expected 
to be stable during the measurement due to low currents or a short duration of the 
measurement, you can use this setup almost equivalent to a 3-electrode setup. Otherwise, this 
setup is only used for applications where the full cell potential is an interesting parameter, for 
example, fuel cells, batteries, capacitors, dummy cells or electronic components. 

Please avoid connecting a self-powered sample, such as 
batteries, fuel cells or supercapacitors, to an unpowered 
potentiostat, as this action can potentially damage the 
equipment. It is advisable to disconnect the sample before 
turning off the potentiostat to mitigate any risk of damage to 
the device. 

3.1.2 3-electrode cell connection 

The 3-electrode setup is the most common configuration for electrochemical measurements. 
In this arrangement, connect the corresponding leads to the respective electrodes. If your 
potentiostat model includes a Sense lead, combine it with the working electrode. The Sense 
plug of PalmSens cables is stackable, allowing for convenient combination. 

 

Figure 34 3-electrodes cell connection 

Similar to the 2-electrode setup, the working electrode (and sense if present) carries the 
current and potential. In this setup, the counter electrode also carries the current and polarizes 
versus the working electrode (WE). However, the potential is measured between the working 
(or sense if present) and reference electrodes, denoted as WE(+S) vs. RE. This potential is the 
one set and read in the plot results. 

The potential WE vs. CE is referred to as the 'compliance potential,' and it is recorded in special 
cases.  

See also section: Recording the cell potential on page 42. 

In potential-controlled experiments, the potentiostat maintains a loop to ensure that the 
potential read (WE vs. RE) remains as programmed in the setup, consistently driving this 
potential towards the WE vs. CE polarization. 

This has the advantage that the potential drop across the counter electrodes interface is 
compensated. Another advantage is that the reference electrode does not carry any current 
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and will thus keep a stable potential during the measurement. This means the potential of the 
working electrode is more accurate and reproducible. 

3.1.3 4-electrode cell connection 

This setup is only possible just with instruments equipped with a 
Sense lead. 

In this configuration, you simply need to connect the corresponding leads to the electrodes, 
and no plug/lead combinations are required. 

 

Figure 35 4-electrodes cell connections 

The potential is measured between the sense lead and the reference electrode, while 
polarization drives the current flow between the working electrode and the counter electrode. 
This arrangement ensures that the potential drops across the counter or working electrodes' 
interfaces, and the associated reactions, do not contribute to the measurement. Processes 
specifically across the solution and obstacles, such as a membrane, between the sense and 
reference electrode, become the primary contributors to the measurement. 

This setup is rarely used, with some examples including research solid-state electrolytes, 
membranes, or liquid-liquid interfaces. 

3.1.4 Kelvin Connection 

In addition to traditional 4-electrode cell connections, the "Kelvin Connection" serves as a 
specialized version of a 4-electrode setup, while functionally operating as a 2-electrode 
configuration. Notably, the sample is still a 2-electrode cell, typically with a very low impedance 
(high conductivity). 

In the Kelvin Connection, like the 2-electrode connection, the CE lead is connected on the 
same side as the RE lead, while the WE lead is connected on the opposite side of the sample, 
alongside the Sense lead. The key distinction lies in its application when potential drops across 
cables and connectors must be meticulously considered. The primary objective of the Kelvin 
connection is to position the RE and Sense as close as possible to the sample. This proximity 
ensures that the impedance introduced by cables and connectors is effectively compensated 
through the functioning of the potentiostat. 
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Please avoid connecting a self-powered sample, such as 
batteries, fuel cells or supercapacitors, to an unpowered 
potentiostat, as this action can potentially damage the 
equipment. It is advisable to disconnect the sample before 
turning off the potentiostat to mitigate any risk of damage to 
the device. 

3.2 Setting up a measurement 
The ‘Measurement’ tab contains all the method parameters.  

By default, the software displays the main parameters maximized, and secondary parameters 
minimized. Groups of parameters can be minimized and maximized by clicking on the section 
headers. The secondary parameters can be toggled using the '…' buttons. 

 

Figure 36 Section headers and the ‘…’ button 

With each change of parameters, the validation of the method is checked. Errors or 
incompatibilities are shown instantly at the bottom of the measurement tab. 

 

 

Figure 37 Method Editor showing an error. 

Thus, the Method tab will prevent you from inserting a parameter that is outside the range of 
the connected instrument. If there is no instrument connected, PSTrace will allow you to 
exceed certain parameters, but warnings will appear as long as the device is connected.  
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If no instrument is connected, parameter validation is done on 
default values. The actual validity and limits can only be 
validated when the intended instrument is powered and 
connected. 

If a parameter can be reached but there is an observation, a yellow warning will appear. This 
warning is advisory and will not prevent you from running the measurement. 

3.2.1 Technique 

The techniques list shows the currently selected technique and allows the user to change it. 
When an instrument is connected, the techniques list will be updated to show only the 
techniques supported by the connected instrument. Changing program mode will also filter 
out techniques that are not supported by the selected mode. If no instrument is connected and 
the default Scientific Mode is active, the list will show all the techniques supported by PSTrace. 

See also section: Program modes on page 7. 

The parameters for each technique are saved when switching to another technique. This allows 
the user to switch between techniques without the need to change parameters each time. 

3.2.2 Sensor and sample 

The Notes textbox can be used to describe information for example about the sensor used and 
sample that is measured.  

 

Figure 38 The Notes box in the Method Editor. 

3.2.3 Current range 

 

Figure 39 Selection of allowed current ranges to be used during the measurement. 

The current range selection buttons determine which range(s) are used for the measurement. 
The gray boxes refer to unselected ranges, while the blue boxes refer to selected ones. The 
small arrow hovering above one of the selected ranges determines at which current range the 
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measurement starts. The starting range can be changed by means of clicking above one of the 
other selected current ranges. 

See also section: Resolution and optimal current range selection on page 34. 

3.2.4 Method settings 

Entered values for each method setting should be within the absolute limits any instrument by 
PalmSens BV can handle. If values are not supported by the instrument connected this is shown 
at the bottom of the method editor. See the next chapter for a description and allowed values 
of each parameter.  

3.2.5 Validation 

In case a value entered is invalid, an error message at the bottom is shown. Errors are shown in 
red and warnings are shown in yellow. In case of a warning, this can be ignored by the user and 
the measurement can be started. In case of an error, the values need to be changed first to a 
valid value to permit the start of the measurement.  

 

 

Figure 40 Error shown in the Method Editor 

A warning is shown in yellow. Warnings can be ignored but, on most occasions, this will result 
in a bad measurement due to wrong settings. 

 

 

Figure 41 Warning shown in the Method Editor 

In case a value for the step potential is given which cannot exactly be met by the instrument 
because of its hardware-determined resolution, the actual value is shown at the bottom as ‘real 
E step’.   

 

 

Figure 42 Real E step shown in the Method Editor 
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3.3 Standard measurement sequence 
Voltammetric measurements have the following sequence. 

 

Figure 43 Normal measurement sequence 

The sequence of a voltammetric measurement (except for stripping chronopotentiometry) is: 

1. In case “Measure vs OCP” option is enabled: determine the OCP. 
2. Apply ‘E condition’, the conditioning potential, if ‘t condition’ is not zero. 
3. Apply ‘E deposition’, the deposition potential, if ‘t deposition’ is not zero. 
4. Apply ‘E begin’ and wait ‘t equilibration’ seconds. 
5. Start measurement at ‘E start’ and continue until ‘E end’ with steps ‘E step’, with the 

specified ‘Scan rate’. In CV the scan is continued by reversing the scan direction. The 
current range is set automatically however with the constraints as specified. 

6. Depending on the potentiostat model, the measurement is plotted during the 
measurement or when the measurement is finished. 

7. If the cell must remain switched on, ‘E standby’ is applied; otherwise, the cell is 
switched off. 

The sequence of an amperometric measurement: 

1. In case “Measure vs OCP” option is enabled: determine the OCP. 
2. Apply ‘E condition’ the conditioning potential, if ‘t condition’ is not zero. 
3. Apply ‘E deposition’ the deposition potential, if ‘t deposition’ is not zero. 
4. Apply E or ‘E equilibration’ and wait ‘t equilibration’ seconds. 
5. Start the measurement.  

3.3.1 Pause and abort 

During the measurement, the curve is shown on the screen in real-time if the scan rate allows 
for it. In that case also the ‘Pause’ button can be used to halt the scan until the same button is 
used again. This button is not available at higher scan rates. 

It is possible to abort a measurement, by pressing the abort button above the plot.  
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Please note that when the ‘Stop’ or ‘Pause’ button is pressed, the 
potentiostat will complete the current measurement point. This 
can happen almost instantly in most cases, but it might take 
some time in situations like low-frequency impedance or very 
large time intervals. 

3.3.2 Cell on after measurement 

A standby potential can be set in the ‘Post measurement’ section in the Method Editor. The 
duration can be set using the ‘For specified period’ checkbox. This potential is applied after the 
measurement has concluded for the specified time duration or indefinitely if this parameter is 
not selected. 

 

 

Figure 44 Using cell on after measurement. 

3.4 Measuring versus OCP 
As a standard practice, the potentials set in PSTrace refer to the values of the Working Electrode 
(WE) relative to the Reference Electrode (RE). This potential is also known as the "Polarization 
Potential". However, in many measurements, the potential can be specified with respect to the 
Open Circuit Potential (OCP) instead. This approach is commonly employed in corrosion and 
some energy-related applications.  

In case one or more potentials are specified with respect to the OCP, this potential must be 
determined before the actual measurement is done. This OCP measurement requires a variable 
time, which is determined by the drift of the open circuit potential and the maximum time to 
measure the OCP value. The OCP value is set as soon as the drift is lower than the specified value 
for the ‘Stability criterion’ or when the ‘t Max. OCP’ has elapsed. Thus, setting ‘Stability criterion’ 
to zero renders it ineffective. 
 

 

Figure 45 OCP parameters 
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3.5 Resolution and optimal range selection 
The Method Editor shows one or two rows of buttons for the current and potential ranges. The 
potential ranges are only visible when a galvanostatic technique is selected.  

With the range-buttons, the applicable current range(s) and potential range(s) during the 
measurement can be selected. If more than one button is selected, the instrument will select 
the most optimal range automatically (auto-ranging).   
A measurement starts at the range with the small arrow above it. 

 

 

Figure 46 Selection of applicable current and potential ranges shown for Potentiometry 

The starting range can be changed by means of clicking above one of the other selected 
current ranges changes.  

Double-clicking a range button will select only this range. 

3.5.1 Automatic range selection / auto-ranging 

During equilibration, the most appropriate range will be selected. If during a measurement the 
current or potential approaches a range limit, the instrument will switch automatically to a 
more suitable current or potential range (lower or higher). When a measurement exceeds the 
upper threshold (80% of the range), a higher range is selected within the range of selected 
ranges.  

Likewise, when a measured current or potential falls repeatedly below the lower threshold (4% 
of the selected range), a lower range is selected if enabled by the user.  

Because auto-ranging takes some time (in the order of milliseconds) this feature is only 
available at lower scan rates. For techniques at very high scan rates automatic ranging is not 
available. This is always shown as an error in the Method Editor if this is the case. 

Table 3 The maximum measured currents for each instrument. 

Instrument Max. measured current 

EmStat1, 2 and 3(+) ±2 * selected range 

PalmSens1 and 2 ±2 * selected range 

PalmSens3 ±3 * selected range 

PalmSens4 ±6 * selected range 

EmStat4 LR and HR ±3 * selected range 

EmStat Pico ±0.6 * selected range 

 
An overload warning is given for measured values ≥ 80% of the selected range. 
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For all instruments except for the EmStat Pico an underload warning is given for measured 
values ≤ 4% of the selected range. For the EmStat Pico the underload warning is given for 
measured values ≤ 2% of the selected range. 

For instruments that support multiple potential ranges, the table below shows the available 
range for each instruments. 

Table 4 The maximum measured potentials for each instrument. 

Instrument Max. measured potential 

PalmSens4 ±10 * selected range 

EmStat4 LR  ±3 * selected range 

EmStat4 HR ±6 * selected range 

3.5.2 Spikes and jumps 

Please note that auto-ranging can cause spikes in the measurement curve, especially during 
fast measurements and/or measurements with high Faradic currents. Spike or jumps may occur 
due to a short interruption or change in measurement interval when switching between the 
ranges.  

If auto-ranging is not needed it is always better to enable a single 
current range to prevent spikes or jumps in your curves.  

If you are uncertain about the current you will obtain, and the experiment requires manual 
range selection, start with the highest current range. You can then lower it in subsequent 
attempts if you still receive underload readings, even at the highest resulted currents. 

3.6 Running a measurement 
Measurements can be started and stopped with the buttons in the measurement tool strip or 
the ‘Measure’ menu.  

The steps conditioning, deposition, and equilibration can be skipped each using the skip 
button. 

 

 

Figure 47 Skip button 

Next to the start button, you can choose to make a ‘New’ graph for the measurement. If 
‘Overlay’ is selected, the measured curve will be added with another color to the existing curves 
in the plot. Or measure a ‘Blank’ curve as a background scan to subtract it later. 
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Figure 48 Options for the next measurement 

If a blank curve is present an additional button is shown, see below. By enabling this button, the 
blank will be subtracted automatically after the measurement is finished.  

See also section Blank subtraction on page 45. 

 

 

Figure 49 Use Blank button 

The progress and status of a measurement is shown in the status bar at the bottom. 

 

Figure 50 Status bar 

3.6.1 Autosaving measured data 

If autosave is enabled, every single measurement will be saved automatically in the 
corresponding format after the measurement has finished or is aborted.  

See also section: Files on page 235. 

 

 

Figure 51 Enabling autosave 

The autosave output can be configured in the Autosave settings window. 
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Figure 52 The Autosave Settings window 

3.6.1.1 Output settings 

The output file gets the prefix followed by a sequential number. This number is based on the 
number of existing files with the given prefix in the storage folder specified and therefore 
increments with each new file added to the folder. 

3.6.1.2 Output data formats 

The output file can be stored in different formats. The PSTrace format will store the file in a 
format that can be loaded in PSTrace again.  

See also section: File types on page 235. 

A CSV file is a comma-separated file and can easily be imported into third party programs like 
Excel and Origin.  

As a third option, it is possible to store the data in a native Origin file format. The latter will also 
include a graph (except for EIS data). 

3.6.1.3 EIS data export settings 

The button ‘EIS data export settings’ allows which columns are exported to the non-PSTrace 
file formats. 
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3.6.1.4 Multiple curves output 

Some measurements produce multiple curves, like a Cyclic Voltammetry measurement with 
multiple scans or a measurement done with a multiplexer. Enabling the checkbox will save the 
output of each separate curve to a single file instead of to a single file containing the data of all 
curves.  

3.6.2 Recovery file  

 

Figure 53 Recovery file settings 

The ‘Autosave settings’ window also shows options for keeping a recovery file during 
measurements. This option can be useful for long-term measurements. In case of a PC crash or 
power outage, the most recent measurement data will still be available. The recovery file is 
overwritten for each new measurement.  

3.6.3 On-device storage 

The PalmSens4, EmStat4-series and Sensit BT are equipped with additional hardware for on-
board data storage. In case the option ‘Save on internal storage’ is checked, the measurement 
will be stored on-board the instrument in a folder with the name of the day’s date.  

 

 

Figure 54 Save on internal storage in the Method Editor of PSTrace 

The on-board data can be browsed and downloaded using the menu: ‘Data’ → ‘Load data from 
internal storage…’. 

For the PalmSens4 the following techniques are excluded for on-
board storage:  
EIS, MultiStep and MixedMode.  

 



PSTrace Manual » Measurements 

PSTrace Manual 39 

3.7 Peaks and levels 

 

Figure 55 Peak/Level parameters tab (showing options for a technique as a function of time) 

Table 5 Parameters in the Peak/Level parameters tab  

Minimum Peak Width determines the minimum peak width. Peaks with a 
lower width may not be detected. The peak width is the 
Full Width at Half Maximum (FWHM). 

 
 

Minimum Peak Height determines the minimum peak height. Peaks lower than 
this value are neglected. 
 

Smooth Window determines to which degree the measured curve is 
smoothed. The specified number is used to smoothen 
the data using the Savitzky-Golay method. 
Please note that too many points will influence the 
shape of the curve 

Extra options for methods vs time: 

Oxidation or Reduction determines whether peaks or current levels are positive 
(Oxidation) or negative (Reduction). 

Current Level or Peaks determines whether peaks or current levels are 
measured 

3.8 Multiplexer 
In the Multiplexer tab, it can be specified which multiplexer channels are measured and 
whether they should be measured consecutive (one by one) or scanned alternately (all 
channels simultaneously).  



PSTrace Manual » Measurements 

40 PSTrace Manual 

When the ‘Consecutive’ mode is chosen, any channel can be selected. In case ‘Alternate’ is 
checked, the manual selection of channels is limited to successive channels. So, it is possible to 
measure 2 to 8 or 2 to 16 successive channels, depending on the type of multiplexer in use.  

 

 

Figure 56 Multiplexer parameters 

3.8.1 Consecutive measurements 

When doing Consecutive multiplexer measurements, the active multiplexer channel will switch 
to the next and be started after the entire measurement as defined in the Measurement tab has 
finished. This mode is available for every technique. 

3.8.2 Alternate measurements 

During the execution of alternating multiplexer measurements, all chosen channels will rapidly 
switch within each measurement interval. The complete switching process, including both 
switching and stabilization, for the multiplexer takes approximately ±31 milliseconds. As a result, 
the lower limit of the interval time is defined as (number of channels selected) * 0.031 s. For 
instance, when using all 8 channels, the minimum interval time is 0.25 seconds. 

The following techniques support the Alternate multiplexer mode: 

▪ Chronoamperometry; 
▪ Chronopotentiometry; 
▪ Open Circuit Potentiometry; 
▪ and (Galvanostatic) Electrochemical Impedance Spectroscopy. 

3.8.3 MUX8 and MUX16 hardware settings 

The multiplexer can be used in different configurations. For the older models, dip-switches are 
available on the underside of the multiplexer to change the configuration.  

See also section: MUX8 and MUX16 multiplexers on page 265. 

3.8.4 MUX8-R2 settings 

The MUX8-R2 hardware configuration settings can be defined in software and will become 
visible in the ‘Multiplexer’ tab if the MUX8-R2 is either detected upon connection or selected 
in the ‘General Settings’ window. 
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Figure 57 Multiplexer MUX8-R2 hardware configuration settings 

When switching techniques, the initial MUX8-R2 settings will be taken from the default settings 
as defined in the settings window of PSTrace. However, when saving a method to either a 
.psmethod file or .pssession file the settings will be saved as present in the ‘Multiplexer’ tab. 

See also section: MUX8-R2 multiplexer on page 275. 

3.9 Recording an auxiliary input 
Supported by all instruments with an auxiliary input port. 

To record an auxiliary value, like an analog input voltage, temperature or cell potential, this 
needs to be enabled in the Method Editor in the section ‘Record additonal data’: 

 

 

Figure 58 Enabling recording on the auxiliary input in the Method Editor 

Whether or not recording additional data is supported depends 
on a combination of the connected instrument and the selected 
technique. 

If the checkbox ‘Record Aux. input’ is checked, the voltage of the corresponding analog input 
pin on the physical auxiliary port is recorded. The auxiliary input value can also be translated to 
another value, like temperature, RPM (For an RRDE) or pH, depending on what is connected. 
This can be set in the ‘General Settings’ window.  
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See also section: Hardware configuration on page 8. 

Please refer to the instrument-specific sections in this manual for more information about the 
positions of the digital and analog I/O pins on your instrument’s auxiliary port. 

3.10 Recording the cell potential 

Supported by a selection of techniques with PalmSens4, EmStat4 
and EmStat Pico. 

Recording the cell potential can be enabled in the Method Editor in the section ‘Record 
additional data’: 

 

Figure 59 Enabling recording the cell potential in the Method Editor 

The ‘cell potential’ is the potential between the working and the counter electrode and thus 
the potential applied to the whole cell. In other words, this is the working electrode’s potential 
versus the counter electrode’s potential. This potential is also called “Compliance Voltage”, and 
as such, this specification refers to the maximum potential that can be applied between WE and 
CE. 

 

 

Figure 60 Cell potential 

Sometimes it is interesting to calculate the potential of the counter electrode versus the 
reference electrode. This can be easily calculated with the applied potential and the cell 
potential. As is visible from picture above the cell potential is calculated by 

 

𝐶𝑒𝑙𝑙 𝑃𝑜𝑡𝑒𝑛𝑡𝑖𝑎𝑙 =  𝐸(𝑊𝐸) − 𝐸(𝐶𝐸) 
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By rearranging the potential of the counter electrode E(CE) can be calculated by 

𝐸(𝐶𝐸) = 𝐸(𝑊𝐸) − 𝐶𝑒𝑙𝑙 𝑃𝑜𝑡𝑒𝑛𝑡𝑖𝑎𝑙 

 

For the EmStat Pico, as well as the Sensit series instruments, 
there is a limitation when recording cell potential. In certain 
situations, the recorded cell potential values may reach a certain 
limit below the actual value. 

3.11 Recording the WE potential 

Supported by a selection of techniques with (Multi)PalmSens4 
and (Multi)EmStat4. 

Recording the WE potential can be enabled in the Method Editor in the section ‘Record 
additional data’: 

 

Figure 61 Enabling recording the WE potential in the Method Editor 

The ‘WE potential’ is the applied potential between the working and the reference electrode. 
This option can be enabled to measure the applied potential during supported Voltammetric 
and Amperometric techniques on supported devices and can be used to determine if the 
instrument was able to apply the requested potential. 

3.12 Recording the WE current 

Supported by a selection of techniques with PalmSens4 and 
EmStat4. 

Recording the WE current can be enabled in the Method Editor in the section ‘Record 
additional data’: 
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Figure 62 Enabling recording the WE current in the Method Editor 

The ‘WE current’ is the applied current between the working and the reference electrode. This 
option can be enabled to measure the applied current during supported Potentiometric 
techniques on supported devices. The current will be measured in the applied current range. 
In the case of an OCP measurement, the current will be measured in the current range as 
specified in the ‘Select current range(s) selection’ bar. 

3.13 BiPotentiostat 

Supported by instruments with bipotentiostat functionality for 
using a second working electrode (WE2). 

If a BiPot module is present in a PalmSens instrument and the ‘BiPot present’ setting is checked 
in the ‘Settings’ window, the second working electrode or WE2 can be used. Please note that 
the WE2 will be measured/polarized versus the same RE and CE used for the main WE1. 

The Settings window can be found in the menu: ‘Tools’ → ‘General Settings…’ 

 

Figure 63 Select BiPot present in Settings window 

In case one of the channels has a BiPot module present, this will be detected automatically. 

An additional tab ‘BiPot’ will become visible in the method editor. This tab contains the settings 
for the use of the second working electrode (WE2). 
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Figure 64 The additional BiPot tab in the Method Editor. 

The E WE2 is the potential set on the WE2.  

The BiPot can be used with the following methods: 

▪ Linear Sweep Voltammetry 
▪ Cyclic Voltammetry 
▪ Amperometric Detection 
▪ Multistep Amperometry 
▪ Multistep Potentiometry 

3.13.1 Plot i(WE2) vs E(WE1) 

The plot window will show the current obtained for WE1 as well as for WE2 or Auxiliary.  

In case the checkbox ‘Plot i(WE2) vs E(WE1)’ is checked the i(WE2) curve will always be shown 
as an overlay in the plot, also when WE2 was maintained at a fixed potential. 

3.14 Blank subtraction 
Blank subtraction can be used by first running a measuring as ‘Blank’ using the dropdown list 
next to the Start button. Or an existing curve can be designated as a Blank curve by clicking on 
this curve in the plot legend. 

 

Figure 65 Select ‘Blank’ to measure a Blank curve for Blank subtraction before clicking the 
Start button. 
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Figure 66 By changing the curve function in the curve tool window, which is accessed by 
clicking on a curve in the plot legend. 

When a Blank has become available, the ‘Use Blank’ button appears next to the measurement 
controls in the bar on the top of the screen.   

When enabling the Use Blank button, the available Blank curve is subtracted immediately after 
the measurement from the measured curve. The Blank Curve is always shown in gray in the plot. 

 

 

Figure 67 Button for Blank subtraction 

3.15 Ohmic (iR) compensation 
This setting is found under the  button for advanced settings. 

iR Compensation is optionally available for  
the PalmSens4 and EmStat4X.  

The resistance between the reference electrode and the double layer of the specimen can 
cause a significant potential drop, decreasing the applied potential where it is required. This 
potential drop (Eohm) is called “Ohmic drop” and it is directly proportional to the electrolyte 
resistance (R) and the actual current (i), thus Eohm = iR. 

The compensation module provides a “positive feedback” to compensate for the iR drop 
between the Reference electrode and the outside of the double layer of the electrochemical 
cell. 
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The resistance to compensate for can be entered directly in the Method Editor in PSTrace: 

 

 

Figure 68 Resistance to compensate for as specified in the Method Editor 

PalmSens recommends that instruments with iR-compensation module also have EIS capability, 
as it is the most common and straightforward technique for determining the resistance to be 
compensated. If the resistance of the electrolyte is accurately determined, then set the 
compensation to a maximum of 95% to prevent system instability. 

Please note that if auto ranging is not allowed for the compensation used in combination with 
the selected current ranges, this is shown in the Method Editor: 

 

Figure 69 Error shown in Method Editor 

Make sure a single current range is selected in these circumstances. Moreover, each current 
range has a maximum resistance that can be compensated for. 

See the following sections for more instrument-specific limitations: 

▪ iR compensation with PalmSens4 on page 305 
▪ iR compensation with EmStat4X on page 337 
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3.15.1 Supported Techniques 

The following techniques are supported for use with iR compensation: 

▪ Linear Sweep Voltammetry 
▪ Cyclic Voltammetry 
▪ Square Wave Voltammetry 
▪ Differential Pulse Voltammetry 
▪ Normal Pulse Voltammetry 
▪ Chronoamperometry 
▪ Multistep Amperometry 

3.16 Potential and current limits 
The settings for current and potential limits are found under the  button for advanced 
settings. 

The limits entered here apply to the entire measurement excluding the pretreatment stages. 
This parameter is also called “cut-off”.  

If the referred measurement is inside a Script sequence, thus the Script will continue to the next 
step. 

This resource is not available in some instruments.  

3.17 Override bandwidth filter 
This setting is found under the  button for advanced settings. 

This function is only supported and visible when a MethodSCRIPT-enabled device like EmStat 
Pico or (Multi)EmStat4 is connected.  

 

Figure 70 Bandwidth override setting in the Method Editor 

Normally the filters of the potentiostat are set optimally for the required bandwidth. In some 
exceptional cases it is useful to override the automatically determined bandwidth setting.  

When the ‘Override bandwidth’ checkbox is set, the setting will be overridden with the value 
given in Hertz. 
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3.18 Digital triggers 
This setting is found under the  button for advanced settings. 

 

 

Figure 71 Hardware trigger settings 

In case “Trigger at …” is set, the selected digital line(s) on the AUX port of the instrument will 
be set high when triggered. They will remain high until the end of the measurement. 

See the instrument-specific sections in this manual for more information about the position of 
the digital pins on your instrument’s auxiliary port. 

In case “Trigger at delay after start” is used, the delay will be rounded to the applicable interval 
time between each measured data point. 

3.19 Measuring the noise level of the instrument 
To determine the environmental noise levels, make sure the (green) test sensor is connected 
or the (blue) PS Dummy Cell is connected on pads RE, CE and WE_A.  

1. Load method file ‘PSNoiseTest.psmethod’.  
2. Start measurement.  
3. Repeat the measurement but with a scan rate of 0.05 V/s. Note that the noise level is 

lower because the current sampling time is longer now. This decreases the measured 
noise level. 
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Figure 72 The curve shown in the figure above is a typical curve measured using the 
unmodified PSNoiseTest method and a PalmSens2. The sensor and connections are housed 
inside a grounded Faraday Cage. 

In case the noise level is too high this might bes due to a noisy power supply of the USB ports 
and therefore the use of a USB Hub with its own ac-adapter between the PC or laptop and 
EmStat is advised.  

  

Figure 73 The green (noisy) and red curves are both measured with the same conditions as 
before and with the same EmStat. The red curve is obtained when EmStat is connected to a 
USB hub instead of directly to a USB port of the PC. 

The instrument can be controlled manually using the ‘Manual Control’ tab.  

To evaluate noise levels in the Manual Control tab click ‘Cell On’. Change the applied potential 
from E= 0.000 V to E= 0.500 V by manipulating the horizontal scrollbar or entering the value 
in the textbox. Select the current range of 10 nA (or 100 nA if 10 nA is not available). The 
measured values of the potential and current as well as the noise are shown. 

If the noise bar shows orange or red, the noise level is high. You are advised to place the test 
sensor inside a Faraday cage with the green ground lead connected to the cage. 
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3.20 Reducing noise 
Electrochemical sensors and cells are susceptible to noise. If noise is interfering with your 
measurement, the solving strategies are rather numerous, but the sources for noise are also 
numerous. Here we describe the most successful and common methods for noise reduction. 

Your power grid is usually using an alternating current. This undulating current influences the 
measured currents. PSTrace and PStouch have a filter setting for this mains frequency. Check 
in the Tools menu under General Settings if the mains frequency is set correctly. 

Noise can also be introduced through the USB port of your computer. In that case using an 
external hub with its own power supply could reduce this noise. 

Our environment is filled with electrical fields. Some of them are created by devices around us 
as side effects or in case of wireless communication on purpose. Although it is a bad idea to 
measure directly next to an electric arc furnace, it is usually not possible to have a workspace 
free of electrical fields, especially not during point-of-care measurements. A Faraday cage is 
usually sufficient to create a field-free environment. A metal box or cage out of metal mesh is a 
good Faraday cage. Even a shield out of aluminum foil can help. Place your electrochemical cell 
inside the Faraday cage and connect the cage to the ground lead (green) of the potentiostat. 
The cable delivered with your EmStat or PalmSens has an inbuilt shield and should protect your 
signal outside the Faraday cage. This is one of the most effective methods to reduce noise. 

Be cautious to avoid accidental contact between electrodes or 
plugs and the Faraday cage. A short circuit between the Faraday 
cage (and thus the ground lead) and an electrode can lead to 
current leakage, resulting in incorrect responses and potential 
damage to the potentiostat in some cases. 

Cables should not be excessively long, as they can inadvertently function as antennas that 
captures electromagnetic noise. However, the cables provided with your EmStat or PalmSens 
instruments include built-in shielding. When you use the original cable, concerns about noise 
induced by the cable are minimal. Nevertheless, avoid using extensions, but if they are 
necessary, they should be used within the Faraday cage. 

Ground your measurement equipment. The best way to connect your equipment is star-
shaped, that is all parts are connected with the ground at the same point. In an electrochemical 
lab that point is usually one small space of the Faraday cage. This way earth loops that induce 
noise are avoided. 

Check if the contacts are corroded. If so, remove the stains, for example with sandpaper. 

The Readings window (shown during the time the cell is on) displays the potential and the 
current and shows the noise level. The background color shows whether the noise might 
deteriorate the measurement. In case the noise level is higher than 0.1 times the selected 
current range, the bar will turn orange. In case the noise level exceeds 0.5 times the selected 
current range, the bar turns red. It is strongly advised to prevent measurements under such 
conditions. 

The EmStats and Sensits are directly powered by the USB port. Some PC’s or laptops have a 
noisy USB power supply. In this case, it is advised to use a USB hub with its own ac-adapter 
between the PC or laptop and EmStat. 
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If you find that the suggestions to reduce noise haven't produced the desired results, it's 
possible that your data collection parameters need adjustment. If your results still appear noisy 
or jagged, consider increasing the 't interval,' 'E step,' or 'i step' parameters to achieve 
smoother data. Increasing these parameters will result in a more gradual change in time, 
potential, or current values, respectively, and can help in obtaining more refined and less 
fluctuating results. Experimenting with these settings may enhance the quality and precision of 
your data. 
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4 Electrochemical techniques 

PSTrace supports the following techniques in the (default) Scientific Mode. Some instrument 
models only support a selection of these techniques. At the beginning of each technique-
specific section is a list with the instrument models supporting the technique. All the above-
listed techniques are described in this section, except EIS/GEIS. 

See also section: Electrochemical Impedance Spectroscopy on page 113. 

Table 6 All available techniques in PSTrace 

Voltammetric techniques  

▪ Linear Sweep Voltammetry LSV 

▪ Cyclic Voltammetry CV 

▪ Fast Cyclic Voltammetry FCV 

▪ AC Voltammetry ACV 

 

Pulsed techniques  

▪ Differential Pulse Voltammetry DPV 

▪ Square Wave Voltammetry SWV 

▪ Normal Pulse Voltammetry NPV 
 

Amperometric techniques  

▪ Chronoamperometry CA 

▪ Zero Resistance Amperometry  ZRA 

▪ MultiStep Amperometry MA 

▪ Fast Amperometry FAM 

▪ Pulsed Amperometric Detection PAD 

▪ Multiple-Pulse Amperometric Detection MPAD 
 

Galvanostatic techniques  

▪ Linear Sweep Potentiometry LSP 

▪ Chronopotentiometry CP 

▪ MultiStep Potentiometry MP 

▪ Open Circuit Potentiometry OCP 

▪ Stripping Chronopotentiometry SCP (or PSA) 
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Coulometric techniques  

▪ Chronocoulometry CC 
 

Other  

▪ Mixed Mode MM 

▪ Electrochemical Impedance Spectroscopy EIS 

▪ Fast Electrochemical Impedance 
Spectroscopy 

FEIS 

▪ Galvanostatic Electrochemical Impedance 
Spectroscopy 

GEIS 

▪ Fast Galvanostatic Electrochemical 
Impedance Spectroscopy 

FGEIS 

4.1 Linear Sweep Voltammetry (LSV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.1.1 Description 

In Linear Sweep Voltammetry a potential scan is performed from the begin potential, ‘E begin’, 
to the end potential ‘E end’. The scan is not exactly linear, but small potential steps (E step) are 
made. The current is measured (sampled) during the last 25% interval period of each step. The 
number of points in a curve showing the current versus potential is 

 (E end – E begin) / E step + 1. 

The scan rate is specified in V/s, which determines the time between two steps and thus the 
sampling time. The interval time is equal to E step / scan rate. So, when E step is 0.005 V and 
the scan rate 0.1 V/s the interval time is 0.05 s. 

4.1.2 Measuring 

Increasing the ‘E step’ is suitable for rapid data collection and may improve the signal-to-noise 
ratio. On the other hand, decreasing the step potential is advantageous when you require 
enhanced resolution, sensitivity, and the ability to study complex electrochemical systems in 
detail. It's essential to strike a balance between scan rate, resolution, and sensitivity based on 
the characteristics of your electrochemical system and research goals. As a start point, it is 
common to use ‘E step’ between 0.003 and 0.01V for Scan rates in the range of 0.01 to 0.1 V/s. 

In some applications, it is important that the current does not get too high. This might ruin the 
working electrode. If the potential at which this will occur is not known, it is possible to specify 
a maximum current value at which the scan stops. In this case, the end potential specified by 
the user may not be reached. 
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See also section: Potential and current limits on page 48.  

 

Figure 74 Potential versus time during Linear Sweep Voltammetry 

 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

By default, the result shown is a graph of Current versus Potential. 

 

Figure 75 Typical LSV plot for a non-diffusion limited redox system and the WE_A of the 
PalmSens Dummy Cell. 
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4.1.3 Technique specific parameters 

E begin The potential where the measurement begins at. 

E end The potential where the measurement stops at. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

E step The potential step size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 
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Scan rate The applied scan rate, also called sweep rate or sweep speed. The 
applicable range depends on the value of E step since the data 
acquisition rate is limited by the connected instrument.  
 
The applicable scan rates for each instrument are: 
 

PalmSens1 and 2 1 mV/s (1 mV step) to 
25 V/s (5 mV step) 

PalmSens3 0.02 mV/s (0.15 mV step) to 
500 V/s (5 mV step) 

PalmSens4 0.02 mV/s (0.075 mV step) to 
500 V/s (10 mV step) 

EmStat1 and 2 0.02 mV/s (0.1 mV step) to 
5 V/s (5 mV step) 

EmStat3(+) 0.025 mV/s (0.125 mV step) to 
5 V/s (5 mV step) 

EmStat4 LR 0.01 mV/s (0.1 mV step) to 
500 V/s (200 mV step) 

EmStat4 HR 0.01 mV/s (0.183 mV step) to 
500 V/s (200 mV step) 

EmStat Pico 0.01 mV/s to 10 V/s (10 mV step) 
 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.2 Cyclic Voltammetry (CV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.2.1 Description 

In Cyclic Voltammetry, recurrent potential scans are performed between the potentials 'E 
vertex1' and 'E vertex2,' going back the number of times determined by the 'Number of scans.' 
The scan starts at the begin potential (E begin) which can be at one of these vertex potentials 
or anywhere in between. The experiment will always terminate at the same potential set as the 
'E begin'. 

The change of the potential per time is the scan rate. The scan rate is specified in V/s, which 
determines the time between two steps and thus the sampling time. The interval time is E step 
/ scan rate. So, when E step is 0.005 V and the scan rate 0.1 V/s the interval time is 0.05 s. 

The scan is not exactly linear, but an approximation by means of a staircase with small potential 
steps (E step). The current is measured (sampled) during the last 25% interval period of each 
step. The number of points per scan of the current versus potential curve is 2 * (E end – E begin) 
/ E step. 

The following graph shows the signal applied and the periods of current sampling.  
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Figure 76 Potential versus time during Cyclic Voltammetry 

4.2.2 Measuring 

As in LSV it is sometimes important that the current does not get too high. This might ruin the 
working electrode. If the potential at which this will occur is not known, it is possible to specify 
a maximum current value at which the scan direction will reverse. If the current set is reached, 
it will reverse the scan direction before the next vertex. 

The user can also interactively determine where the scan direction is reversed, using the button 
‘Reverse’.  In these cases, the specified vertex potential by the user may not be reached. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

As in LSV, by default, the result shown is a graph of Current versus Potential. Successive cycles 
will be displayed in different colors. 
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Figure 77 Typical CV plot for a free diffusing redox species 

4.2.3 Technique specific parameters 

E start The potential where the scan starts and stops at. 

E vertex1 The first potential where the scan direction reverses. 

E vertex2 The second potential where the scan direction reverses. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
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E step The potential step size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

Scan rate The applied scan rate, also called sweep rate or sweep speed. The 
applicable range depends on the value of E step.  
 
The applicable scan rates for each instrument are: 
 

PalmSens1 and 2 1 mV/s (1 mV step) to 
25 V/s (5 mV step) 

PalmSens3 0.02 mV/s (0.15 mV step) to 
500 V/s (5 mV step) 

PalmSens4 0.02 mV/s (0.075 mV step) to 
500 V/s (10 mV step) 

EmStat1 and 2 0.02 mV/s (0.1 mV step) to 
5 V/s (5 mV step) 

EmStat3(+) 0.025 mV/s (0.125 mV step) to 
5 V/s (5 mV step) 

EmStat4 LR 0.01 mV/s (0.1 mV step) to 
500 V/s (200 mV step) 

EmStat4 HR 0.01 mV/s (0.183 mV step) to 
500 V/s (200 mV step) 

EmStat Pico 0.01 mV/s to 10 V/s (10 mV step) 
 

Number of scans The number of repetitions for this scan. 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.2.4 Fast CV 

A CV becomes a Fast CV if the scan rate in combination with E step results in a rate of over 2500 
points / second (scan rate / E step > 2500).  

See next section for more information. 
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4.3 Fast Cyclic Voltammetry (FCV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat4 LR and HR 

4.3.1 Description 

(See also previous section: Cyclic Voltammetry) 

In Cyclic Voltammetry a cyclic potential scan is performed between two vertex potentials E 
vertex1 and E vertex2. The scan can start (E begin) at one of these vertex potentials or anywhere 
in between.  

A CV becomes a Fast CV if the scan rate in combination with E step results in a rate of over 2500 
points / second (scan rate / E step > 2500).  

Additional options for Fast CV compared to a normal CV include averaging multiple scans and 
using equilibration scans. This technique can be particularly useful for very noisy 
measurements. Of course, it would be preferable to eliminate noise at the source first. 

Auto-ranging cannot be used at these high speeds, so only one current range can be selected. 

 

 

Figure 78 Fast Cyclic Voltammetry with ‘n scans’=2 and ‘n averaged scans’=3 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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4.3.2 Technique specific parameters 

E start The potential where the scan starts and stops at. 

E vertex1 The first potential where the scan direction reverses. 

E vertex2 The second potential where the scan direction reverses. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

E step The potential step size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

Scan rate The applied scan rate, also called sweep rate or sweep speed. The 
applicable range depends on the value of E step.  
 
The maximum scan rates for each instrument are: 
 

PalmSens1 and 2 25 V/s (5 mV step) 

PalmSens3 500 V/s (5 mV step) 

PalmSens4 500 V/s (10 mV step) 
 

Number of scans The number of repetitions for this scan. 
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n averaged 
scans 

The number of scans repetitions for averaging. In case ‘Number of 
scans’ is set to a value of more than 1, each scan in the plot is the result 
of an average of multiple scans, where the number of scans averaged is 
specified with this value. 

n equil. scans The number of equilibration scans. During these scans, no data is 
recorded. 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

As in CV, by default, the result shown is a graph of Current versus Potential. Successive cycles 
will be displayed in different colors. 

4.4 AC Voltammetry (ACV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat4 LR and HR 

4.4.1 Description 

In AC Voltammetry a potential scan is made with a superimposed sine wave which has a 
relatively small amplitude (normally 5 – 10 mV) and a frequency of 10 – 2000 Hz. 

The AC signal superimposed on the DC-potential results in an AC response (i ac rms). The 
resulting AC response is plotted against the potential. 

 

 

Figure 79 Potential versus time during AC Voltammetry 
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See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

 

4.4.2 Technique specific parameters 

E begin The potential where the measurement starts at. 

E end The potential where the measurement stops at. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 
 

E step The step potential size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

E ac The RMS amplitude of the applied sine wave. 
 
Applicable amplitude range: 1 mV to 250 mV 

Frequency The frequency of the applied ac signal. 
 
The applicable frequency range for each instrument is: 
 

PalmSens1 and 2 0.12 Hz to 250 Hz 

PalmSens3 1 Hz to 2000 Hz 

PalmSens4 1 Hz to 2000 Hz 

EmStat4 LR and HR 10 mHz to 50 kHz 
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Scan rate The applied scan rate, also called sweep rate or sweep speed. The 
applicable range depends on the value of E step.  
 
The applicable scan rates for each instrument are: 
 

PalmSens1 and 2 1 mV/s (1 mV step) to 25 mV/s (5 mV step) 

PalmSens3 0.2 mV/s (1 mV step) to 50 mV/s (5 mV step) 

PalmSens4 0.2 mV/s (1 mV step) to 1 V/s (250 mV step) 

EmStat4 LR and HR 0.2 mV/s (1 mV step) to 1 V/s (250 mV step) 
 

Measure DC 
current 

When checked, the direct current (DC) will be measured separately 
and added to the plot as an additional curve. 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.5 Differential Pulse Voltammetry (DPV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.5.1 Description 

In Differential Pulse Voltammetry a potential scan is made using pulses with a constant 
amplitude of E pulse superimposed on the dc-potential. The amplitude is mostly in the range 
of 5 – 50 mV. 
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Figure 80 Potential versus time during Differential Pulse Voltammetry 

The interval time between the pulses is equal to ‘E step’ / ‘scan rate’. 

The current is sampled twice in each step: one time just before applying the pulse and one time 
at the end of the pulse. The difference between these two current samples is plotted versus the 
potential. 

The obtained current is proportional to the derivative of the curve obtained using Linear Sweep 
or Normal Pulse Voltammetry. A DPV thus has a peak-shaped curve. The peak height is 
(normally) proportional to the concentration in the solution. Be aware that the peak is not the 
redox potential!  

Epeak = E½ −
Epulse

2
 

4.5.2 Measuring 

As in Normal Pulse Voltammetry (NPV) the diffusion layer thickness increases with pulse time, 
thus the current will be lower when the pulse time is increased. However, a short pulse time will 
result in an increased capacitive current and therefore give a higher (non-linear) baseline. 

In trace analysis, it is important to apply pulses with optimal pulse times. In general, the optimal 
value must be found by varying the pulse time. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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Figure 81 Typical DPV plot 

4.5.3 Technique specific parameters 

E begin The potential where the measurement starts at. 

E end The potential where the measurement stops at. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
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E step The potential step size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

Scan rate The applied scan rate, also called as sweep rate or sweep speed. The 
maximum scan rate depends on the value of E step and t pulse.  
The scan rate must be < (E step / 2 / t pulse). 
 
For PalmSens1 and 2: 
In case the scan rate is so low that the time between two measured points is 
longer than approx. 0.05 s, the measured data points are displayed during the 
measurement. In other cases, the measurement is completed before the points 
are shown.  
 
The applicable scan rates for each instrument are: 
 

PalmSens1 and 2 0.2 mV/s (0.1 mV step) to 
50 mV/s (5 mV step) 

PalmSens3 0.02 mV/s (0.15 mV step) to 
25 V/s (0.25 V step) 

PalmSens4 0.02 mV/s (0.07 mV step) to 
25 V/s (0.25 V step) 

  

EmStat1 and 2 0.02 mV/s (0.1 mV step) to  
5 V/s (5 mV step) 

EmStat3 0.025 mV/s (0.125 mV step) to  
5 V/s (5 mV step) 

EmStat3+ 0.025 mV/s (0.125 mV step) to  
5 V/s (5 mV step) 

EmStat4 LR 0.1 mV/s (0.1 mV step) to 
1 V/s (5 mV step) 

EmStat4 HR 0.1 mV/s (0.183 mV step) to 
1 V/s (5 mV step) 

EmStat Pico 0.01 mV/s to 10 V/s (10 mV step) 
 

E pulse The pulse potential height. 
 
The applicable pulse potential range for all instruments: 
 

E pulse 1 mV to 250 mV 
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t pulse The duration of the potential pulse. This duration needs to be set shorter 
than 0.5 * interval time where the interval time is equal to E step / Scan 
rate. 
 
The applicable pulse time range for each instrument is: 
 

PalmSens1 and 2 10 ms to 1 s 

PalmSens3 0.2 ms to 1 s 

PalmSens4 0.4 ms to 1 s 

EmStat1, 2 and 3(+) 5 ms to 1 s 

EmStat4 LR and HR 0.4 ms to 0.3 s 

EmStat Pico 2 ms to 0.3 s 
 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.6 Square Wave Voltammetry (SWV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.6.1 Description 

Square wave Voltammetry is in fact a special version of DPV. 

DPV is SWV when t pulse is equal to interval/2 (see DPV). The interval time is the inverse of the 
frequency (freq):   t interval = 1 / freq. As in DPV, the pulse amplitude is also normally in the 
range of 5 - 25 or 50 mV. 
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Figure 82 Potential versus time during Square Wave Voltammetry  

4.6.2 Measuring 

In trace analysis, it is important to apply a frequency with optimal values. As in DPV the optimal 
value must be found by varying the frequency. 

SWV is sometimes used to measure the reaction rate of the electrode reaction.  In this case, a 
plot of the currents observed in the positive potential pulses is plotted next to the currents 
measured in the negative potential pulses (forward and reverse currents). 

The shape of these curves shows how reversible or how fast the electrode reaction is. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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Figure 83 Typical SWV plot 

4.6.3 Technique specific parameters 

E begin  Potential where scan starts. 

E end Potential where measurement stops. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
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E step Step potential 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

Amplitude The amplitude of the square wave pulse. 
Values are half peak-to-peak. 
 
The amplitude range for all instruments: 0.1 mV to 250 mV 

Frequency The frequency of the square wave. 
 
The applicable frequency range of each instrument is: 
 

PalmSens1 and 2 1 Hz to 400 Hz 

PalmSens3 1 Hz to 1250 Hz 

PalmSens4 1 Hz to 1250 Hz 

EmStat1, 2 and 3(+) 1 Hz to 500 Hz 

EmStat4 LR and HR 1 Hz to 2500 Hz 

EmStat Pico 1 Hz to 500 Hz 
 

Measure i 
forward/reverse 

If this option is enabled the plot will show two separate curves for the 
measured forward and reverse current. 
 
Not supported by PalmSens1 and PalmSens2. 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.7 Normal Pulse Voltammetry (NPV) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.7.1 Description 

In Normal Pulse Voltammetry (NPV) a potential scan is conducted in pulses by consistently 
increasing the pulse amplitude. With Normal Pulse Voltammetry the influence of diffusion 
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limitation on your i-E curve (Cottrel behavior) is removed. NPV is normally more sensitive than 
LSV, since the diffusion layer thickness will be smaller, resulting in a higher faradaic current. 

 

 

Figure 84 Potential versus time during Normal Pulse Voltammetry  

At the first potential step, the pulse is equal to ‘E step’, at next twice the value ‘E step’, until the 
end where the pulse is ‘E begin’ + n * ‘E step’ is equal to ‘E end’, where 

n = (E end – E begin) / E step . 

The pulse time t pulse is specified by the user but must not exceed half the interval time. 

So, the t pulse <= E step / (scan rate * 2). 

4.7.2 Measuring 

Since the diffusion layer thickness increases with time, the sampled current will be lower when 
the pulse time is increased. However, a short pulse time will result in an increased capacitive 
current and therefore give a higher (non-linear) baseline. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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Figure 85 Typical NPV plot 

4.7.3 Technique specific parameters 

E begin The potential where the measurement starts at. 

E end The potential where the measurement stops at. 

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
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E step The potential step size. 
 
The applicable step range for each instrument is: 
 

PalmSens1 and 2 1 mV to 250 mV 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat1 and 2 0.1 mV to 250 mV 

EmStat3(+) 0.125 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico High Speed mode: 0.395 mV to 250 mV 
Low Speed mode: 0.537 mV to 250 mV 

 

t pulse The duration of the potential pulse. This duration needs to be set 
shorter than 0.5 * interval time where the interval time is equal to E 
step / Scan rate. 
 
The applicable pulse time range for each instrument is: 
 

PalmSens1 and 2 10 ms to 1 s 

PalmSens3 0.2 ms to 1 s 

PalmSens4 0.4 ms to 1 s 

EmStat1, 2 and 3(+) 5 ms to 1 s 

EmStat4 LR and HR 0.4 ms to 0.3 s 

EmStat Pico 2 ms to 0.3 s 
 

Scan rate The applied scan rate. The maximum scan rate depends on the value of 
E step and t pulse.  
The scan rate must be < (E step / 2 / t pulse). 
 
For PalmSens2: 
In case the scan rate is so low that the time between two measured points is 
longer than approx. 0.05 s, the measured data points are displayed during the 
measurement. In other cases, the measurement is completed before the 
points are shown. 
 

4.8 Chronoamperometry (CA) 
Also known as Amperometric Detection, or Potentiostatic Step. 

Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 
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4.8.1 Description 

The simplest, but widely used measurement technique is Chronoamperometry (or 
Amperometric Detection). Many sensors, like those for glucose or oxygen, require this 
technique. The instrument applies a constant DC-potential (E dc) and the current is measured 
with constant interval times. The result is displayed in real time. 

 

 

Figure 86 Potential versus time during Chronoamperometry  

4.8.2 Measuring 

Chronoamperometry is widely utilized in many applications, including highly sensitive 
electrochemical sensors (e.g., glucose biosensors), corrosion studies for assessing materials’ 
resistance, as well as basic electrochemistry applications like studying electrode kinetics and 
reaction mechanisms, and electrodeposition processes for precise coating control in 
industries such as electronics, automotive, and aerospace. 

The technique is also applied when electrochemical detection is used with a flow cell or flow 
injection cell (FIA). While batch measurements result in current levels, which depend on the 
concentration, a FIA setup shows peaks in the current. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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Figure 87 Typical CA curve obtained using capillary electrophoresis 

4.8.3 Technique specific parameters 

E dc The potential applied during the measurement. 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t interval The time between two current samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
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t run The total run time of the measurement. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

If you need to run faster steps use Fast Amperometry (FAM) instead. See details in section Fast 
Amperometry (FAM) on page 82. 

4.9 Zero Resistance Amperometry (ZRA) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

Use the technique Chronoamperometry in our software to 
perform ZRA measurements. 

4.9.1 Description 

All our potentiostats can be used as a Zero Resistance Ammeter (ZRA). A ZRA measures the 
current flowing through it without adding any resistance or polarization. This means the 
current is measured without the ZRA influencing the current. 

4.9.2 Setup 

If a potentiostat is used as a ZRA, in most setups it needs to be floating (Galvanically Isolated). 
The potentiostat’s ground cable, is used for the ZRA setup and if the potentiostat is grounded 
additionally elsewhere the current could flow through that connection instead of the required 
path.  

There are two options for a setup with a floating potentiostat.  

1. Using Bluetooth and battery for communication and power. This means the 
potentiostat has no connection to ground. 

2. Using a galvanic isolation dongle, which is inserted between the USB port of the 
computer and the potentiostat, makes the potentiostat float. This way you have a 
USB connection for communication and power, but no ground connection. 
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4.9.3 Connections 

The reference electrode (blue) and counter electrode (black) 
connections of the potentiostat need to be short-circuited and 
left disconnected to anything else. 

The current flows through the working electrode (red) and the ground (green). The Working 
Electrode is connected to the – input of the current follower and the + input is connected to 
Ground. The voltage difference between the Working Electrode and ground is zero and the 
current will be measured. See the following picture for a schematic representation. 

 

  

Figure 88 Electrode connections for a ZRA measurement 

Make sure that the current will not exceed the specification of 
your instrument model to avoid any damage. There will be no 
automatic interruption for current overload in this mode! 

4.9.4 Recording ZRA currents 

If you just want to see the current without recording, it is sufficient to go to the Manual Control 
tab and switch on the Cell. 

If you want to record the values, you can start a Chronoamperometry measurement. The 
applied potential doesn't matter, because the reference and counter electrode of the ZRA is 
not part of the measured circuit. 
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4.10 MultiStep Amperometry (MA) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.10.1 Description 

Multistep amperometry simply allows the user to specify the number of potential steps they 
want to apply and how long each step should last. Each step works exactly as a 
Chronoamperometry step. The current is continuously sampled with the specified interval 
time. A whole cycle of steps can be repeated several times. 

 

 

Figure 89 Potential versus time during Multistep Amperometry 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.10.2 Cottrell plot 

A plot of i vs. t-½ is often referred to as the “Cottrell plot”.  
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For more information see section: Cottrell plot on page 182. 

4.10.3 Technique specific parameters 

t interval The time between two current samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
 

Cycles The number of cycles (repetitions). 

Levels The number of potentials to apply within a cycle. 
Switching between levels adds an overhead time. 
 
The average overhead time for each instrument is: 
 

PalmSens1 and 2 ~80 ms * 

PalmSens3 ~80 ms * 

PalmSens4 ~80 ms * 

EmStat1, 2 and 3(+) ~80 ms * 

EmStat4 LR and HR ~1 ms 

EmStat Pico ~1 ms 

 

* Other running processes in Windows and 
periodically saving to the recovery file (in 
case this setting is enabled) may add 
significantly to the overhead time. 
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E level [n] The potential level at which the current is recorded. 
 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t [n] The duration of the applied potential. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

 

Additional options can be enabled using the  button: 

Use limits for 
each level 

Adds additional fields to each E level block for proceeding to the next 
level if a specified current is reached. 

Select for which 
levels to record 
data 

Adds additional ‘Record’ checkboxes to each E level block. If the 
‘Record’ checkbox is not checked, the specified potential will be 
applied for the given time, without recording the current. 

Use triggers Adds additional digital trigger settings to each E level block. See for 
more information section Digital triggers. 

 

If you need to perform actions which require more complexity, you can utilize Scripting.  

See also section: Scripting on page 243. 

4.11 Fast Amperometry (FAM) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat4 LR and HR 

4.11.1 Description 

Fast amperometry is a form of Amperometric Detection (Chronoamperometry) but with very 
high sampling rates or respectively very short interval times. 
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Figure 90 Potential versus time during Fast Amperometry 

  

Please note that if you combine two or more FAM steps in a row 
using MethodSCRIPT, there will be an overhead time of 
approximately ~1 ms between them. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.11.2 Technique specific parameters 

E equilibration Equilibration potential at which the measurement starts. 

E dc Potential of the pulse. Note that this value is not relative to E 
equilibration, given above.  
The current is continuously sampled during this stage. 

 The applicable potential range for PalmSens series is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 
 

t run Total run time of the measurement. 
Applicable run time: 1 ms to 30 s 
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t interval The time between two current samples. 
 
Minimum interval times: 

PalmSens1 and 2 0.25 ms 
PalmSens3 0.01 ms 
PalmSens4 0.02 ms 
EmStat4 LR and HR 0.001 ms 

 

4.12 Pulsed Amperometric Detection (PAD) 
Also known as Pulsed Amperometry 

Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.12.1 Description 

With Pulsed Amperometric Detection a series of pulses (pulse profile) is periodically repeated. 
Pulsed Amperometric Detection can be used when higher sensitivity is required. Using pulses 
instead of constant potential might result in higher faradaic currents. PAD is also used when the 
electrode surface has to be regenerated continuously, for instance, to remove adsorbents from 
the electrode surface. 

 

 

Figure 91 Potential versus time during Pulsed Amperometric Detection 

  

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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4.12.2 Technique specific parameters 

E dc The dc or base potential. 
 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

E pulse Potential in pulse. Note that this value is not relative to E dc, given 
above.  
 
The applicable pulse potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 
 

t pulse The pulse time. 
 
The applicable pulse time range for each instrument is: 
 

PalmSens1 and 2 10 ms to 1 s 

PalmSens3 0.2 ms to 1 s 

PalmSens4 0.4 ms to 1 s 

EmStat1, 2 and 3(+) 5 ms to 1 s 

EmStat4 LR and HR 0.4 ms to 0.3 s 

EmStat Pico 2 ms to 0.3 s 
 

Mode DC: i(dc) measurement is performed at 
potential E dc 

pulse: i(pulse) measurement is performed at 
potential E pulse 

differential: i(dif) measurement is i(pulse) -  i(dc) 
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t run Total run time of the measurement. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

t interval The time between two current samples. 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.13 Multiple Pulse Amperometry (MPAD) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat1, 2 and 3(+) 

4.13.1 Description 

The Multiple Pulse Amperometry (MPAD) technique involves applying a series of voltage pulses 
to an electrode immersed in a sample solution, and the resulting current of one of the pulses is 
measured. 

This technique can be used when higher sensitivity is required. Using pulses instead of constant 
potential might result in higher faradaic currents. MPAD is used when the electrode surface 
must be regenerated continuously, for instance, to remove adsorbents from the electrode 
surface. Some examples include detection and quantification of specific analytes, particularly 
in liquid chromatography and flow-injection analysis. 

Advantages of MPAD include its ability to reduce background noise and interference, making 
it especially useful for detecting trace-level analytes in complex sample matrices. Additionally, 
the choice of potential levels and pulse durations can be optimized for specific analytes, 
enhancing the method's sensitivity and selectivity. MPAD is commonly employed in techniques 
like high-performance liquid chromatography (HPLC) and capillary electrophoresis (CE) for the 
detection of a wide range of analytes, including pharmaceuticals, environmental contaminants, 
and biomolecules. 
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Figure 92 Potential versus time during Multiple Pulse Amperometry 

  

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.13.2 Technique specific parameters 

E1(measure) The first potential level in which the current is recorded 

E2 The second applied potential level  

E3 The third applied potential level  

 The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t1 The duration of the first applied potential 
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t2 The duration of the second applied potential 

t3 The duration of the third applied potential 

 Values t1, t2 and t3 can be 0.1 to 2 s 

t run Total run time of the measurement. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

4.14 Open Circuit Potentiometry (OCP) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat series 
▪ Sensit series 

4.14.1 Description 

For Open Circuit Potentiometry there is no polarization, and the so-called Open Circuit 
Potential (OCP) is measured and recorded with constant interval times. The result is a curve of 
Potential versus Time, displayed in real time. The OCP is also called Open Circuit Voltage (OCV). 

In corrosion, it is referred to as the "Corrosion Potential" (Ecorr), but in this context, it 
specifically denotes the potential of a metal or electrode when exposed to a corrosive 
environment. 

If you just want to see the OCP value without recording a curve, the information is available in 
the status bar. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.14.2 Technique specific parameters 

t run Total run time of the measurement. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

t interval The time between two potential samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
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Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.15 Chronopotentiometry (CP) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat4 LR and HR 

4.15.1 Description 

Chronopotentiometry (CP), also called Galvanostatic Step, is an electrochemical technique 
that requires a galvanostat instead of a potentiostat. It is supported by many PalmSens 
instruments. In this method, a constant current is applied, and the resulting potential (voltage) 
is continuously recorded over time in a definite time interval. This technique is particularly 
useful for studying electrochemical reactions, kinetics, and processes under non-steady-state 
conditions, offering valuable insights into how the electrode potential evolves in response to 
the applied current. It serves as a fundamental tool in various electrochemical investigations 
and analyses. 

This technique is a valuable tool in situations where a Reference Electrode (RE) is not available. 
When combined with a known electrode surface area, it offers a reliable and reproducible 
alternative for quantitative and comparative electrochemical studies. Its ability to maintain a 
constant current density, even with changes in the system's resistance, allows for highly 
reproducible experiments, ensuring precise control over current conditions and minimizing 
the impact of resistance variations. This feature makes it particularly valuable for quantitative 
analyses, such as determining reaction rate constants and charge transfer coefficients. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 
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Figure 93 Current versus time during during Chronopotentiometry 

 

4.15.2 Technique specific parameters 

i applied The current to apply. The unit of the value is the selected current 
range, so if 10 uA is selected and 1.5 is given as a value, the applied 
current will be 15 uA. 
 
The applicable applied currents for each instrument are: 
 
 Applied Available Ranges (CR) 

PalmSens2 -2 to 2 * CR 1 µA to 10 mA 

PalmSens3 -3 to 3 * CR 1 µA to 10 mA 

PalmSens4 -6 to 6 * CR 1 nA to 10 mA 

EmStat4 LR -3 to 3 * CR 10 nA, 1 µA, 100 µA, 10 mA 

EmStat4 HR -3 to 3 * CR 1 µA, 100 µA, 10 mA and 100 
mA 

 

t run Total run time of the measurement. 
 
RuntimeRange 
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t interval The time between two potential samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
 

 

4.16 Linear Sweep Potentiometry (LSP) 
Supported instruments: 

▪ PalmSens4 
▪ EmStat4 LR and HR 

4.16.1 Description 

In Linear Sweep Potentiometry is very similar to Linear Sweep Voltammetry, but in this case, the 
current is controlled, instead of the potential. It is also known as Galvanodynamic Step. A 
current scan is performed from the begin current, ‘i begin’, to the end current, ‘i end’. The scan 
is not really linear, but small current steps (‘i step’) are made. The potential is measured 
(sampled) during the last 25% interval period of each step. So, the number of points in the curve 
of the current versus potential is (i end – i begin) / E step + 1. 

The scan rate is specified in current per time (i.e. µA/s), which determines the time between 
two steps and thus the sampling time. The interval time is ‘i step’ / ‘Scan rate’. I.e.: when ‘i step’ 
is 0.005 mA and the scan rate 0.1 mA/s the interval time is 0.05 s. 

4.16.2 Measuring 

As other Galvanostatic tecnhiques, The LSP is particularly useful in systems where a Reference 
Electrode is not possible, but the Electrochemical Surface Area is well known. As a controlled 
current is applied to the electrode, this ensures a stable and consistent rate of reaction, which 
is advantageous when dealing with complex or multi-step electrochemical reactions. 
Galvanodynamic experiments also allow for the determination of rate constants and reaction 
mechanisms directly from the current-time data, facilitating quantitative analysis. Moreover, 
they are less susceptible to artifacts caused by double-layer charging effects and potential drift, 
often encountered in potentiodynamic experiments. 

In some applications, it is important that the potential does not get too high. This might ruin 
the working electrode. If the current at which this will occur is not known, it is possible to 
specify a maximum potential value at which the scan stops. In this case, the end current 
specified by the user may not be reached.  

See for more information section Potential and current limits on page 48. 
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Figure 94 Current versus time during Linear Sweep Potentiometry 

During the measurement, the curve is shown on the screen in real-time. It is possible to abort 
the measurement, by pressing the abort button above the plot. 

During a measurement, the use of the ‘Pause’ button will halt the scan until the same button is 
used again. This button is not available at higher scan rates. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.16.3 Technique specific parameters 

Applied current 
range 

The applied current range. If a range of 10 uA is selected and 1.5 is given 
as an applied current value, the applied current will be 15 uA. 
 
The applicable applied currents for each instrument are: 
 
 Applied Available Ranges (CR) 

PalmSens2 -2 to 2 * CR 1 µA to 10 mA 

PalmSens3 -3 to 3 * CR 1 µA to 10 mA 

PalmSens4 -6 to 6 * CR 1 nA to 10 mA 

EmStat4 LR -3 to 3 * CR 10 nA, 1 µA, 100 µA, 10 mA 

EmStat4 HR -3 to 3 * CR 1 µA, 100 µA, 10 mA and 100 
mA 

 

i begin Current in the selected range where scan starts at. 

i end Current in the selected range where scan stops at. 
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i step The current step size. 
 
The applicable minimum ‘i step’ for each instrument is: 
 

PalmSens1 and 2 0.001 * CR 

PalmSens3 0.00015 * CR 

PalmSens4 0.000075 * CR 

EmStat4 LR 0.0001 * CR 

EmStat4 HR 0.000183 * CR 
 

Scan rate The applied scan rate. The applicable range depends on the value of i 
step since the data acquisition rate is limited by the connected 
instrument.  

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.17 MultiStep Potentiometry (MP) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat4 LR and HR 

4.17.1 Description 

MultiStep Potentiometry simply allows the user to specify the number of current steps they 
want to apply and how long each step should last. The potential response is continuously 
sampled with the specified interval. 

A whole cycle of steps can be repeated several times. 

(Note: if only one current step is used, this technique is identical to Potentiometry which 
provides a larger range of measurement rates.) 
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Figure 95 Current versus time during Multistep Potentiometry 

  

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.17.2 Technique specific parameters 

t interval The time between two potential samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
 

Cycles The number of repetitions. 
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Levels The number of potentials to apply within a cycle. 
 
The average overhead time for each instrument is: 
 

PalmSens1 and 2 ~80 ms * 

PalmSens3 ~80 ms * 

PalmSens4 ~80 ms * 

EmStat1, 2 and 3(+) ~80 ms * 

EmStat4 LR and HR ~1 ms 

EmStat Pico ~1 ms 

 

* Other running processes in Windows and 
periodically saving to the recovery file (in 
case this setting is enabled) may add 
significantly to the overhead time. 

 

i level [n] The current level at which the potential is recorded. 
 
The applicable applied currents for each instrument are: 
 
 Applied Available Ranges (CR) 

PalmSens2 -2 to 2 * CR 1 µA to 10 mA 

PalmSens3 -3 to 3 * CR 1 µA to 10 mA 

PalmSens4 -6 to 6 * CR 1 nA to 10 mA 

EmStat4 LR -3 to 3 * CR 10 nA, 1 µA, 100 µA, 10 mA 

EmStat4 HR -3 to 3 * CR 1 µA, 100 µA, 10 mA and 100 
mA 

 

t [n] The duration of the applied current. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

 

Additional options can be enabled using the  button: 

Use limits for 
each level 

Adds additional fields to each i level block for proceeding to the next 
level if a specified potential is reached. 

Select for which 
levels to record 
data 

Adds additional ‘Record’ checkboxes to each i level block. If the 
‘Record’ checkbox is not checked, the specified current will be applied 
for the given time, without recording the potential. 

Use triggers Adds additional digital trigger settings to each i level block. See for 
more information section Digital triggers. 
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Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 

4.18 Stripping Chronopotentiometry (SCP) 
Also known as Potentiometric Stripping Analysis (PSA) 

Supported instruments: 

▪ PalmSens series 

4.18.1 Description 

Chronopotentiometric Stripping or Stripping chronopotentiometry is a sensitive analytical 
technique. 

The sequence of a stripping chronopotentiometry measurement: 

1. Apply E condition, the conditioning potential, if t condition is not zero. 
2. Apply E deposition, the deposition potential, if t deposition is not zero. 
3. Apply E deposition and wait t equilibration seconds. 
4. If Stripping Current = 0 then the cell is switched off, otherwise, the specified constant 

current is applied. The measurement with a rate of 40 kHz starts. The measurement 
stops when either the measured potential is below ‘E end’ or the run time is exceeded. 

 

Figure 96 Stripping chronopotentiometry (SCP) 
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4.18.2 Measuring 

The actual measurement can be done in two modes: 

▪ Chemical stripping, using a chemical oxidant (or reductant) 
▪ Using the instrument as a galvanostat and applying a constant stripping current. 

In both cases, the potential versus time (E vs t) is measured. The resulting curve is re-calculated 
to the inverse derivative, so dt/dE (in s/V) vs E. 

In case a component was deposited at the electrode surface, it requires current to oxidize or 
reduce.  The higher the amount of absorbed component, the more electrical charge (time 
integral of the current) it requires, so the longer it takes to change the electrode potential. 

The plot of dt/dE vs E therefore will show a peak the potential where the oxidation or reduction 
occurs. 

The direction of the stripping current depends on the end potential (E end) minus deposition 
potential (E deposition). In case no deposition time was used, the sign is determined by the end 
potential (E end). 

4.18.3 Technique specific parameters 

E end Potential where measurement stops. 
 
The applicable potential range for PalmSens series is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 
 

Stripping 
Current 

If specified as 0, the method is called chemical stripping otherwise it is 
constant current stripping. 
 
The direction of the stripping current is determined by E end minus E 
deposition. 
 
The applicable stripping current and potential range of each 
instrument is: 
 

PalmSens1 and 2 ±0.001 μA to ±2 mA. 
-2 V to +2 V. 

PalmSens3 ±0.001 μA to ±30 mA. 
-5 V to +5 V. 

PalmSens4 ±1 nA to ±30 mA. 
-10 V to +10 V 

 

Measurement 
time 

The maximum measurement time. This value should always exceed the 
required measurement time. It only limits the time of the 
measurement. When the potential response is erroneously and E end is 
not found within this time, the measurement is aborted. 
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4.19 Chronocoulometry (CC) 
Supported instruments: 

▪ PalmSens3 and PalmSens4 
▪ EmStat series 
▪ Sensit series 

4.19.1 Description 

Chronoamperometry (CA) and Chronocoulometry (CC) have the same potential waveform but 
are used for different purposes. In CA, the current is monitored as a function of time, whereas 
in CC, the charge is monitored as a function of time. This means that in essence, the 
potentiostat performs the same experiment as in CA, keeping the potential constant and 
registering the current over time. However, in CC, instead of displaying the current, the 
software displays the charge versus time. The charge is determined by integrating the current. 

While the measured current in the CA shows a linear correlation with the reaction rate, the 
charge measured in CC shows a linear correlation with the number of converted reactants. This 
is described in Faraday's law. This makes CC useful during deposition or electrochemical 
synthesis. For the characterization of batteries and capacitors, CC is also helpful. 

In analytical chemistry, CC is employed to determine the adsorbed number of active species in 
a solution of freely diffusing active species. Multiplying the Cottrell equation by t yields that the 
charge Q of the freely diffusing species’ reaction is proportional to t½. The total charge also 
includes the contribution of the charge stored in the electrochemical double layer and the 
charge due to reactions of adsorbed species. These two effects are a lot faster than the reaction 
of free diffusing species. Plotting Q versus t½ (Anson plot) delivers (ideally) a jump in charge 
followed by a linear increase. When the linear part is extrapolated, the intersection with the 
charge axis delivers the contribution of the double layer and adsorbed species. A previous 
blank measurement allows the determination of the double layer contribution and thus the 
calculation of the adsorbed species contribution. 

To ensure that the charge step at the beginning is recorded, this measurement is conducted in 
two steps. The first step at a reaction-free potential followed by the step where the reaction is 
initiated, just like the classic Cottrell experiment. 
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Figure 97 Potential versus time during Chronocoulometry 

 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

4.19.2 Anson plot 

For more information about the Anson plot, see section Anson plot on page 183. 

4.19.3 Technique specific parameters 

t interval The time between two current samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
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E step 1 Potential applied during the first potential step. 
 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t 1 Duration of the first potential step. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

E step 2 Potential applied during the second potential step. 
 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t 2 Duration of the second potential step. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

 

Additional options can be enabled using the  button. See for more information the 
applicable sub-sections in section Measurements on page 25. 
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4.19.4 Overhead time between steps 

The delay between the execution of the two potential steps varies, depending on the 
instrument model. The following table gives an indication of the average overhead time for 
each model. 

 

The average overhead time for each instrument is: 
 

PalmSens1 and 2 ~80 ms * 

PalmSens3 ~80 ms * 

PalmSens4 ~80 ms * 

EmStat1, 2 and 3(+) ~80 ms * 

EmStat4 LR and HR ~1 ms 

EmStat Pico ~1 ms 

 

* Other running processes in Windows and periodically saving to 
the recovery file (in case this setting is enabled) may add 
significantly to the overhead time. 

4.20 Mixed Mode (MM) 
Supported instruments: 

▪ PalmSens series 
▪ EmStat1, 2 and 3(+) (limited) 
▪ EmStat4 LR and HR 

4.20.1 Description 

Mixed Mode is a flexible technique that allows for switching between potentiostatic, 
galvanostatic, and open circuit measurements during a single run. 

See section Standard Measurement Sequence on page 32 for information about pretreatment 
and post measurement settings. 

The Mixed Mode uses different stages similar to the levels during Multistep Amperometry or 
Potentiometry, but each stage can be galvanostatic or potentiostatic independent of the 
previous stage.  

The available stage types are ‘ConstantE’, ‘ConstantI’, ‘SweepE’, ‘OpenCircuit’ and ‘Impedance’. 
‘SweepE’ offers a potential linear sweep (ramp), so as a regular LSV step. During an Impedance 
stage the impedance is measured by applying a small AC potential superimposed with a DC 
potential. This corresponds to an EIS single frequency step (Scan type = Default, Frequency type 
= Fixed). 

Each stage can use the previous stage’s potential as a reference point, for example, a constant 
current is applied for a fixed period and afterward, the reached potential is kept constant for a 
fixed period. 
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Furthermore, each stage can end, because a fixed period has elapsed, or certain criteria are 
met. Available criteria include reaching a maximum current, minimum current, maximum 
potential, and minimum potential. 

These modes are useful especially for energy conversion and storage research, i.e.: battery, 
solar cell, or supercapacitors research. A classic test for batteries involves charging and 
discharging them through multiple cycles. A constant current is applied, and the potential 
change is recorded. If a certain potential is reached, the next stage is triggered, which is usually 
applying the inverted constant current. This is repeated for multiple cycles. While this method 
could be performed with Multistep Potentiometry as soon as further steps are introduced the 
Mixed Mode is necessary. For example, to determine the capacity you would like to discharge 
a battery, but you need to take care that the terminal potential isn’t crossed. First the battery is 
charged. You can apply a constant current until a set potential is reached, e.g.: the termination 
potential. After that, the termination potential is kept constant until a minimum current limit is 
reached or the time has elapsed. Then this process is repeated with a negative current to 
discharge the battery until a minimum potential is reached. Impedance steps can be inserted 
between to determine the parameters called State of Charge (SoC) and State of Health (SoH) 
of the battery. 

 

 

Figure 98 Scheme of the potential and current profile during the above-described example. 
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Figure 99 Part of the Method needed to perform the above-described method 

Another example is to study how well a supercapacitor stores charge. First, the capacitor is 
charged with a fixed current followed by observing the OCP of the supercapacitor. 

4.20.2 Technique specific parameters 

t interval The time between two current samples. 
 
The applicable time interval range of each instrument is: 
 

PalmSens1 and 2 1 ms to 300 s 

PalmSens3 0.2 ms to 300 s 

PalmSens4 0.4 ms to 300 s 

EmStat1, 2 and 3(+) 1 ms to 300 s 

EmStat4 LR and HR 0.4 ms to 300 s 

EmStat Pico 1 ms to 300 s 
 

Cycles The number of repetitions. 
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4.20.3 Parameters for Constant E stage 

E dc Potential during measurement. 
 
The applicable potential range of each instrument is: 
 

PalmSens1 and 2 -2 V to +2 V 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat1 and 2 -2 V to +2 V 

EmStat3 -3 V to +3 V 

EmStat3+ -4 V to +4 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico High Speed mode: -1.7 V to +2 V 
Low Speed mode: -1.25 V to +2 V 

See also section Limitations and extra options for EmStat Pico on page 109. 
 

t run The run time of the stage. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

4.20.4 Parameters for Constant I stage 

i applied The current to apply. The unit of the value is the selected current range 
at the top. So if 10 uA is selected and 1.5 is given as a value, the applied 
current will be 15 uA. 
 
The applicable applied currents for each instrument are: 
 
 Applied Available Ranges (CR) 

PalmSens2 -2 to 2 * CR 1 µA to 10 mA 

PalmSens3 -3 to 3 * CR 1 µA to 10 mA 

PalmSens4 -6 to 6 * CR 1 nA to 10 mA 

EmStat4 LR -3 to 3 * CR 10 nA, 1 µA, 100 µA, 10 mA 

EmStat4 HR -3 to 3 * CR 1 µA, 100 µA, 10 mA and 100 
mA 

 

t run The run time of the stage.  
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
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4.20.5 Parameters for Open Circuit stage 

t run The run time of the stage. 
 
The minimum and maximum duration of a measurement: 
5 * interval time to 1,000,000 seconds (ca. 278 hours) 
 

4.20.6 Parameters for Sweep E stage 

E begin Potential where scan starts. 

E end Potential where measurement stops. 

  
PotentialRanges 

E step Step potential 
 
StepRanges 

Scan rate The applied scan rate. The applicable range depends on the value of E 
step since the data acquisition rate is limited by the connected 
instrument.  
 
The applicable scan rates for each instrument are: 
 

PalmSens1 and 2 1 mV/s (1 mV step) to 
25 V/s (5 mV step) 

PalmSens3 0.02 mV/s (0.15 mV step) to 
500 V/s (5 mV step) 

PalmSens4 0.02 mV/s (0.075 mV step) to 
500 V/s (10 mV step) 

EmStat1 and 2 0.02 mV/s (0.1 mV step) to 
5 V/s (5 mV step) 

EmStat3(+) 0.025 mV/s (0.125 mV step) to 
5 V/s (5 mV step) 

EmStat4 LR 0.01 mV/s (0.1 mV step) to 
500 V/s (200 mV step) 

EmStat4 HR 0.01 mV/s (0.183 mV step) to 
500 V/s (200 mV step) 

EmStat Pico 0.01 mV/s to 10 V/s (10 mV step) 
 

4.20.7 Parameters for EIS stage 

Frequency The applied frequency in Hz. 

E dc The dc potential applied during the EIS scan. 

E ac The amplitude of the E ac signal has a range of 0.0001 V to 0.25 V 
(RMS). In many applications, a value of 0.010 V (RMS) is used. The 
actual amplitude must be small enough to prevent a current response 
with considerable higher harmonics of the applied ac frequency. 
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t run The total run time of a scan. 

t. Min. sampling Each measurement point of the impedance spectrum is performed 
during the period specified by minimum sampling time ‘t Min 
sampling’. This means that the number of measured sine waves is equal 
to t Min sampling * frequency. If this value is less than 1 sine wave, the 
sampling is extended to 1 / frequency. So, for a measurement at a 
frequency, at least one complete sine wave is measured. 
Reasonable values for the sampling are in the range of 0.1 to 1 s. 

t. Max 
equilibration 

The impedance measurement requires a stationary state. This means 
that before the actual measurement starts, the sine wave is applied 
during ‘t Max equilibration’ only to reach the stationary state. 
The maximum number of equilibration sine waves is however 5. The 
minimum number of equilibration sines is set to 1, but for very low 
frequencies, this time is limited by ‘t Max equilibration’. The maximum 
time to wait for a stationary state is determined by the value of this 
parameter. A reasonable value might be 5 seconds. In this case, this 
parameter is only relevant when the lowest frequency is less than 1/ 5 s 
so 0.2 Hz. 

 

4.20.8 Overhead time between steps 

The delay between the execution of the two potential steps varies, depending on the 
instrument model. The following table gives an indication of the average overhead time for 
each model. 

The average overhead time for each instrument is: 
 

PalmSens1 and 2 ~80 ms * 

PalmSens3 ~80 ms * 

PalmSens4 ~80 ms * 

EmStat1, 2 and 3(+) ~80 ms * 

EmStat4 LR and HR ~1 ms 

EmStat Pico ~1 ms 

 

* Other running processes in Windows and periodically saving to 
the recovery file (in case this setting is enabled) may add 
significantly to the overhead time. 
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4.21 MethodSCRIPT Sandbox 
Supported instruments: 

▪ EmStat4 LR and HR 
▪ EmStat Pico 
▪ Sensit series 

MethodSCRIPTTM is a scripting language designed for researchers 
and developers. 

4.21.1 Description 

The MethodSCRIPT Sandbox allows you to write your own MethodSCRIPT and run them 
conveniently in PSTrace. 

The MethodSCRIPT language allows for programming a human-readable script directly into the 
potentiostat. The simple script language makes it easy to combine different measurements and 
other tasks. 

See for more information section MethodSCRIPT on page 259. 
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5 Limitations and extra options for 
EmStat Pico 

The EmStat Pico module has some limitations for each technique which are explained in this 
section. This section also applies to instruments based on the EmStat Pico like the Sensit Smart 
and Sensit BT. 

  

Figure 100 Sensit Smart and Sensit BT based on EmStat Pico module 

 

Figure 101 EmStat Pico Development Board 

5.1.1 EmStat Pico limitations for each mode 

The EmStat Pico can be used in 3 different modes; Low Speed, High Speed or Max Range: 

▪ Low Speed mode: for scan rates up to 1 V/s or a bandwidth of 100 Hz. 
▪ High Speed mode: for high scan rates and frequencies. 
▪ Max Range mode: a combination of the Low and High Speed modes for optimal 

dynamic dc-potential range 

Each mode comes with distinct limitations regarding potential ranges. The following table 
illustrates the applicable ranges for each mode, along with the main performance differences 
between them. 
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Table 7 Limitations for each EmStat Pico mode 
 

Low Speed mode High Speed mode Max Range  
mode  

Full dc-potential range -1.2 to +2 V -1.7 to +2 V -1.7 to +2 V 

Dynamic dc-potential range 1 2.2 V 1.2 V 2.6 V 

Compliance voltage -2.0 to +2.3 V 2 

Maximum current ±3 mA 

Max. acquisition rate 
(datapoints/s) 

100 1000 100 

Supports FRA/EIS NO YES NO 

Applied dc-potential 
resolution 

537 µV 395 µV 932 µV 

Applied potential accuracy < 0.2% < 0.5% < 0.5% 

Available current ranges 100 nA, 2 uA,  
4 uA, 8 uA,  
16 uA, 32 uA,  
63 uA, 125 uA,  
250 uA, 500 uA,  
1 mA, 5 mA 

100 nA, 1 uA,  
6 uA, 13 uA,  
25 uA, 50 uA,  
100 uA,  
200 uA, 1 mA,  
5 mA 

100 nA, 1 uA,  
6 uA, 13 uA,  
25 uA, 50 uA, 100 
uA,  
200 uA, 1 mA, 5 mA 

Current accuracy < 0.5% of current 
±0.1% of range 

< 1% of current  
±0.1% of range 3 

 

Measured current resolution 0.006% of range  
(5.5 pA on 100 nA 
range) 

  

  

 

1 The dynamic range is the range that can be covered during a single scan within the full potential 

range. For example; a linear scan can start at -1.5 V and end at 1.1 V or vice versa, covering 2.6 V dynamic 

range. 

2 The compliance voltage is the maximum potential between Working and Counter electrode and 

depends on the selected mode.  

3 Channel 2 has an uncompensated series resistor (typical 110 Ω) in series with the WE2 signal. This 

additional resistance must be taken into account. 
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5.2 Extra options for EmStat Pico and Sensit Series 
If an EmStat Pico is connected additional functions become visible when expanding the 
advanced options for a technique in the Method Editor 

 

 

Figure 102 Advanced options for EmStat Pico 

5.2.1 Override potentiostat mode 

By default, the ‘Override potentiostat mode’ option is disabled, causing the potentiostat mode 
to be automatically selected based on the predetermined parameters. While the automated 
selection is generally efficient, there are instances where a manual override may be preferable.  
An example of this scenario is when dealing with a cell that demands a higher compliance 
voltage. In such cases, selecting the ‘Max Range' option manually proves to be the most 
suitable, in combination with the ‘Override E range’. See also section “Override E range” below. 

5.2.2 Potentiostat channel 

The EmStat Pico is equipped with two channels each with their own RE, CE and WE. Here you 
can specify on which channel the measurement should be performed.  

Please be aware that in Sensit BT SNS version and Sensit Smart, the Reference Electrode (RE) 
and Counter Electrode (CE) of the second channel (Channel 1) are in an open circuit 
configuration. Therefore, if you simply select this channel, you will always obtain an open circuit 
response. 

5.2.3 Override E range 

To achieve the desired potential between the Working Electrode (WE) and Reference Electrode 
(RE), a potentiostat applies a potential between the WE and Counter Electrode (CE). This 
potential is generally higher than the requested potential between the WE and RE. The 
maximum potential that the potentiostat can apply on the CE vs. WE is called the compliance 
potential.  

See also section Sensit Smart and Sensit BT specifications on page 344 for a more detailed 
overview of the limitations of the EmStat Pico concerning compliance potential. 

On the EmStat Pico, the compliance potential range can be manually set by enabling the 
'Override E range' option and configuring the values for 'Min E range override' and 'Max E range 
override'. This specified potential range governs the potentials applied during the 
measurement, directly influencing the available compliance potential. Typically, PSTrace 
automatically selects the potential range based on the measurement potentials, which are 
defined as WE vs. RE. 
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An instance where this feature proves useful is when dealing with a cell that requires a higher 
compliance voltage on the positive end. In automatic mode, there might be some compliance 
range allocated for the lower potential end that goes unused. By setting 'Min E range override' 
and 'Max E range override' towards more positive potentials, the potentiostat can provide 
additional potential compliance when required. 

A way to verify that the compliance potential is exceeded is to check the box ‘Record Cell 
potential’ in the Method Editor.  

An alternative way to verify if the compliance potential is exceeded is to measure the CE lead 
(black) versus the GND lead (green). If the potential reaches 2.8V vs GND, the lower (negative) 
limit of the potential range should be extended. If the potential reaches 0.2V vs GND, the upper 
(positive) limit of the potential range should be extended. 
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6 Electrochemical Impedance 
Spectroscopy 

Electrochemical Impedance Spectroscopy (EIS) is an electrochemical technique to measure 
the impedance of a system in dependence of the AC potentials frequency. 

In classic Electrochemical Impedance Spectroscopy (EIS) measurements, they are typically 
conducted in "potentiostatic mode." In this mode, a sine wave is superimposed on the specified 
DC potential, resulting in the equation E = Edc + Eac. This configuration produces a DC current 
with an additional AC component, expressed as I = Idc + Iac. From these two waves the 
potentiostat calculates total impedance (Z), phase angle (Φ), real impedance (Z’) and complex 

/ imaginary impedance (Z’’). The spectrum is made by measuring these parameters for 
potential waves with different frequencies. 

Indeed, the term "spectroscopy" implies a frequency sweep, which is the most common 
measurement. However, our instruments provide the flexibility to set the frequency and vary 
other parameters, such as DC potential and time. 

Alternatively, some of our instruments offer the option of EIS in galvanostatic mode (GEIS), 
where the current is controlled while the potentials are measured. 

An introduction can be found in for instance the textbook: 

Electrochemical Methods: Fundamentals and Applications, written by Allen J. Bard and Larry R. 
Faulkner, ISBN-13: 978-0471043720  

Supported instruments: 

▪ PalmSens3 
▪ (Multi)PalmSens4 
▪ (Multi)EmStat4 series 
▪ EmStat Pico and Sensit series 

The EIS option is an optional feature, except for the Sensit Series. Please verify if it was included 
in your purchase order. 

6.1 Introduction 
PSTrace provides different modes of EIS measurements: 

▪ a frequency scan at a fixed dc-potential (default EIS) 
▪ frequency scans at each dc-potential in a potential scan 
▪ frequency scans at specified time intervals (time scan) 
▪ a single frequency applied at each dc potential in a potential scan (Mott-Schottky) 
▪ a repeated single frequency at specified time intervals 
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For Galvanostatic EIS (GEIS) the modes are: 

▪ a frequency scan at a fixed dc-current 
▪ frequency scans at each current in a current scan 
▪ frequency scans at specified time intervals (time scan) 
▪ a single frequency applied at each current in a current scan 
▪ a single frequency at specified time intervals 

The measured data can be presented in different plot formats. 

For fitting EIS data on an equivalent circuit, see section: Equivalent Circuit Fitting on page 135. 

The measurements yield the impedance defined by Z() = Eac() / Iac().  

The impedance is a complex number Z() = Z’() – jZ’’(), where Z’ is the real part and Z’’ the 
imaginary part of the impedance and  = 2 π f , where f is the applied frequency. 

The phase shift φ is defined as tan(φ) = - Z’’ / Z’. (Note: we do not use () from here anymore) 

The impedance data are often presented in the Nyquist plot, with Z’’ vs Z’ or in a Bode plot, with 
the decimal logarithm of the magnitude of Z and phase shift versus the logarithm of the 
frequency. 

The magnitude Z is defined as  

 |Z|2 = (Z)’2 + (-Z’’)2. 

 

 

Figure 103 Example of a Nyquist plot 
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Figure 104 Example of a Bode plot 

The inverse of the impedance is the admittance, which is also a complex number Y = Y’ + jY’’,  

where Y = 1 / Z ,  Y’ = Z’ / ( Z’2  + Z’’2)  and Y’’ = Z’’ / ( Z’2  + Z’’2) . 

Sometimes impedance measurements are represented in a plot of Y vs log(f) or Y’’ vs Y’. 
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Figure 105 Example of an admittance plot 

The example shown in the plots above represents a measurement of an ideal working electrode 
at which a faradaic reaction occurs. The equivalent circuit for such a simple system is shown in 
the figure below. 

 

 

Figure 106 Equivalent circuit for a simplified Randles circuit 

Where R is the ohmic resistance of the electrolytic solution, Cdl the capacitance of the double 
layer of the working electrode and Rct is the resistance due to the electron transfer of the faradic 
reaction. 

At high frequencies, the impedance is dominated by the value of R , so Z = R , with a phase 
shift of 0 °. 

At low frequencies the impedance of the double layer is so high that it can be neglected, so the 
impedance is equal to R  + Rct and the phase shift is again 0 °. 

At intermediate frequencies the influence of the capacitance of the double layer (which has an 
impedance of Z = - j / (Cdl)) results in a phase shift and a measured impedance between the 
two limits of R and (R + Rct ). 
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6.2 Setting up an impedance measurement 
The Measurement tab contains all the method parameters. The Notes textbox can be used to 
describe the sensor used and sample that is measured. 

With each change, the validation of the method is checked. Errors or incompatibilities are 
shown instantly at the bottom of the measurement tab. 

6.2.1 Current ranges 

 

Figure 107 Buttons for selecting the applicable current ranges 

With the current range buttons at the top, the applicable current range(s) during the 
measurement can be selected. If more than one button is selected (blue), the instrument will 
select the most optimal current. The highest current to be enabled is determined by the lowest 
impedance value and equal to 1 / Z (lowest value) as well as the highest obtained value for the 
dc-current. The lowest enabled current range is determined by the highest impedance to be 
measured and equal to 1 / Z (highest) and again the lowest value to the dc-current. 

So, if the lowest impedance is in the order of 100 Ω or lower, enable 10 mA and if the highest 
impedance is in the order of MΩ, enable current ranges down to 1 µA or 100 nA. Nevertheless, 
it's important to be aware that for high frequencies, the autoranging routines consider the 
maximum bandwidth when determining how to establish optimal gain settings. This involves a 
combination of switching to the optimal range and applying a gain of 10 or 100 on the active 
current range. Consequently, if you configure the potentiostat to operate with a lower Current 
Range (CR), for instance, by deselecting the higher CR option, you may experience inaccuracies 
in responses. The chosen CR might lack the necessary bandwidth to adequately sample certain 
high frequencies. 

In general, it is best to enable all current ranges for EIS. In a general way, for EIS experiments 
the instruments can select the proper current range automatically without any issues. Note 
that maybe some ranges can be unavailable according to other measurements parameters 
(mainly ‘Max. frequency’ and ‘E ac’). 

For a typical Electrochemical Impedance Spectroscopy (EIS) measurement, which involves a 
frequency scan starting from a high frequency (i.e., >1kHz), data collection is rapid, typically 
taking only a few seconds for each frequency measurement. In this scenario, the potentiostat 
efficiently searches for a suitable range, starting from the highest one. 

An EIS measurement starts at the highest selected current range. 

It's worth noting that if you start with a low frequency (i.e., >1Hz), each measurement will take 
longer, and the potentiostat may require additional time on the first point to select the proper 
range. In such cases, situations where manual range selection can be more straightforward may 
arise. Another example where the manual range may be suitable is a time scan at low 
frequencies. 
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6.2.2 Auto current ranging in Galvanostatic EIS 

Since the current follower is in the controlled loop, current range switching is not possible 
while measuring. Auto current ranging is therefore not supported in galvanostatic mode. 

6.2.3 Pretreatment settings 

Pretreatment is always done in potentiostatic mode, also for Galvanostatic EIS. 

Before a measurement starts, the working electrode or sensor can be pretreated according to 
the specified values for E condition1 and 2 and related times. 

Each time a new dc-potential is applied, the equilibration time is used before the impedance 
measurements start. 

6.2.4 Frequency scan settings 

A frequency scan starts at the ‘Max. frequency’ and ends at ‘Min. frequency'. The frequency 
distribution can be logarithmic, linear or custom. If frequency distribution is logarithmic, a fixed 
number of frequencies per decade are applied. Typically, EIS experiments encompass a broad 
range of frequencies, spanning from kilohertz to millihertz. Consequently, the use of 
logarithmic frequency distribution is more suitable, and a common practice is to set 10 
frequencies per decade (order of magnitude). For instance, in a scan ranging from 10 kHz to 
100 Hz, the total number of frequencies will be 2 decades times 10 + 1, resulting in 21 
frequencies. The actual applied number of frequencies can be entered or the number of 
frequencies per decade. 

 

 

Figure 108 Parameters for defining the frequency scan in the Method Editor 
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Figure 109 ‘Edit applied frequencies’ window 

The list of frequencies is shown by clicking the ‘Edit’ button in the method editor. It opens a 
dialog which allows the user to choose a mode (Logarithmic, linear, or custom) to generate the 
frequency list. Any edits made to the frequency list turns it into a custom list which is written 
back to the method. The modified list can also be saved in the application settings to be used 
later if needed. 

6.3 Parameters for EIS 
 

Scan type Default: this is the setting for the regular EIS experiment. The dc-
potential ‘E dc’ will remain fixed at a determinate value.  
E dc scan: multiple measurements will be conducted with different dc-
potential levels, starting from 'E begin' and ending at 'E end' in 
increments determined by the 'E step'. At each dc-potential level, a 
single fixed frequency is applied, or a frequency scan is made, 
according to the set ‘Frequency type’. 
Time scan: repeated measurements at a defined ‘E dc’ will be 
conducted and recorded versus time. 
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6.3.1.1 Parameters for Scan type = E dc scan 

E begin The dc-potential at which the measurement starts. 
 
The applicable potential range for each instrument is: 

PalmSens3 -5 V to +5 V 

PalmSens4 -10 V to +10 V 

EmStat4 LR -3 V to +3 V 

EmStat4 HR -6 V to +6 V 

EmStat Pico -1.25 V to +2 V 
See also section: Limitations and extra options for EmStat Pico on page 
109. 

E step The potential step size. Sets the increment to be used between 
‘E begin’ and ‘E end’. 
 
The applicable step range for each instrument is: 

PalmSens3 0.15 mV to 250 mV 

PalmSens4 0.075 mV to 250 mV 

EmStat4 LR 0.1 mV to 250 mV 

EmStat4 HR 0.183 mV to 250 mV 

EmStat Pico 0.537 mV to 250 mV 
 

E end The potential at which the scan ends. The applicable range is 
same as ‘E begin’ 

 

6.3.1.2 Parameters for Scan type = Time scan 

t run The total run time of a scan. 
 
Run time for each instrument: <1 s to 1,000,000 s 

t interval The minimum interval time between each data point  
(Frequency type=Fixed) or between each frequency scan 
(Frequency type=Scan). We recommend a time higher than the 
required time to measure the data point or perform the 
frequency scan + overhead time. While it's possible to use a 
shorter time, doing so may lead to incorrect impedance 
calculations. 

 

6.3.1.3 Parameters for all scan types 

E dc The dc-potential applied during the EIS scan. Also called “DC 
Bias” or “level”. The most common setting for this parameter is 
0 V vs. OCP. By default, the option ‘Measure vs. OCP’ comes 
checked.  
 
See also section: Measuring versus OCP on page 33. 

E ac The amplitude of the E ac signal has a range of 0.001 V to 0.25 V 
(RMS). In many applications, a value of 0.010 V (RMS) is used. 
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Frequency type Fixed: a single frequency is applied for the given duration or at each 
potential step or time interval. 
Scan: a frequency scan is performed starting at the given ‘Max. 
frequency’ to the given ‘Min. frequency’. This is the setting for the 
regular EIS experiment. 

Frequency The applied frequency (in case of Frequency type=Fixed). 

Show time domain 
data 

Only visible for EmStat4-series instruments. When enabled a 
Scope window is shown during the measurements to view the 
time domain data as sinewaves or in a Lissajous plot. 

 

6.3.1.4 Parameters for Frequency type = Scan 

n frequencies The number of frequencies to apply between the given Max. 
frequency and Min. frequency. 

Max. frequency The frequency to start the frequency scan on. 

Min. frequency The frequency to end the frequency scan on. 

Measure vs OCP If enabled, the Open Circuit Potential will be determined first as 
a reference point for applied dc potentials.  
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See also: 

▪ “Frequency scan settings” in the section: Setting up an impedance measurement on 
page 117.  

▪ Section: Measuring versus OCP on page 33.  

6.3.1.5 Advanced parameters under […] button 

Pretreat each scan The potentials set in the “Pretreatment Settings” will be applied 
before each frequency scan is started 

Force max stability 
filter 

Applies to PalmSens4 only. Overrides the frequency-dependent 
stability filter to its maximum value, can prevent a shift in 
impedance due to 100uA to 10uA CR switch. 

t. Min. sampling Each measurement point of the impedance spectrum is 
performed during the period specified by minimum sampling 
time ‘t Min sampling’. This means that the number of measured 
sine waves is equal to t Min sampling * frequency. If this value is 
less than 1 sine wave, the sampling is extended to 1 / frequency. 
So, for a measurement at a frequency, at least one complete 
sine wave is measured. 
Reasonable values for the sampling are in the range of 0.1 to 1 s. 

t. Max equilibration The impedance measurement requires a stationary state. This 
means that before the actual measurement starts, the sine wave 
is applied during ‘t Max equilibration’ only to reach the 
stationary state. 
The maximum number of equilibration sine waves is however 5. 
The minimum number of equilibration sines is set to 1, but for 
very low frequencies, this time is limited by ‘t Max equilibration’. 
The maximum time to wait for a stationary state is determined 
by the value of this parameter. A reasonable value might be 5 
seconds. In this case, this parameter is only relevant when the 
lowest frequency is less than 1/ 5 s or 0.2 Hz. Increasing this 
parameter can be beneficial when measuring unstable or noisy 
samples at low frequencies, although it will extend the overall 
measurement time. 

 

6.3.1.6 Parameters applicable for PalmSens3 only 

Allow AC coupled 
measurements > 200 
Hz 

Enables the use of ac-coupled measurements when reading the 
current during measurements above 200 Hz. This option 
increases accuracy, but also increases sensitivity to noise and 
might introduce a ‘jump’ around 200 Hz. 
 

Disable use of High 
Stability mode 

The High Stability Mode is enabled by default for measurements 
at frequencies below 400 Hz. This mode filters out high-
frequency noise and increases the stability of the measurement. 
If a small jump in phase shift is observed in a measurement 
around 400 Hz, it is advised to disable this mode. 
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Sensitivity mode Determines the maximum gain used and therefore resolution in 
the measurements. If measured signals in the scope window 
seem too noisy, a lower sensitivity might be helpful.  
 

6.4 Parameters for Galvanostatic EIS 
In Galvanostatic-EIS (GEIS) the current through the cell is controlled rather than the potential 
across the cell as with standard EIS. In some cases, it’s preferred to perform the EIS 
measurement in galvanostatic mode e.g. when measuring low impedance cells. To prevent 
large currents on low impedances low amplitudes can be used in potentiostatic mode, 
however, the cell impedance may change during the measurement giving unexpected change 
in currents. In Galvanostatic mode, the current amplitude is controlled and set by the user. 

 

Scan type Default: this is the setting for the regular GEIS experiment. The dc-
current ‘i dc’ will remain fixed at a determinate value.  
i dc scan: multiple measurements will be conducted with different dc-
current levels, starting from 'i begin' and ending at 'i end' in 
increments determined by the 'i step'. At each dc-current level, a 
single fixed frequency is applied, or a frequency scan is made, 
according to the set ‘Frequency type’. 
Time scan: repeated measurements at a defined ‘i dc’ will be 
conducted and recorded versus time. 

 

6.4.1.1 Parameters for Scan type = i dc scan 

Applied current 
range 

The range in which the specified current values (such as ‘i begin’, ‘i 
end’ and ‘i step’) will be applied.  

 Applicable applied currents for each instrument: 
 
 Applied Available Ranges (CR) 

PalmSens3 -3 to 3 * CR 1 µA to 10 mA 

PalmSens4 -6 to 6 * CR 1 nA to 10 mA 

EmStat4 LR -3 to 3 * CR 10 nA, 1 µA, 100 µA, 10 mA 

EmStat4 HR -3 to 3 * CR 1 µA, 100 µA, 10 mA and 100 
mA 

 

i begin Current at which the scan starts expressed in the Applied current 
range. 
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i step The current step size. Sets the increment to be used between ‘i 
begin’ and ‘i end’. 
 
The applicable minimum ‘i step’ for each instrument is: 
 

PalmSens1 and 2 0.001 * CR 

PalmSens3 0.00015 * CR 

PalmSens4 0.000075 * CR 

EmStat4 LR 0.0001 * CR 

EmStat4 HR 0.000183 * CR 
 

i end Current at which the scan ends expressed in the Applied current 
range. 

 

6.4.1.2 Parameters for Scan type = Time scan 

t run Total run time of the scan. 
 
Run time for each instrument: <1 s to 1,000,000 s 

t interval The minimum interval time between each data point (Frequency 
type=Fixed) or between each frequency scan (Frequency 
type=Scan). The interval time cannot be lower than the required 
time to measure the data point or perform the frequency scan + 
overhead time.  

 

6.4.1.3 Parameters for all scan types 

i dc The dc current applied during the EIS scan is expressed in the 
Applied current range. 

i ac The amplitude is in the RMS value as a factor of the used current 
range. The maximum factor is 0.4 per current range except for 
the 10mA current the max factor is 0.2 x 10 mA. 

Frequency type Fixed: a single frequency is applied for the given duration or at each 
potential step or time interval. 
Scan: a frequency scan is performed starting at the given ‘Max. 
frequency’ to the given ‘Min. frequency’. This is the setting for the 
regular GEIS experiment. 

Frequency The applied frequency (in case of Frequency type=Fixed). 

Show time domain 
data 

Only visible for EmStat4-series instruments. When enabled a 
Scope window is shown during the measurements to view the 
time domain data as sinewaves or in a Lissajous plot. 

 

6.4.1.4 Parameters for Frequency type = Scan 

n frequencies The number of frequencies to apply between the given Max. 
frequency and Min. frequency.  
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Max. frequency The frequency to start the frequency scan on. In galvanostatic 
mode, the bandwidth of the current follower affects the stability 
of the system. For this reason, the maximum frequency is limited 
to 100 kHz for the Palmsens4. 

Min. frequency The frequency to end the frequency scan on.  

 

See also “Frequency scan settings” in the section: Setting up an impedance measurement on 
page 117. 

6.4.1.5 Advanced parameters under […] button 

t. Min. sampling Each measurement point of the impedance spectrum is 
performed during the period specified by minimum sampling 
time ‘t Min sampling’. This means that the number of measured 
sine waves is equal to t Min sampling * frequency. If this value is 
less than 1 sine wave, the sampling is extended to 1 / frequency. 
So, for a measurement at a frequency, at least one complete 
sine wave is measured. 
Reasonable values for the sampling are in the range of 0.1 to 1 s. 
Increasing this parameter can be beneficial when measuring 
unstable or noisy samples at high frequencies. 

t. Max equilibration The impedance measurement requires a stationary state. This 
means that before the actual measurement starts, the sine wave 
is applied during ‘t Max equilibration’ only to reach the 
stationary state. 
The maximum number of equilibration sine waves is however 5. 
The minimum number of equilibration sines is set to 1, but for 
very low frequencies, this time is limited by ‘t Max equilibration’. 
The maximum time to wait for a stationary state is determined 
by the value of this parameter. A reasonable value might be 5 
seconds. In this case, this parameter is only relevant when the 
lowest frequency is less than 1/ 5 s or 0.2 Hz. Increasing this 
parameter can be beneficial when measuring unstable or noisy 
samples at low frequencies, although it will extend the overall 
measurement time. 

6.5 Parameters for Fast EIS and Fast GEIS 

This technique is only supported by instruments  
from the EmStat4-series. 

The Fast EIS and Fast EIS techniques provide a form of EIS where the latency between each 
measured datapoint is reduced to a minimum of 1 ms, starting at a frequency of 10 kHz. This 
allows for observing rapid impedance changes on a cell at a fixed frequency. 

See the previous section for more detailed information about the allowed ranges for each 
technique parameter. 
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6.6 Running an EIS measurement 
The sequence of the measurement depends of course on the specified parameters. 

1. In case Measure vs OCP is enabled: determine the OCP. 
2. If ‘t condition 1’ > 1 s, apply E condition1 and wait the specified time 
3. If ‘t condition 2’ > 1 s, apply E condition2 and wait the specified time 
4. Apply the dc-potential at which the impedance has to be measured and wait ‘t 

equilibration’ seconds. 
5. Apply sine wave and wait for the stationary state, using the parameters as 

described above. 
6. Sample the impedance value by measuring at least one complete sine wave, but 

during at least the specified ‘t Min. sampling’. 
7. Perform the necessary calculations and present them in the ‘EIS Plot’ window. 

The next measurement is now done by stepping back to step 1, step 3 or step 4: 

8. Goto step1: if the checkbox ‘Pretreat each frequency’ or ‘Pretreat each scan’  
9. Goto step 3: if the next dc-potential has to be applied 
10. Goto step 4: if another frequency has to be applied and the checkbox ‘Pretreat 

each frequency’ has NOT been checked. 

In case a ‘Time scan’ is made, the program waits until the ‘t interval‘ has been completed. 

6.6.1 The Scope window 

During the measurement the measured time domain response is presented in the Scope 
window. For PalmSens4, this data is always shown. For other instruments, the recording of time 
domain data needs to be enabled in the Method Editor. The EmStat Pico and derived Sensit-
series instruments are not capable of recording time domain data. 

The EmStat Pico does not support the Scope window shown 
during measurements. 

 

Figure 110 The Scope window 
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The Scope window is used to check that the response is not distorted by higher harmonics or 
noise (especially 50/60 Hz from mains) and whether the current is not measured in an overload 
situation. 

By utilizing the selection buttons, you have the ability to present time domain data in two 
distinct forms: sinusoidal waveforms or Lissajous plots. In the latter representation, the plotted 
relationship between measured current and potential provides valuable insights. Importantly, 
data is stored for each frequency, allowing separate viewing after measurements are done. 

Closing the Scope window clears the time domain data from 
memory, which is not saved with the measurement file.  

6.6.2 Measurement results 

The presented numerical results are: 

▪ dc current 
▪ ac current, both in units of the applied current range 
▪ Impedance amplitude Z and phase shift in degrees 
▪ Real or in-phase impedance Z’ and imaginary or out-of-phase impedance Z’’ 

The measured data can graphically be presented in different ways. 

 

 

Figure 111 Impedance plot options 
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For a frequency scan: 

▪ -Z’’ vs Z’, also called the “Nyquist plot” or “Complex plot” 
▪ Log |Z| vs log f 
▪ Log |Z| and -Phase (shift) vs log f, also called the “Bode plot” 
▪ Y’’ vs Y’, also called the “Admitance Nyquist plot” 
▪ Log Y vs Log f, also called the “Admitance Bode plot” 
▪ Y’ and Y’’ vs Log f 
▪ C’ vs C’’, also called “Complex Capacitance plot” 

For a time or potential scan: 

▪ Z’ and Z’’ vs time (t) or potential (E) 
▪ Z and -Phase (shift) vs t or E 
▪ Y’ and Y’’ vs t or E 
▪ Y vs t or E 
▪ C vs t or E 
▪ C’ and C’’ vs t or E 

Please note that if a plot of Y vs potential is made, the plot in fact is an ac-voltammogram. 

The numerical values of impedance, phase shift, and admittance are shown in the ‘Data’ tab. 

The series capacitance Cs is 1 / (j * f * 2 * pi * Z’’) where the imaginary component j can be ignored 
as there is no real part to contribute to the magnitude. The real and imaginary capacitance are 
calculated as follows C’ = Z’’ / (f * 2 * pi * |Z|2) and C’’ = Z’ / (f * 2 * pi * |Z|2). 

 

 

Figure 112 Data tab showing the raw measured data 

6.7 Optimizing EIS Parameters for Improved Results and 
Troubleshooting 
EIS measurements can be very sensitive to electromagnetic noise. To address and mitigate 
potential noise issues, please refer to section “Reducing noise on page 51” for detailed 
guidance. Here are the primary parameters you can adjust to troubleshoot the most common 
issues encountered when conducting impedance measurements. 

E dc: as the EIS data may be challenging to interpret, setting the DC potential (E dc) to match a 
stable OCP is a common practice. This approach helps initiate the experiment as close to a 
'Steady State' as possible, minimizing variations in other system properties throughout the 
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frequency sweep. Therefore, it is advisable to ensure a stable OCP curve before starting an EIS 
measurement, unless your experiment necessitates a different configuration. 

E ac, also called “AC amplitude”, plays a critical role in EIS experiments. To ensure accurate and 
reliable data, it's important to strike the right balance. Keeping the amplitude small is essential 
to prevent the appearance of significant higher harmonics of the applied AC frequency, which 
can complicate data interpretation and introduce redox reactions that are typically beyond the 
scope of common EIS experiments. To assess the suitability of your amplitude, if your 
instruments offers a 'Scope window', you can examine the shape of the current wave. If it 
deviates substantially from a sine wave, it may indicate that the system is operating outside its 
linearity region, suggesting the need for a lower amplitude. 

Conversely, there are instances where increasing the amplitude becomes necessary. If your 
system exhibits high impedance results, often in excess of megaohms, and you still encounter 
noise or inconsistent curves, adjusting the amplitude upwards may be beneficial. In such cases, 
even with an increased potential amplitude, the net current remains relatively low, allowing you 
to maintain linearity while improving signal quality. 

Max. frequency: when conducting EIS measurements, it's essential to be mindful of the 
maximum frequency setting. For the most common 3-electrode electrochemical cells, like 
those with metal electrodes in aqueous solutions, frequencies exceeding 10 kHz are often 
unnecessary. The reference electrode's response time is a limiting factor, and any variations 
observed at higher frequencies may be attributable to artifact signals. While high frequencies 
offer faster data collection, they may require time-consuming data filtering or exclusion. To 
avoid this, consider initiating your measurements with a lower frequency setting. 

However, if your application demands higher frequencies, such as when working with solid 
electrolytes, be aware of potential inductance issues arising from cables and connections. 
These can affect data accuracy, so proper consideration of cable quality and connections 
becomes essential for precise measurements. 

t. Min sampling: when confronted with inconsistent data in the high-frequency region, 
consider increasing the minimum sampling time. This adjustment can help stabilize data 
collection and improve the reliability of measurements, especially when dealing with rapid 
changes or fluctuations in the system's response at higher frequencies. 

6.8 Fitting measured EIS data in PSTrace 
PSTrace comes with an advanced Equivalent Circuit fitting tool.  

See also section: Equivalent Circuit Fitting on page 135. 

6.9 Export for analysis and circuit fitting 
PSTrace comes with an advanced Equivalent Circuit fitting tool. However, PSTrace also allows 
exporting EIS data to Scribner’s ZView and the free program EIS Spectrum Analyser. Measured 
data in PSTrace can be opened or added to ZView with a one-click action.  

6.9.1 Free EIS Spectrum Analyser 

Data can be saved in a file that is loaded in the third-party program (free of charge) EIS 
Spectrum Analyzer, written by Alexander S. Bondarenko and Genady A. Ragoisha and is 
available from: 
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http://www.palmsens.com/eisspectrumanalyser. 

This program allows users to fit the measured data to specific equivalent circuits and for 
instance obtain the best values of the elements in the equivalent circuit, for instance, R, Rct 
and Cdl. 

The file can be saved using the button in the toolbar left from the plot: 

 

Or from the EIS Plot menu: 

 

 

Figure 113 EIS plot menu 

For detailed instructions consider the manual of EIS Spectrum Analyser.  

6.9.2 ZView 

If ZView 3.3 or later is installed, PSTrace will detect this automatically. A one-click-export button 
will appear next to the plot. The measurement selected in the Legend will be exported to ZView. 

 

 

Figure 114 ZView one-click-export button 

 

 

Figure 115 Equivalent circuit model in ZView 

Multiple measurements can be run from PSTrace and fitted on the active circuit model in ZView 
with a single click from PSTrace. 

http://www.palmsens.com/eisspectrumanalyser
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For detailed instructions consider the manual of ZView. 

6.9.3 Origin 

Origin from OriginLab is scientific graphing and data analysis software widely used at 
universities.  

See for more information: http://www.originlab.com/ 

If Origin is installed on the PC where PSTrace is running on an extra button appears in the 
toolbar next to the plot: 

 

Figure 116 Origin one-click-export button 

When clicking this button, Origin will be opened showing the selected EIS data directly in a 
Work sheet.  

If the button is not showing and Origin is installed, open the General settings window in the 
menu ‘Tools’ → ‘General settings…’ and check in the ‘Plot and data’ tab if the location for Origin 
is properly set. 

 

 

Figure 117 Location for Origin specified in the Settings window 

To change the exported columns for EIS data, click the button ‘Set columns for exporting EIS 
data’ on the left-hand side of the Settings window. 

http://www.originlab.com/
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6.10 Limitations for EIS on EmStat Pico 

This section also applies to instruments based on the EmStat Pico 
potentiostat module,  
including the Sensit BT and Sensit Smart. 

Electrochemical Impedance Spectroscopy (EIS) measures the change of the complex 
impedance over a frequency range (spectrum). The common way to calculate the complex 
impedance is by dividing the complex voltage by the complex current. The ADUCM355 has only 
1 ADC so it is not possible to measure both signals (voltage and current) at the same time. Thus 
the proposed solution to enable EIS measurement using only the current signals is a 3-stage 
measurement. The total EIS measurement for one single frequency point is split up into three 
measurements on three different impedances: 

1. Zcell + Rload  

2. Rload (load resistor in the WE signal path) 

3. Rcall (calibration reference resistor) 

Since all three measurements are performed under the same conditions and Rcall is a reference 
resistor of known value, the final complex impedance of Zcell can be calculated having only the 
complex currents of the three measurements.   

6.10.1 Complex voltage correction 

For the plain ADuCM355 the conditions for the 3 measurements are equal, for the Emstat Pico 
the measurement on the Zcell+Rload is performed using external RE-buffers introducing a 
complex transfer function for the applied AC voltage on the Zcell+Rload. This complex voltage 
transfer function is modeled by an electronic circuit simulation of the gain and phase behavior 
of the transfer function.  

6.10.2 Time-domain sinewave 

The Emstat Pico integrates a DFT calculation block enabling onboard complex current 
calculations. In contrast to other Palmsens devices having the EIS feature, the raw ADC signal is 
not available and therefore the time-domain signal cannot be shown in a host application 
(PSTrace, PStouch) 

6.10.3 Measurement duration 

The accuracy of the complex current depends on the number of the applied frequency cycles 
presented to the DFT process. For higher frequencies, the time to measure multiple cycles is 
relatively short in contrast to the lower frequencies. For example, measuring 8 cycles of 1 Hz 
takes 8 seconds resulting in a 24 seconds measurement duration for a complete 3-stage 
measurement. 

6.10.4 Current ranges 

Since the conditions must be the same, all 3 measurements must be performed using the same 
current range. Rload (~100 Ω) and the Rcall (1 kΩ or 100 kΩ) are fixed values, however the 
complex current measurements are frequency depended due to parasitic effects of the signals 
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path. The changes of Zcell vs frequency can be so large that it cannot be covered by staying in 
the same current range. Auto current ranging dynamically changes the current range (in 
combination with the PGA) to cover the frequency range in the EIS measurement.     

 

 

Figure 118 DFT signal path block diagram for EmStat Pico 

More details can be found in the “ADuCM355 Hardware Reference Manual- UG-1262”, pages 
137-143. 
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7 Equivalent Circuit Fitting 

The Circuit Editor can be used to build, simulate, and fit equivalent circuits on your 
Electrochemical Impedance Spectroscopy data. The following chapters present an overview of 
the circuit editor’s options and features. 

For more detailed information on fitting equivalent circuits electrochemical impedance 
spectroscopy measurement the following literature is recommended: 

▪ Electrochemical Impedance Spectroscopy. Chapter 23: An Integrated Approach to 
Impedance Spectroscopy. Mark E. Orazem & Bernard Tribollet, ISBN: 978-0-470-
04140-6. 

▪ Electrochemical Impedance Spectroscopy and its Applications. Chapter 14: Modeling 
of Experimental Data. Andrzej Lasia, ISBN: 978-1-4614-8932-0. 

7.1 Overview 
The circuit editor has two different modes: 

▪ Edit mode: draw the circuit or type CDC circuit. You typically start with this mode, but 
afterwards you can return to it whenever you need to redraw the circuit. 

▪ Fit mode: fit the EIS data on the drawn circuit or simulate a response of the circuit. 

7.1.1 Circuit Edit Mode 

 

Figure 119 Circuit Editor main window in Edit Mode. 

Available circuit components

Graphical circuit editor

Toggle between Edit and Fit modes

Circuit CDC editor

Copy image of circuit to clipboard

Close window
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7.1.2 Circuit Fit Mode 

 

Figure 120 Circuit Editor main window in Fit Mode. 

7.2 Opening the circuit editor 
The circuit editor can be opened from the EIS Plot tab in PSTrace. To fit a circuit the 
measurement to fit on must be selected from the Session Manager first. When no measurement 
is selected it is only possible to simulate circuits. 

 

 

Figure 121 Button for opening Circuit Fitting window 

7.3 Switching between Edit mode and Fit mode 
The circuit editor has two modes. 

1. In Edit Mode circuits can be built, edited, loaded and saved. 

2. In Fit Mode the circuit built in the Edit Mode can be simulated or fit on the 

electrochemical impedance spectroscopy data. (Note: Fitting is only possible when a 

measurement was selected in the Session Manager while opening the circuit editor.) 

To switch from the edit mode to the switch mode either press the Fit Mode button or select Fit 
Mode from the view menu. 
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Figure 122 Switching between the two modes 

To switch from the fit mode to the edit mode either press the Edit Mode button or select Edit 
Mode from the view menu. 

   

Figure 123 Switching between the two modes 

7.4 Building a circuit in the graphical editor 
To build a circuit the circuit editor must be in edit mode. Circuits can be built graphically using 
the circuit components and the graphical circuit editor.  

7.4.1 Graphical circuit editor 

Circuits can be built graphically using the circuit components and the graphical circuit editor.  

7.4.2 Selecting a circuit component 

By default, the resistor is selected. To select another circuit component click on it. The eraser 
is used to remove components from the circuit. 

 

 

Figure 124 Circuit component selection buttons 

7.4.3 Adding a component to the circuit 

Components can be added in series or in parallel with other components. The first component 
is added by hovering the mouse cursor over the open connector in the graphical circuit editor 
and clicking the left mouse button.  
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Figure 125 The open connector 

When hovering the mouse cursor over a connector it will turn green and a grey preview of the 
component is displayed. 

 

Figure 126 Preview of the component 

By clicking the left mouse button the component is added to the circuit. 

 

Figure 127 The inserted component. 

To add components in serial the mouse cursor must hover over a connector. Clicking on the 
left mouse confirms the placement of the component. 

 

 

Figure 128 Adding components in series 

Components can be added in parallel to other components by hovering the mouse cursor over 
the component it must be placed parallel to. When hovering the mouse cursor over another 
component it will turn green to indicate that it is selected and a preview parallel component is 
shown in grey. Click the left mouse button to confirm the placement of the component in the 
circuit. 
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Figure 129 Preview of a parallel component 

 

Figure 130 Component added in parallel 

When creating larger circuits it is useful to know that components can be added in parallel 
within or over a parallel group in the circuit.  

To place a component in parallel to a component within a parallel group directly hover the 
mouse cursor over the other component and click on the left mouse button. 

 

Figure 131 Placing a component in parallel to a component within a parallel group 

To place a component in parallel to the entire group hover the mouse cursor over the group. 
This will select the entire group (i.e. all its components will turn green). Clicking on the left 
mouse button will confirm the placement of the component. 

 

Figure 132 Placing a component in parallel to the entire parallel group 
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7.4.4 Removing components from the circuit 

Components can be removed from the circuit using the eraser tool. To remove a component, 
select the eraser tool. 

 

 

Figure 133 Eraser tool 

To remove a component or a group of parallel components hover the mouse cursor over it. 
The component(s) will turn green indicating that they are selected. Clicking the left mouse 
button will remove the selected components from the circuit. 

 

Figure 134 Removing a single component 

 

Figure 135 Removing a group of components 

7.5 Building a circuit with the CDC editor 
Every equivalent circuit for EIS data fitting can be represented by a CDC or Circuit Description 
Code. The CDC circuit editor is located at the bottom of the circuit editor. To build a circuit 
using the CDC circuit editor click on it and type the circuits CDC code. If the CDC code is valid 
the circuit is updated directly in the graphical circuit editor. The CDC code is described by 
Boukamp in:  

Boukamp BA (1986) A package for impedance/admittance data analysis. Solid State Ionics 18 & 
19, 136-40. 

 

 

Figure 136 Field for entering CDC directly 
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7.5.1 Supported CDC characters 

The following table shows which characters are supported by the CDC circuit editor. 

Table 8 Supported character for writing the CDC 

Key Function 

 

Inserts a resistor. 

 

Inserts a capacitor. 

 

Inserts an inductor. 

 

Inserts a Warburg impedance. 

 

Inserts a constant phase element. 

 +  

Inserts a parenthesis defining the beginning of a parallel 
group.  

 +  

Inserts a parenthesis defining the end of a parallel group. 

 

Inserts a bracket defining the beginning of a series group. 

 

Inserts a bracket defining the end of a series group. 

 

7.5.2 Supported CDC controls 

The following table shows which keyboard control keys are supported by the CDC circuit 
editor. 

The mouse cursor places the text cursor in the CDC editor by clicking the left mouse button. It 
can also be used to select text in the CDC editor by holding down the left mouse button and 
dragging the cursor over the CDC characters it should select. 

Table 9 Supported character for writing the CDC 

Key Function 

  

The arrow keys move the text cursor left and right 
respectively. In combination with Shift, they select CDC code. 

   
 

Home and end move the cursor to the beginning or end of the 
CDC code respectively. In combination with Shift, they select 
CDC code. 

 

Backspace removes the CDC character to the left. 

 

Delete removes the CDC character to the right. Backspace 
cannot be used to remove a selection of CDC characters.  
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 +  

Control + A selects all of the CDC code. 
 

 +  

Control + C copies the selected CDC code to the clipboard. 
 

 +  

Control + X cuts the selected CDC code and sends it to the 
clipboard. 
 

 +  

Control + V pastes the contents of the clipboard to the 
location of the text cursor. 

7.5.3 Adding components 

Components are added to the circuit by typing the keys of the supported characters.  

 

Figure 137 Pressing R will add a resistor to your circuit 

To add components in parallel parenthesis must be used. After opening the parenthesis the 
CDC editor will turn red indicating the CDC code is invalid at the moment. Ignore this and add 
the components that should be placed parallel to each other.  

1.   2.  3.  

Figure 138 Entering CDC code for components parallel to each other 

As soon as the parenthesis are closed the CDC code will become valid again and the graphical 
circuit editor will display the circuit as well. 

 

Figure 139 Graphical representation of the (RC) circuit in the graphical circuit editor 

 

Figure 140 Example of a CDC code with three components parallel to each other 
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Within a group of components parallel to each other brackets must be used to add a 
component in series to one of the components. After opening the brackets the CDC editor will 
turn red indicating the CDC code is invalid at the moment. Ignore this and add the components 
that should be placed series to each other.  

1.  2.  3.  

Figure 141 Entering CDC code for components in series within a parallel group 

 

Figure 142 Graphical representation of the ([RW]C) circuit in the graphical circuit editor 

In some cases it is easier to copy and paste parts of the CDC code to quickly build a large circuit. 
This can be done using the supported CDC controls.  

1.  2.  3.  

Figure 143 Copying and pasting in the CDC editor 

7.5.4 Removing components 

Components can be removed from the circuit with the CDC circuit editor by placing the text 
cursor next to the component that should be removed and using the supported CDC circuit 
editor controls. Pressing backspace or delete removes the CDC character to the left or right of 
the text cursor respectively. The changes to the circuit are directly visible in the graphical 
circuit editor. 

1.  2.  

Figure 144 Backspace removes the constant phase element to the left of the text cursor 

1.  2.  

Figure 145 Delete removes the capacitor to the right of the text cursor 

Removing a parenthesis or bracket from a valid CDC code will invalidate it.Tthe CDC circuit 
editor will indicate this by turning red. This happens typically when you want to remove a 
parallel or series group from a circuit. 

1.  2.  3.  4.  5.  

Figure 146 Removing a parallel group from a circuit using backspace 

In this example the parentheses around the second resistor are removed as they no longer have 
any meaning. 
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A selection of CDC characters can be removed by cutting or deleting it with control + x, 
backspace or delete. The selection can also be replaced by pasting data from the clipboard, 
control + v, or replacing it with any of the supported characters. 

1.  2.  

7.5.5 Invalid CDC code 

In the case of an invalid CDC code the CDC circuit editor indicates this by turning red. The 
graphical circuit editor is not updated until the CDC code is valid again, this is indicated by the 
CDC circuit editor turning white again. 

When adding or removing a parallel or series group from a circuit using the CDC circuit editor 
ignore that the code is invalid, as it will be valid again once the entire parallel or series group 
has been added or removed. 

When using the graphical circuit editor in combination with the 
CDC circuit editor hovering the mouse over the graphical 
representation will remove any invalid CDC code in the CDC 
circuit editor. 

 

 

Figure 147 Invalid placement of closing parenthesis 

Here the invalid CDC code can be resolved by removing the closing parenthesis between the 
resistor and Warburg impedance and placing it at the end of the CDC code. 

 

Figure 148 Unbalanced amount of opening and closing parentheses or brackets 

Here the invalid CDC code can be resolved by adding an opening parenthesis or removing a 
closing parenthesis, as the amount of opening and closing parenthesis is unbalanced in this 
example. 

 

Figure 149 Unsupported CDC characters have been pasted into the CDC circuit editor 

This code is invalid because unsupported CDC characters were pasted into the CDC circuit 
editor from the clipboard. To resolve this, the unsupported CDC characters must be removed. 
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7.6 Loading and saving circuits 
Circuits can be stored in and retrieved from the circuit database which is stored locally in a 
folder on the computer. The load and save options are in the Circuit menu.  

 

Figure 150 “Circuit” menu  

To load or save a circuit the circuit editor must be in edit mode. 

7.6.1 Loading a circuit 

To load a circuit, open the load circuit screen by selecting load in the Circuit menu. In this 
screen the available circuits stored on your computer are listed in the circuit browser on the 
left. A preview of the selected circuit is presented in the preview panel on the right. 

 

 

Figure 151 “Load circuit” window 

The selected circuit can be loaded by pressing on the Load button or double-clicking on the 
circuit. 

7.6.2 Saving a circuit 

Circuits can be saved using the save circuit screen. To open the save circuit screen select save 
in the Circuit menu. The option to save a circuit is only available if there is a circuit containing 
at least one component in the editor. The save circuit screen contains a circuit browser and a 
field to input the name of circuit that is being saved. 
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Figure 152 “Save circuit” window 

To save the circuit press the save button. Optionally a name can be assigned to the circuit in 
the circuit name input field.  

7.7 Fitting or simulating a circuit 
After an equivalent circuit has been built or loaded into the circuit editor in “Edit Mode” it can 
be simulated or fit onto the data of the electrochemical impedance spectroscopy 
measurement.  

7.7.1 Simulating a circuit 

The impedance of circuits can be simulated using the circuit editor. When simulating the fit 
options are disabled. Check the title of the circuit editor or the view menu to see whether the 
circuit editor is set to simulation mode. 

   

Figure 153 Circuit editor set to simulation mode and fit mode. In fit mode the name of the 
measurement is visible in the title bar and the simulation is not checked in the view menu. 

Values of the components can be changed in the circuit table and the graphical circuit editor. 
Changing the value of a component in either the graphical circuit editor or the table will 
automatically update the value in the other. The effects of these changes will appear directly in 
the preview plot. 
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Figure 154 Changing the value of the Warburg Coefficient for a Warburg Impedance in the 
graphical circuit editor. 

 

Figure 155 Changing the value of the Warburg Coefficient for a Warburg Impedance in the 
circuit table. 

For example, changing the value of the Warburg Coefficient to 100 will lower the impedance at 
the lower frequencies. 

   

Figure 156 Simulation of the absolute impedance over frequency of a Randle’s circuit using 
the default values. 
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Figure 157 Simulation of the absolute impedance over frequency of a Randle’s circuit with the 
value of the Warburg Coefficient lowered to 100. 

Using the plot selector, it is possible to view the effects of lowering the Warburg Coefficient to 
100 on the negative phase angle over frequency and the Nyquist plot as well. 

 

 

Figure 158 Plot selector 

7.7.2 Setting the simulation’s frequency range 

The frequency range of the simulation can be set in the “Advanced Options” window which can 
be accessed by clicking on the ‘Advanced Options’ button. 

 

Figure 159 The ‘Advanced Options’ button 
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The simulations frequency range (Hz) can be specified in the simulation settings, by default this 
is 0.01 to 100000 Hz. 

 
 

 

Figure 160 Advanced Simulation Settings 

7.7.3 Fitting a circuit 

Before fitting the circuit, it is important to check whether the circuit editor is in simulation or 
fit mode. Check the title of the circuit editor or if the simulation option is checked in the view 
menu. 

  

Figure 161 Circuit editor set to simulation mode and fit mode. In fit mode the name of the 
measurement is visible in the title bar and the simulation is not checked in the view menu. 

To ensure a good fit on a measurement it is important to build the right equivalent circuit. It is 
often possible to achieve a good fit with different but similar circuits. Although these other 
circuits can provide a good fit, they are not necessarily an accurate representation of the cell 
that was measured. Selecting appropriate initial values for the components in the models is also 
recommended, as in some cases the fitting algorithm will get stuck in a local minimum and the 
quality of the fit is not optimal. 

As the complexity of the proposed circuit increases, achieving optimal results with the 
algorithm becomes more challenging without reasonable initial values. In certain instances, 
specific elements or sets of elements may tend towards values close to zero or infinite after a 
run (i.e.: resistor with less than a few microohms). This indicates that the algorithm is almost 
ignoring this part of the circuit, and is a stuck called “local minima”. To address this, it becomes 
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necessary to supply more realistic initial values. Additionally, you can also manually edit the 
minimum and maximum values in the table to further refine the simulation parameters.  

For more details, see the example of Maxwell fit: Fitting Example on page 165. 

7.7.4 Fitting on a specific frequency range 

The frequency over which you desire to fit the circuit can be specified either by clicking in the 
plot or by entering the values in the corresponding textboxes. 

Note: Specifying the frequency range over which to fit the data is only possible when in fit 
mode. To specify the frequency for a simulation please refer to the help section on simulating 
a circuit. Specifying the fitting frequency range is only possible in the plots that also show the 
measured data (i.e., the blue dots). 

Specifying fitting frequency with the mouse is done by moving your mouse over the sample 
from where you would like to start or end your fit, then double-clicking on that sample (blue 
dot). Then move your mouse to the data point where you would like to respectively end/start 
your fit and click on it once. The frequency range selected for fitting is indicated by the solid 
blue dots. 

 

 

Figure 162 Specifying the frequency range for fitting. Left: First move your mouse to the data 
point from which you would like to start the fit and click on it. Middle: Click on it again, now it 
will be the only data point selected (in this case the sample at 11.51 Hz). Right: Then move your 
mouse to the data point where you would like fitting to end and click on it. The selected 
frequency range is now indicated by the solid blue dots and the values in the text boxes below 
the plot. 

7.7.5 Excluding outliers 

To exclude outliers from a fit, hold down the Ctrl-button on your keyboard and drag a box 
around the outlier with your mouse to deselect it. Selecting that point again by dragging a box 
while holding down Ctrl, will reselect it. While dragging an area using the Ctrl- and the left 
mouse button, it is possible to (de)select all points in the specified area. 
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Figure 163 Deselecting specific points by holding Ctrl-button and dragging the left mouse 
button. 

7.7.6 Fixate a component’s value 

When necessary, it is possible to fixate the value of any given component in the model by 
checking its checkbox in the Fixed column. 

 

 

Figure 164 Fixating a value. 

7.7.7 Undo/Redo changes to component values 

The undo/redo buttons allow you to revert unwanted changes to the model’s component 
values either due to an incorrect fit or a mistake when entering the values. 
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Figure 165 In the case of a poor fit the values of a previous fit can be recovered by clicking on 
the undo button. 

In the next sections, brief instructions are given on selecting the components for the circuit. 
However, further reading on the topic is recommended:  

▪ http://www.consultrsr.net/resources/eis/index.htm  
▪ Electrochemical Impedance Spectroscopy. Chapter 23: An Integrated Approach to 

Impedance Spectroscopy. Mark E. Orazem & Bernard Tribollet, ISBN: 978-0-470-
04140-6. 

▪ Electrochemical Impedance Spectroscopy and its Applications. Chapter 14: Modelling 
of Experimental Data. Andrzej Lasia, ISBN: 978-1-4614-8932-0. 

  

http://www.consultrsr.net/resources/eis/index.htm
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7.8 Batch-fitting a circuit on multiple curves 
When multiple EIS curves are available, a single equivalent circuit can be fitted on multiple 
curves. 

 

Figure 166 Panel for selecting multiple EIS curves. 

When this panel is visible, the ‘Fit’ button applies to the checked curves only. The table showing 
the fit results and the results shown in the equivalent circuit apply to the curve selected in the 
same list.  

After fitting, the checkboxes can be used to show or hide the results in the Plot with the EIS 
data curves and fitted curves. 

The initial component values used for fitting can be copied to all curves in the list, using the 
button ‘Copy values to selected items’.  

7.9 Overview of circuit components 
 

The following components can be used to build equivalent circuits in the circuit editor. The two 
chapters after this chapter provide two examples of selecting the components for an 
equivalent circuit, setting/adjusting their values to obtain a good fit, and interpreting the 
quality of the fit. 

7.9.1 Resistor 

𝑍𝑅 = 𝑅  

The impedance of a resistor is independent of frequency, and it only contributes to the real 
component of impedance. Hence it does not affect phase shift and it is represented by a single 
dot in the Nyquist plot. By default, resistors are 1000 Ω in the circuit editor. 
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When modeling an electrochemical impedance measurement on a cell a resistor can be used 
to model the solution resistance (resistance between the working electrode’s surface and the 
tip of the reference electrode). 

 

Figure 167 Left: The absolute impedance of a resistor plotted against frequency. Top right: 
Phase shift of a resistor over frequency. Bottom right: In the Nyquist plot a resistor is seen as a 
single dot (little red dot in the center of the plot). 

7.9.2 Capacitor 

𝑍𝐶 = 1
𝑗𝜔𝐶⁄  

A capacitor’s effect on impedance pertains to its imaginary component and decreases with 
increasing frequency. On its own a capacitor causes a phase shift -90˚ independent of 
frequency (by default the negative phase is represented upwards). As it only affects the 
imaginary component of impedance, it is represented by a vertical line in the Nyquist plot. The 
default value of a capacitor is 1 µF in the circuit editor. 

 

Figure 168 Left: The absolute impedance of a capacitor plotted against frequency. Top right: 
Phase shift of a capacitor over frequency. Bottom right: Nyquist plot of capacitor.  

When a capacitor is placed in series with a resistor the circuit’s phase shift becomes frequency 
dependent. At low frequencies, it approaches 90˚ and at high frequencies it approaches 0˚. 
Thus, at high frequencies the capacitor’s effect on the circuit’s impedance and phase shift 
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becomes negligible and the circuit effectively behaves as a single resistor. The Nyquist plot 
below shows that the real component of the impedance remains 1 kΩ regardless of frequency. 

A resistor and capacitor in series model the impedance of an ideally polarized liquid electrode 
/ blocking electrode, i.e., an electrode that does not transfer charge with the surrounding 
solution. In this model, the resistor represents the solution resistance and the capacitor 
represents the product of the real surface of the electrode and its double layer capacitance. 
With increasing frequency there is less time for the electrochemical double layer to charge and 
its effects on impedance and phase shift diminish.  

Another application of a resistor and capacitor in series is modeling an ideal coating. Again, the 
resistor represents the solution resistance. But in this model, the capacitor represents the 
coating capacity. A coating’s capacity depends on the coating’s thickness, surface area, and 
dielectric constant.  

For more information on modeling corrosion, we recommend reading: 

Electrochemical Impedance Spectroscopy and its Applications. Chapter 11: Coatings and Paints. 
Andrzej Lasia, ISBN: 978-1-4614-8932-0. 

 

Figure 169 Left: The phase shift of a resistor and capacitor in series plotted against frequency. 
Top right: Absolute impedance over frequency. Bottom right: Nyquist plot.  

7.9.3 Inductor 

𝑍𝐿 = 𝑗𝜔𝐿 

An inductor is the reciprocal of a capacitor its effect also pertains to the imaginary component 
of impedance. However, in contrast to a capacitor, the impedance of an inductor increases with 
frequency and its phase shift is +90˚ frequency (by default the positive phase is represented 
downwards). It is also represented by a vertical line in the Nyquist plot, but in the opposite 
direction. In the circuit editor, the default value of an inductor is 100 µH. 

An example of a model where an inductor is used is a model of a faradaic reaction involving 
adsorption of one or more species. In certain cases, on the Nyquist plot inductive loops can be 
observed together with capacitive loops and it is possible to model inductance as the product 
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of the resistance of the charge transfer squared and the absorption pseudocapacitance. For 
further reading see: 

Electrochemical Impedance Spectroscopy and its Applications. Chapter 5: Impedance of the 
faradaic reactions in the presence of adsorption. Andrzej Lasia, ISBN: 978-1-4614-8932-0. 

 

Figure 170 Left: The absolute impedance of a inductor plotted against frequency. Top right: 
Phase shift of a inductor over frequency. Bottom right: Nyquist plot of Inductor. 

 

Figure 171 Nyquist plot of a circuit that can model faradaic reactions involving adsorption 
and subsequent desorption of a species. 

7.9.4 Warburg element 

𝑍𝑊 =
𝜎

√𝜔
− 𝑗

𝜎

√𝜔
 

A Warburg element is a component used to model the transfer of charge between the 
electrode and a redox species in the solution and the depletion of the diffusions layer’s inner 
layer. This Warburg element assumes there is a semi-infinite linear diffusion layer. Both the real 
and imaginary components of impedance increase equally with frequency. The equal decrease 
in real and imaginary impedance can be seen in the Nyquist plot and results in a constant phase 
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shift of 45˚. The unit of the Warburg coefficient, 𝜎, is Ohm to the power -0.5. The default value 
of the Warburg coefficient in the circuit editor is 1000. 

 

 

Figure 172 Left: The absolute impedance of a pure Warburg element plotted over frequency. 
Top right: Phase shift of a pure Warburg element over frequency. Bottom right: Nyquist plot 
of a pure Warburg element. 

The Randle’s circuit is often used to model the transfer of charge between the electrode and a 
redox species solution. The Randle’s circuit consists of two resistors, a capacitor, and a Warburg 
element. The first resistor is in series and represents the solution resistance. The electrode’s 
double-layer capacitance is represented by a capacitor parallel to a resistor that represents the 
charge transfer resistance and the Warburg element. At high concentrations of the oxidant, 
the semicircle and the diffusion are separated and at low concentrations, they overlap.  

 

Figure 173 Nyquist plot of a Randle’s circuit with a large value for the Warburg coefficient of 
the Warburg element. This represents the transfer of chare between the electrode and redox 
species with a low concentration of the oxidant (overlap of semicircle and diffusion).  
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Figure 174 Nyquist plot of a Randle’s circuit with a small value for the Warburg coefficient of 
the Warburg element. This represents the transfer of charge between the electrode and 
redox species with a high concentration of the oxidant (no overlap of semicircle and 
diffusion). 

Note that some authors refer to the Randle Circuit with just a 
R(CR) set, so without the Warburg element.  
This document refers to this circuit as the  
“Simplified Randle’s Circuit” 

7.9.5 Warburg Short/Open 

In contrast to the Warburg element, the Warburg short/open do not assume semi-infinite 
diffusion. 

𝑍𝑂 =
𝜎𝐵

(𝐵√𝑗𝜔)∅
tanh(𝐵√𝑗𝜔)∅ 

𝑍𝑇 =
𝜎𝐵

(𝐵√𝑗𝜔)∅
coth(𝐵√𝑗𝜔)∅ 

Respectively the Warburg short (ZO) and Warburg open (ZT) model the transmissive and 
reflective boundaries of a diffusion layer. Some authors use the terms "O element" and "T 
element" to describe these elements. Nevertheless, it's important to note that these letters 
refer to the hyperbolic cotangent and tangent, respectively, but in the admittance formulas 
(thus, the opposite). “B” represents the thickness (l) in meters (m) and the diffusion coefficient 
(D) of the diffusion layer in square meters per second (m2/s): 

𝐵 = 𝑙 √𝐷⁄ .  

The experimental parameter (Ø) has a maximum value of 1 when diffusion is uniform and is 
smaller when diffusion is nonuniform. The default values for the Warburg coefficient, B, and the 
experimental parameter are 1000 σ, 1 √s and 0.5 respectively. 
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Figure 175 Left: The absolute impedance of a Warburg open plotted against frequency. Top 
right: Phase shift of a Warburg open over frequency. Bottom right: Nyquist plot of Warburg 
open. 

 

Figure 176 Left: The absolute impedance of a Warburg short plotted against frequency. Top 
right: Phase shift of a Warburg short over frequency. Bottom right: Nyquist plot of Warburg 
short. 

The figure below shows various circuits illustrating the differences in the transfer of charge 
between the electrode and a redox species a solution, assuming finite diffusion 
transmissive/reflective boundary or semi-infinite diffusion. 
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Figure 177 Nyquist plot demonstrating the differences in diffusion at low frequencies for a 
Randle’s circuit (yellow line and bottom circuit), an electrode with a reflective boundary (blue 
line and top circuit) and an electrode with a transmissive boundary (red line and middle 
circuit). 

7.9.6 Gerischer element 

𝑍𝐺 =
𝑍0

√𝑘 + 𝑗𝜔
⁄  

The effects of a Gerischer element are similar to those of a Warburg open. However, the 
parameters of the model are different, Z0 is the magnitude of the impedance at ω = 1 rad/s and 
k is a reaction rate constant. The Gerischer element introduces a phase lag that is related to the 
kinetics of charge transfer processes. It is designed to model the effect of an electrochemical 
species reacting with something to form an inactive substance or absorbed species during the 
diffusion process. 
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Figure 178 Nyquist and Bode plots showing response of the Gerischer element 

7.9.7 Constant Phase element 

𝑍𝐶𝑃𝐸 = 1
𝑇(𝑗𝜔)∅⁄  

The Constant Phase element (CPE) is referred to by some authors as “Element Q”. It deserves 
to describe a frequency dispersion present in most real electrochemical double-layers. The CPE 
equation has two parameters: T, that is related to its capacitance and Φ, that is the constant 
phase exponent which is related to the deviation from an ideal capacitor. At a Φ of 1 the 
behavior of a constant phase element resembles that of a regular capacitor, for a Φ of 0.5 that 
of a Warburg element, and for a Φ of 0.0 that of a resistor. The unit of T is Siemens per second 
to the power Φ. The value of the constant phase exponent should be between 0 and 1; it 
regulates the constant phase which is -90 times Φ. The phase shift of a constant phase element 
is independent of frequency, the slope of the line in the Nyquist plot corresponds to the 
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magnitude of the phase shift specified by Φ. The default values of the constant phase element 
in the circuit editor are 1 µT and 1 Φ. 

 

Figure 179 Left: The absolute impedance of a constant phase element with a constant phase 
exponent of 1 Φ (i.e. a capacitor) plotted against frequency. Top right: Phase shift of a 
constant phase element over frequency. Bottom right: Nyquist plot of constant phase 
element. 

  

 

Figure 180 Left: The absolute impedance of a constant phase element with a constant phase 
exponent of 0.6 Φ plotted against frequency. Top right: Phase shift of a constant phase 
element over frequency. Bottom right: Nyquist plot of constant phase element. 

The constant phase element is used instead of a regular capacitor to model the double layer 
capacitance when an electrode displays a frequency-dependent dissipation/dispersion of 
energy (typical for nonuniform electrode surfaces). When studying a redox reaction without 
diffusion limitations the dissipation/dispersion of energy presents as a depressed semicircle in 
the Nyquist. See the figure below. 
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Figure 181 Nyquist plot of a redox reaction without diffusion limitations, with a solution 
resistance of 10 Ω, a charge transfer resistance of 1 kΩ and a constant phase element that 
represents the double layer capacitance of an ideally polarizable liquid electrode, i.e. a 
constant phase element with a phase exponent of 1 Φ (or a capacitor). 

 

Figure 182 Nyquist plot of a redox reaction without diffusion limitations, with a solution 
resistance of 10 Ω, a charge transfer resistance of 1 kΩ and a constant phase element that 
represents the double layer capacitance of a solid electrode with dispersion/dissipation of 
energy. Here the semicircle is shifted downwards as a result of the dispersion/dissipation, 
modelled as a constant phase element with a phase exponent smaller than 1 Φ. 

In the Bode plot, the most notable effect of the CPE compared to a regular capacitor is the 
reduction of the (negative) maximum phase shift. 
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7.9.8 Bisquert Short/Open 

𝑍𝑁 = √𝜁𝜒𝑡𝑎𝑛ℎ (𝐿√
𝜒

𝜁
) 

𝑍𝑀 = √𝜁𝜒𝑐𝑜𝑡ℎ (𝐿√
𝜒

𝜁
) 

 

where 𝜁 ≡
1

1

𝑍𝑅𝑘

+
1

𝑍𝑄𝑚

=
1

1

𝑅𝑘
+𝑇(𝑗𝜔)∅

 and 𝜒 ≡ 𝑍𝑅𝑚
= 𝑅𝑚 

 

The Bisquert Short (N) and Bisquert Open (M) can be used to model porous electrodes. These 
electrodes have a large surface area but the pores themselves contain a limited volume 
affecting the rate with which ions enter and react in the pores. L is a fixed parameter that 
represents the depth of the pore. ζ relates to the impedance of the active porous part of the 
electrode, Rk models the reaction resistance and Qm the diffusion / double-layer capacitance (a 
constant phase element is used to compensate for inhomogeneities of the pores). Finally, the 
χ relates to the impedance of the electrolyte within the pore. Both elements assume that 
reactions can only take place at the active porous part of the electrode. The Bisquert Short 
models an absorbing boundary condition where the contribution of the base electrode to the 
reaction can short the porous film. The Bisquert Open models a reflective boundary condition 
where the base electrode is insulating and cannot contribute to the reaction. For both 
elements the parameters are in the respective order; pore impedance (Rm), reaction resistance 
(Rk), diffusion of active porous area modeled by a constant phase element (T, φ) and pore depth 
(L).  

 

Figure 183 Nyquist plot demonstrating the differences in impedance of a porous electrode 
with an absorbing boundary. The blue line (Rm = 100 Ω, Rk = 1e20 Ω, CPE = (1 µT, 1 φ), L = 1) 
represents a situation where the diffusion reaction Qm is dominant, impedance of Rk >> than Rm 

and Qm. The red line (Rm = 100 Ω, Rk = 0.1 Ω, CPE = (1 µT, 1 φ), L = 1) where there is a 
homogeneous reaction with the absorbing boundary condition and a diffusion reaction. 
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Figure 184 Nyquist plot demonstrating the differences in impedance of a porous electrode 
with a reflecting boundary with different relations between reaction rate and diffusion rate. 
The blue line (Rm = 20 Ω, Rk = 1e20 Ω, CPE = (0.1 µT, 1 φ), L = 1) represents a situation where 
there is diffusion with a reflective boundary, impedance of Rk >> than Rm and Qm. The red line 
(Rm = 20 Ω, Rk = 100 Ω, CPE = (0.1 µT, 1 φ), L = 1) where the reaction at the active porous part is 
slower than the diffusion and the yellow line (Rm = 20 Ω, Rk = 10 Ω, CPE = (0.1 µT, 1 φ), L = 1) 
where the reaction is faster than the diffusion. 

For more information, please refer to: 

Theory of the Impedance of Electron Diffusion and Recombination in a Thin Layer. Juan 
Bisquert. (2002) The Journal of Physical Chemistry B. 106 (2), 325-333 

 

7.10 Fitting Example 
This example demonstrates the fitting of an equivalent circuit on a measurement with two 
distinct time constants (semi-circles). The measurement used in this example was performed 
on a PalmSens EIS Dummy Cell described in the figure below.  

This file is installed with PSTrace, by default in the folder: 

“<username>\Documents\PSData\EIS Examples” 

The figure below shows the dummy cell’s circuit, the values of its components, and a simulated 
of a Nyquist plot of the dummy cell.  

This example aims to demonstrate that three similar equivalent circuits can all fit the data 
accurately. Although the quality of the fit is similar the values of the components differ 
significantly emphasizing the importance of choosing the right equivalent circuit to interpret a 
measurement. 
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Figure 185 Nyquist plot of a simulation of the PalmSens EIS Dummy Cell 

7.10.1 Designing equivalent circuits 

There are two distinct time constants (semi-circles) visible in the Nyquist plot. Time constants 
can be modeled by placing a capacitor or constant phase element in parallel to a resistance 
(and optionally a Warburg element). For this example, three different circuits will be used, (1) a 
circuit with a Voigt structure (the same as the circuit inside the dummy cell), (2) a circuit with a 
ladder structure and (3) a circuit with a Maxwell structure. Voigt circuits are typically used for 
modeling the redox process on an electrode. Ladder circuits can be used when there are one 
or more adsorbed species, or to fit many types of corrosion-protective coatings. Maxwell 
circuits have been used to study dielectric phenomena.   

 

Figure 186 Three different circuits that can model measurements with two-time constants. 1: 
A Voigt circuit (the actual model of the dummy cell). 2: A Ladder circuit. 3. A Maxwell circuit. 

7.10.2 Fitting the circuits 

After the circuit has been drawn the Fit mode can be opened. Often the default values of the 
components are sufficiently close to their actual values and the fitting algorithm will fit the 
circuit correctly. However, in some cases circuit fitting algorithms end up in so-called local 
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minima, this inherits to mathematical optimization algorithms. The fitting of the three 
equivalent circuits on the measurement is demonstrated below. In the fit of the Maxwell circuit, 
some tips are also given on how to avoid getting stuck in local minima. 

7.10.3 Voigt 

The following image shows the fitting tab with at the top a Nyquist plot of the measurement 
(blue dots) and a simulation of the Voigt circuit with the circuit editors default values (red line). 
Clicking on the fit button will fit the equivalent circuit on the measurement. Assuming the 
measurement was performed correctly this circuit will directly give an accurate fit with the 
default values of the components. 

 

Figure 187 Fitting of the Voigt circuit. Left: the default values of the components result in the 
small red semi-circle. Right: After pressing the fit button the circuits semi-circles (time 
constants) no longer overlap and fit the measurement accurately. 

7.10.4 Ladder 

Just as the Voigt circuit the ladder circuit directly fits on the measured data without first getting 
stuck in a local minimum. The fitted values of the components are even quite close to those of 
the Voigt model. However, in the Maxwell circuit the resistor R3 is used to obtain the value of 
the pseudocapacitance and not for modeling the charge transfer resistance. 
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Figure 188 Fitting of the ladder circuit. Left: the default values of the components result in 
the small red semi-circle. Right: After pressing the fit button the circuits semi-circles (time 
constants) no longer overlap and fit the measurement accurately. 

7.10.5 Maxwell – local minima example 

As seen below the Maxwell circuit will not fit directly on the measurement, as it gets stuck in a 
local minimum. Therefore, it is necessary to refine the initial values of the circuit’s components 
to avoid ending up in this local minimum.  

 

Figure 189 Fitting of the Maxwell circuit. Left: the default values of the components are far 
from the actual values as the overlapping red semi-circles (time-constants) are much smaller 
than the ones that were measured. Right: clicking on the fit button will result in the fitting 
algorithm getting stuck in a local minimum, the model of the semi-circle clearly does not 
overlap with the measured data also the values several components are unrealistic. Thus, 
values of the components must be adjusted to obtain an accurate fit. 
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A general tip for avoiding local minima is providing a rough 
initial estimation in which the red semicircle(s) (i.e., the 
modelled time constants) approaches that of the measurement, 
preferably set the initial values so that the circuit’s semicircles 
are slightly larger than the measured semi circles.  

Based on the Nyquist plot the real component (x-axis) of the impedance is close to 25 kΩ at the 
lowest frequencies. In the Maxwell circuit resistor R2 is parallel to the second time constant (C2 
and R3) and the current will primarily flow through this resistor at low frequencies, thus 
increasing R2 to 25 kΩ should increase the total size of the overlapping semicircles. Before we 
will attempt to fit again, we will change the size of the capacitors to decrease the overlap of the 
resistors. During the last fit, the value of C2 got stuck at 48 kF which is unrealistically large, 
therefore, we will change it back to 1 µF. The value of R3, 349 kΩ, is also too high, so we will set 
it somewhere between 0 and 25 kΩ (this is where the imaginary component (y-axis) of the 
impedance approaches zero). Then, click on the fit button again and the fit should now be 
accurate. 

 

Figure 190 Left: the value of resistor R2 is increased to match the real impedance of the 
circuit at low frequencies (25 kΩ as seen on the x-axis on the plot above), as a result, the 
semicircle is now almost as wide as the measured semi-circles. Right: The unrealistically high 
capacitance of C2 is lowered back to 1 µF, this reduces the overlap of model’s the semi-circles. 
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Figure 191 Left: The very high resistance of R3 is lowered to 10 kΩ, a value between 0 and 25 
kΩ (i.e. the range of the real component of the impedance (x-axis)). This changes how the 
model's semi-circles overlap. Right: with the values of the components as specified in the left 
image the fitting algorithm now finds an accurate fit. 

7.10.6 Inspecting the quality of the fit 

The results of the fit are displayed in the table after fitting the circuit on the data. The chi-
squared test is a general indication of the fit’s quality. The lower the chi-squared value, the 
better the fit. The square root of the chi-squared statistic gives the average error of the fit. For 
these fits, this is 0.4% which is very good. The individual errors of the components are also 
given in the table. 

Achieving errors and chi-square values as low as these is uncommon in a real electrochemical 
cell, where numerous other variables can significantly influence the impedance response. The 
complexities and variability inherent in practical electrochemical systems often contribute to 
higher levels of uncertainty and deviations from idealized model fits. Therefore, these 
exceptionally low error and chi-square values may be challenging to replicate in real-world 
electrochemical scenarios where multiple factors come into play. 

Although the quality of the fit is good, the values of the components for the ladder and Maxwell 
model cannot be interpreted correctly as the specific processes of the cell that these 
components represent do not comply with the actual measurement, thus it is demonstrated 
that blindly assuming that your model is an accurate representation, just because it fits, might 
lead to circuits lacking actual physical meaning. 
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Table 10 Fitting results using Voigt model 

Voigt 

Element Fitted 
Value 

Unit Error% 

R 1 201.5 Ω 0.250 

C 1 1.028 μF 0.357 

R 2 14.98 KΩ 0.164 

C 2 32.54 nF 0.097 

R 3 9.997 KΩ 0.124 

    

Chi-Squared: 1.33E-5 Iterations: 17 

 

Table 11 Fitting results using Ladder model 

Ladder 

Element Fitted 
Value 

Unit Error% 

R 1 201.5 Ω 0.250 

C 1 31.54 nF 0.095 

R 2 10.63 KΩ 0.113 

C 2 1.042 μF 0.357 

R 3 14.34 KΩ 0.170 

    

Chi-Squared: 1.33E-5 Iterations: 20 

 

Table 12 Fitting results using Maxwell model 

Maxwell 

Element Fitted 
Value 

Unit Error% 

R 1 201.5 Ω 0.250 

C 1 31.54 nF 0.095 

R 2 24.97 KΩ 0.092 

C 2 0.343 μF 0.343 

R 3 18.52 KΩ 0.200 

    

Chi-Squared: 1.33E-5 Iterations: 10 

 

Visual inspection of the fit’s quality is also possible by changing the plot to either the error in 
the magnitude of the impedance over frequency, the error in the real component of 
impedance over frequency or the error in phase shift over frequency. These plots represent 
the difference in magnitude of impedance, real impedance, and phase shift between the fit of 
the equivalent circuit and the measured data. As seen in the figure below there are subtle 
discrepancies in impedance at the lower frequencies and phase shift at higher frequencies 
between the equivalent circuit and the measurement. 
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Figure 192 Error plots displaying the differences in impedance and phase shift between the 
equivalent circuit and the measurement.  

7.10.7 Adjusting the advanced fit options 

In some cases, you may wish to adjust the fitting options to obtain the type of fit that you want. 
In the Advanced Options window of the circuit editor, several advanced options can be set. 
These options include selecting a frequency range over which you would like to fit your 
equivalent circuit and adjustments to the default parameters of the fitting algorithm. 

 

 

Figure 193 Advanced Options window for fitting EIS data 

7.11 Fitting algorithm 
There are two different fitting algorithms available, which can be selected in the “Advanced 
Options” window in the circuit editor: the Levenberg-Marquardt algorithm and the Nelder-
Mead algorithm.  

7.11.1 Levenberg-Marquardt 

The Levenberg-Marquardt algorithm is available for finding the minimum complex non-linear 
sum of squares. The advantages of this algorithm are that it is robust and generally quick at 
finding a solution. A disadvantage of the Levenberg-Marquardt algorithm is that it was not 
designed to work with specified minimum and maximum values for components. As a result, 
the algorithm sometimes ends up in local minima or saddle points with unrealistic values for 
the components (i.e., extremely large/small or negative values). Local minima and saddle 
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points are inherent to mathematical optimization algorithms and in some cases, a good fit will 
require changing the default values of the components before performing the fit. Typically, 
when fitting equivalent circuits the Levenberg-Marquart will provide better results than the 
Nelder-Mead algorithm. 

7.11.2 Nelder-Mead 

The Nelder-Mead algorithm, also known as the simplex algorithm, is an iterative optimization 
method commonly used for nonlinear optimization problems, including curve fitting. It is 
particularly useful when the objective function (the function being minimized or maximized) is 
not differentiable or when gradients are hard to obtain. Nelder-Mead is best suited for fitting 
equivalent circuits with a few parameters, for equivalent circuits with more than five parameters 
we highly recommend the Levenberg-Marquardt algorithm. 

Note that the ‘Error%’ column in the ‘Results’ table will remain empty when using the Nelder-
Mead algorithm. 

7.11.3 Maximum Iterations 

Generally, it will not be necessary to increase the maximum number of iterations for fitting. As 
the Levenberg-Marquardt algorithm usually requires few iterations to achieve a fit. However, 
when the minimum step size parameters are lowered this could be necessary. When you do not 
achieve a good fit and see that the number of iterations was 500 in the table of the fit tab 
increasing the maximum number of iterations may help. Usually, it is better to carefully review 
the design of your circuit and enter more appropriate values for its components before fitting 
again. 

Typically, the Nelder-Mead algorithm requires more iterations to converge than the 
Levenberg-Marquardt. The number of steps also depends on the convergence tolerance, the 
lower this is set the more steps it will take to converge. 

7.11.4 Minimum Step Size 

The minimum delta sum of squares and minimum parameter step size are the desired stopping 
conditions for the fitting algorithm.  

The Levenberg-Marquardt algorithm attempts to reduce the sum of squares with each step, 
the minimum delta sum of squares specifies when further improvements become negligible. 
This can be lowered to achieve a more precise fit for the value of the components. For this to 
have an effect you will usually have to lower the minimum parameter step size as well. It is 
questionable whether lowering the minimum delta sum of squares will improve your fit as 
generally the accuracy of the fit is limited by the fact you are fitting a model which is a 
simplification of the actual ongoing processes in the cell and that will never fit the 
measurement perfectly. 

As the Levenberg-Marquardt algorithm approaches the global minimum (i.e. the desired fit) or 
a local minimum or saddle point (i.e. an undesired fit) the differences in the values of the 
components become smaller each step. Lowering this value is recommended if the expected 
component in the circuit has a value in the range of 1-10 pico Farad/Henri/Ohm etc. 

Minimum step size does not apply to the Nelder-Mead algorithm. 
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7.11.5 Lambda 

The Levenberg-Marquardt algorithm uses lambda as a damping/scaling parameter. The 
lambda factor increases/decreases the change in the values of the components for the next 
step. In the event of a successful step (i.e. the sum of squares decreases) the lambda factor 
decreases and becomes increasingly smaller as the algorithm approaches a minimum. In the 
event of an unsuccessful step, it becomes larger allowing the algorithm to approach a minimum 
with fewer steps. 

The starting lambda value can be lowered in case you want to further optimize a fit that was 
already good or increased to find a minimum in fewer steps. The same holds for the lambda 
scaling factor reducing it will increase the number of iterations required but may be useful if 
further optimization is required and increasing it could decrease the number of iterations 
required to find a minimum or it could make the algorithm unstable. 

7.11.6 Convergence Tolerance 

The Nelder-Mead will stop when the simplex shrinks as it approaches a global/local minimum 
or a saddle point. Lowering the convergence tolerance will let it shrink further and could help 
it move along a saddle point and converge to a local minimum. For equivalent circuits with 
many parameters, convergence is difficult to achieve. 
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8 Plot, curves and data 

In this section, all available functions related to measured curves are explained. Impedance data 
is presented differently from regular curves. For information about working with impedance 
data, see section:  

Electrochemical Impedance Spectroscopy on page 113. 

8.1 Handling curves 
There are two Plot tabs in PSTrace; impedance measurement curves (EIS curves) are shown in 
the ‘EIS Plot’ tab, all other curves are shown in the ‘Plot’ tab. 

 

 

Figure 194 PSTrace window showing the Plot tab. 

The legend next to the Plot tab shows all available measurements (session data) with 
corresponding curves.  

A ‘Session’ can contain multiple measurements with curves. 

See also section Files on page 235. 
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8.2 Session data 
When a measurement is started the resulting data is added in the Session data list or Legend 
next to the plot window and the default curve is added. 

 

 

Figure 195 The legend showing session data 

The curve selected in the curves list determines which curve is active. The active curve is used 
when saving a single curve, showing data in the Data tab, marking peaks or slopes, etc. 

The asterisk (*) next to the titles indicates the measurement or curve is not saved yet. They will 
disappear when the data is saved to a session file.  

When a measurement is selected in the legend, a window appears next to the legend showing 
all data that was recorded during the measurement together with some other information 
about the measurement: 

8.2.1 Automatic naming of curves 

In the case of a new measurement, the curve is named with the technique acronym followed 
by the respective plotted variables “y vs x”, i.e.: “LSV i vs E”. In the case of a Cyclic Voltammetry 
measurement, the curve receives an addition in the name ‘Scan n’, where n is a sequential 
number.  In the case of a multiplexer measurement or measurement using an auxiliary channel, 
it receives the name of the channel used.  

8.2.2 Measurement Tool window 

Selecting a Measurement item in the Legend opens the following tool window for this 
measurement.  

 

The measurement title. Clicking
this item in the legend shows the
Measurement tool window.

The title and color of the default
curve generated for this measure-
ment. Visibility of curves can be
toggled by clicking the colored
checkbox in front of the curve title.
Clicking this items shows the
Curve tool window.

‘Show all’ / ‘Hide all’ button
toggles the visibility of all curves

Deletes all the unchecked
(invisible) curves
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Figure 196 Window with measurement information shown next to the selected measurement 
in the legend. 

Add curves generated from the
data recorded during the
measurement.

The measurement title as
shown in the legend

Notes as specified in the method
editor before starting the
measurement. Can be in this
window as well.

View the method parameters used
for this measurement. Also useful for
changing automatic peaks detection
settings for the curves in this
measurement.

Preview plot of the new curve
generated from the selected data.

View the raw data recorded for this
measurement in the ‘Data’ tab.

Delete the recorded Measurement
including all related data and
information (notes, Method
parameters used).

Change appearance for all curves in
this Measurement.
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8.2.3 Curve Tool window 

Selecting a Curve item in the Legend opens the following Curve tool window. 

 

Figure 197 Windows with tools for the selected curve shown next to the legend after 
selecting a curve 

8.3 Switching between plots 
In case the legend contains curves with different units on the X and/or Y axis, a plot selection 
bar appears on top of the legend that allows for switching between different plots.  

 

Figure 198 The plot selection toolbar 

  

Buttons to change the Curve’s color and the
appearance of the curve (line visibility, thickness
and/or symbols)

The title of the curve

The name and location (path) of the file where
this curve is stored in. Hover the mouse cursor
over the path to see the full path in case it is
too long for the window.

Curve functions can be changed here. This can
be used in the Analytical Mode to assign Sample
and Standard Addition curves.

Assign secondary axis for the
curve to overlay with curves with
different units or magnitudes

Delete the curve.

Button to make all other curves invisible and the
selected curve visible. Making all curves visible
again is done using the ‘Show all’ button above
the legend.

View the curve data in the Data tab
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When starting a measurement, the appropriate plot will automatically be selected, or added if 
necessary. The automatic selection of the active plot can be disabled in the ‘Plot visual settings 
window’.  

See also section: Plot toolbar on page 179. 

8.4 Plot toolbar 
The plot toolbar at the left-hand side of the plot contains the following buttons. 

8.4.1 Scaling and selection 

 
Automatic scaling to show all data points. 

 
Use pointer to select a datapoint. 

 
Use the pointer to drag an area that defines the new scaling boundaries. 

 
Enter minimum and maximum values for both axes. 

8.4.2 Clear helplines 

 
Removes all existing helplines (for example LLS or integration lines). 

8.4.3 Plot options 

 
Toggle smart scaling to automatically round up / down minimum and maximum values 
for both axes. 

 
Toggle symbol visibility on each datapoint in the curve(s). 

 
Opens the ‘Plot visual settings’ window. 
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8.4.4 Plot visual settings window 

 

Figure 199 The ‘Plot visual settings’ window 

The ‘Plot visual settings’ window allows for changing the default appearance of the plot.  

The ‘Default Symbol for datapoint’ can be set here for all new measurements. This setting is 
saved upon closing PSTrace. The button ‘Apply to all existing curves’ makes sure that the new 
setting is also applied on any existing curves in the plot. 

The ‘Plot area’ appearance can be customized by toggling the checkboxes for 

▪ ‘Background gradient’: 
Default set to checked. When unchecked, the light blue gradient in the plot is replaced 
with a plain white background. 

▪ 'Grid’: 
Default set to checked. When unchecked, the grid lines in the plot are no longer 
showing. 

▪ ‘Show axes origin lines’: 
Default set to checked. When unchecked, the blue horizontal and vertical lines at the 
axis 0 point are no longer showing. 

▪ ‘Autoscale during measurement’: 
Default set to checked. When unchecked, the plot will no longer automatically rescale 
when new added datapoints during a measurement are out of the axis bounds. This 
can be helpful to reduce CPU usage when running (very) long duration measurements 
with many datapoints. 

▪ ‘Autoscale during measurement’: 
Default set to checked. In case curves with different units are present in the legend, a 
plot selection toolbar is shown above the legend. If the checkbox is set, the relevant 
plot will automatically be selected when a new measurement is started. 
See also section: Switching between plots on page 178. 
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▪ ‘Use polarographic conventions (default IUPAC)’: 
There are two common conventions for Voltammetric plots both of which are 
supported in PSTrace: 
o The IUPAC (International Union of Pure and Applied Chemistry) makes sure that 

anodic currents are plotted in a positive direction and cathod currents in a 
negative direction. 

o If the Polarographic convention (also known as the North American, 
Polarographic, or Classic convention) is used, anodic currents will be plotted in a 
negative direction and cathodic currents in a positive direction. 

▪ ‘Draw peak search windows (in Analytical mode)’: 
If enabled the potential windows that are assigned to an analyte are made visual in the 
plot. This helps the user to visually check the chosen potential windows. 

▪ ‘Convert area to charge’: 
By enabling this checkbox, the pop-up shown when clicking a peak label in the plot 
shows the charge for the peak next to the label for area: 
 

 

Figure 200 The peak label showing peak charge 

8.4.5 Axes options 

The data shown in the plot can be presented in different ways, depending on the data available. 
The table below shows which options for the axes are available. 

Table 13 Buttons for different plot options 

 
Plots the derivative of the curve using the centered three-point method. 

 
Plots the second derivative of the curve. 

 
Plots the integral of the curve. 

 
Plots the logarithm (Log10) of the Y values. 
 

 
Shows the Cottrell plot. 

 
Shows the Anson plot. 

8.4.6 Plot export options 

The data that is presented in the plot at any given time can be exported to third-party software. 
The table below describes the buttons found in the plot area for exporting the data. 
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Table 14 Options for exporting the data that is shown in the plot 

 
Takes a snapshot of the plot area and copies the result to the clipboard for pasting in 
other software. The snapshot settings can be changed in the ‘Plot visual settings’ 
window. 

 
This button is only visible when exporting to Excel is enabled. See also section 
Exporting curves on page 207. 

 
This button is only visible when exporting to Origin is enabled. See also section 
Exporting curves on page 207. 

The data in the plot can be presented with additional information using the buttons described 
in the table below. 

Table 15 Print buttons in the Plot toolbar 

 
Shows a print preview and printing options for the plot 
 

 

Opens the general printer settings window, allowing you to select the default printer 
for printing in PSTrace and changing the default printer settings. 

 

8.4.7 Cottrell plot 

The option for displaying the Cottrell plot is only visible for 
current measured versus time (multistep amperometry). 

The Cottrell Equation is well known in electrochemistry. It describes how the current I due to a 
reaction of a free diffusing species develops over time t: 

𝐼 = 𝑧𝐹𝐴𝑐∗√
𝐷

𝜋𝑡
 

Where D is the species’ diffusion coefficient, z the number of electrons transferred per 
molecule, A the active area of the electrode, c* the bulk concentration and F the Faraday 
constant. 

If a potential step is performed from a reaction free potential to a potential where a reaction is 
no longer potential controlled, but diffusion controlled, we expect the current to look like in 
the figure below. 
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Figure 201 a) current response to a potential step (Cottrell experiment) b) linear form of a) 

In the Cottrell plot the current I is plotted versus t½ and according to the Cottrell equation a 
linear plot is expected as shown in the figure above (b). The slope m of this plot is 

𝑚 = 𝑧𝐹𝐴𝑐∗√
𝐷

𝜋
 

Depending on which factors are known the Cottrell plot can be used to determine for example 
D, c* or A. The challenge is to choose the right part of the Cottrell plot to perform the linear fit. 

In the initial and final segments of the curve, non-linearity is observed. The non-linearity at the 
curve's end is attributed to the diffusion layer's inability to expand infinitely due to convection 
or other influencing factors. Two factors contribute to the non-linearity at the curve's 
beginning and end. Firstly, achieving an ideal potential step is unattainable as potentiostats 
have rise times in the order of nanoseconds or microseconds. Despite reaching the set 
potential swiftly, it remains slower than perfectly instantaneous. Secondly, the capacitive 
current or capacitive charging current arises from ions forming a capacitor at the 
electrochemical double layer. These combined factors introduce deviations from the ideal 
potential step, influencing the curve's shape at its initial and final points. 

8.4.8 Anson Plot 

The option for displaying the Anson plot is only visible for 
charge measured versus time (chronocoulometry). 

While measured current in the MultiStep Amperometry (MSA) shows a linear correlation with 
the reaction rate, the charge measured in Chronocoulometry (CC) shows a linear correlation 
with the amount of converted reactants. This is described in Faraday’s law. This characteristic 
renders Chronocoulometry (CC) a valuable tool for quantitative analysis, especially in 
applications such as electrodeposition or electrochemical synthesis. The linear relationship it 
exhibits enables precise measurement and analysis of the quantity of reactants transformed 
during the electrochemical process. Additionally, Chronocoulometry proves beneficial in the 
characterization of batteries, as it can be employed to accurately determine their capacity. 

In analytical chemistry CC is used to determine the adsorbed amount of active species in a 
solution of free diffusing active species. Multiplying the Cottrell equation with t delivers that 
the charge Qdiff of the free diffusing species’ reaction is proportional to t½.  
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𝑄𝑑𝑖𝑓𝑓 = 𝑧𝐹𝐴𝑐∗√
𝐷𝑡

𝜋
 

Where D is the species’ diffusion coefficient, z the number of electrons transferred per 
molecule, A the active are of the electrode, c* the bulk concentration and F the Faraday 
constant. 

The total charge Q during a potential step like the Cottrell experiment (see Cottrell plot) also 
includes the contribution of the charge stored in the electrochemical double layer Qdl and the 
charge due to reactions of adsorbed species. Qads  (see figure below) 

𝑄 = 𝑄𝑑𝑖𝑓𝑓 + 𝑄𝑎𝑑𝑠 + 𝑄𝑑𝑙  

The cause of Qads and Qdl are a lot faster than the reaction of free diffusing species. Plotting Q 
versus t½, known as Anson plot, delivers (ideally) a jump in charge followed by a linear increase 
(see figure below).  

 

 

Figure 202 a) current response to a potential step (Cottrell experiment) b) linear form of a) 

When the linear part is extrapolated the intersection with the charge axis delivers Qads+Qdl. A 
previous blank measurement allows the determination of Qdl and thus the calculation Qads 

Analog to the Cottrell plot the Anson plot won’t show linear behavior at the beginning and the 
end for real experiments for the same reasons. 

To make sure that the charge step, in the beginning, is recorded CC is performed in 2 steps. 
The first step at a reaction-free potential is followed by the step where the reaction is initiated, 
just like the classic Cottrell experiment. 

8.5 Curve toolbar 
This section describes the tools found in the curve toolbar. 

 

Figure 203 The Curve toolbar 

8.5.1 Marking peaks manually 

The buttons to manually mark peaks in the plot can be found in the curve toolbar under the 
button ‘Manual peak’. 
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8.5.1.1 Fixed baseline 

  
Draw a baseline fixed on the curve for peak detection. 

 

 

Figure 204 Baseline on curve 

8.5.1.2 Free baseline 

 
Draw a baseline that is not attached to the curve. 

 

 

Figure 205 Free baseline 

8.5.1.3 Three points 

 
Mark three points on the curve to determine the left and right sides of the baseline and 
the top of the peak. 
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Figure 206 Three points determine baseline and corresponding peak 

8.5.1.4 Extrapolate baseline  

 
A linear slope (using linear regression) is marked on the curve from which the baseline 
is extrapolated. 

 

 

Figure 207 Extrapolate from slope 

As soon as the slope for the baseline line has been drawn, the Curve calculations window is 
shown: 
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Figure 208 Calculations window showing the properties of the slope 

The values shown in the window can be changed manually and applied again on the curve.  

8.5.1.5 Non-linear baseline  

 
A polynomial with a specified order is fitted through the selected points on the curve. 

 

The following buttons are shown during selection: 

 

Figure 209 Buttons to set the degree for the polynomial baseline  

The selected ‘Max. order’ defines the maximum (n) order, or degree, applied for the 
polynomial: 

𝑎0 + 𝑎1𝑥 + 𝑎2𝑥2 + 𝑎3𝑥3 … +  𝑎𝑛𝑥𝑛 

 

The number in red represents the current order ‘n’ applied. When a polynomial is set, the 
button ‘Apply’ shows a preview of the peak using the polynomial as the baseline. Each time 
the polynomial is changed; the ‘Apply’ button should be clicked to mark a new peak using the 
changed polynomial as the baseline. The ‘Close’ button should be clicked when a satisfactory 
peak is found. 
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Figure 210 Marking a peak in a CV curve 

The baselines can also be used for subtraction. This can be done in the Curve Operations 
Window. See section Curve operations on page 197. 

 

 

Figure 211 Curve operations window 
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8.5.1.6 Add notes 

 
Annotate a feature of a curve by marking a point and adding a note 
 

 

The following buttons are shown during selection: 

 

Figure 212 Input field and buttons to enter and set a note to mark feature on a curve 

Mark a point to annotate by clicking in the plot with the left mouse button and enter the note 
you want to add in the input field. 

 

 

Figure 213 Marking a point on a curve to annotate 

Press the ‘Add Note’ button to add the note to the curve. Labels in the plot marked with ‘i’ 
symbol contain notes. 

 

Figure 214 A plot label containing a note 

8.5.1.7 Manual level 

 
Add a level to an amperometric or potentiometric curve with an optional note and/or 
concentration 
 

 

The following buttons are shown during selection: 

 

Figure 215 Input fields and buttons to add a manual level 
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Mark a level by clicking in the plot with the left mouse button and enter the note and/or 
concentration you want to add in the input fields. 

 

Figure 216 Marking a level manually 

8.5.2 Peaks toolbar buttons 

Detect peaks 

 
Automatically detect peaks in all curves or a selected curve. A single curve can be 
selected using the small drop-down arrow next to the button. 
The settings in the Peaks tab on page 39 are used for peak finding.  
Results are shown in the Peaks Data window.  
Note: This button is replaced by the ‘Find levels’ button if the last measurement was 
versus time. This can be reversed in the Peaks tab. 

8.5.2.1 Remove peaks 

 
Remove all peaks or remove the peaks of a specific curve. Peaks in a single curve can be 
removed using the small drop-down arrow next to the button. 

8.5.2.2 Find levels  

 
Available if measured as a function of time and Current Level is checked in the Peaks 
tab. The settings in the Peaks tab are used for the level finding. 
Results are shown in the Peaks Data window. 

8.5.2.3 Remove levels 

 Remove all levels or remove the levels of a specific curve. Peaks in a single curve can be 
removed using the small drop-down arrow next to the button. 

8.5.2.4 Windows 

 
Overlapping peaks separation window. 
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Figure 217 Window showing separation of overlapping peaks in a CV measurement. 

The overlapping peaks separation window on page 192 allows for the separation of two or more 
overlapping peaks. This tool window is only accessible for LSV and CV measurements. 

  

 
Toggle peaks or levels data window. 
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Figure 218 Windows showing peak (left) or level (right) data 

The table shows the values for the peak potential, peak height, peak area, peak width at half-
height, the value at the baseline as well as the maximum values for the ascending and 
descending slopes, and the sum of both values for each curve in a measurement. These results 
can be copied to excel or the clipboard for the selected or all measurements. The 
measurement’s automatic peak detection parameters can be adjusted, and the automatic peak 
detection can be performed again. In the case of a curve plotted versus the time it is possible 
to switch between peak and level detection. 

8.6 Separating overlapping peaks 
Overlapping peaks in a cyclic or linear sweep voltammetry measurement can be separated 
using the peak separation window. The peak separation window can be opened from the 

toolstrip above the plot . Peak separation works best for reversible peaks, the amount of 
overlap and number of overlapping peaks determine how well the peaks can be separated from 
each other (separating peaks is not guaranteed to work properly in all cases). 
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Figure 219 Overview of the peak separation window 

First, select the measurement that contains the curve that you would like to separate in the 

legend of the Plot tab in the main window. Then the peaks or levels data window  should 

be opened and the  separate overlapping peaks button clicked. Select the anodic or 
cathodic curve that you would like to separate peaks in from the dropdown menu in the top 
left corner of the peak separation window. 

 

 

Figure 220 The dropdown menu for selecting the curve 

Before you can separate the overlapping peaks, they should be marked in the plot to the right. 
Click on mark peaks, this will change the view in the plot to the differintegral view. The peaks 
are still at approximately the same potential, however, in this view, they are more distinct.  

 

 

Figure 221 Button for the first step; marking the peaks to separate 

 

Dropdown list from which
you can select the anodic or
cathodic parts of the curves
in the measurement.

Table and plot containing the
results of the peak
separation.
The blue curve is the original
curve (highlighted in the top
left).
The red, green and yellow
curves are the separated
peaks.
The purple curve is the
baseline and the dark blue
curve is a reconstruction of
the original curve using the
three separated curves.

Adds the resulting curves to
the main window.
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Figure 222 Left: Anodic curve with several overlapping peaks. Right: Differintegral view of the 
same curve. 

Once you selected the peaks you want to separate, click on ‘Apply’ Tip: you can zoom in by 
scrolling the mouse and pan using the right mouse button. Selecting peaks that do not overlap 
will not work and selecting more than three peaks takes much longer to compute. 

 

 

Figure 223 Marking the peaks in a curve 

Once the peaks have been marked, they can be separated by clicking on the respective button. 
This will change the plot back to the regular view and display the results.  
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Figure 224 Results of the peak separation. Blue curve: original curve. Red and green curves: 
curves of the peaks that were separated. Yellow curve: baseline curve (both peaks removed). 
Purple curve: sum of the separated curves. 

The results are also shown in the table on the left. This table can be used to hide/show and show 
the peaks corresponding curves, select curves to add to your measurement and to delete 
curves (by clicking on the red cross). 

 

 

Figure 225 The list with the curves as a result of peak separation 

The results can be added to your measurement in the main Session manager (the legend in the 
main window showing all available session data) using the add button below the table. The clear 
button removes all the results from the table and the plot. It is also possible to export the curves 
to excel, this can be useful when you need to export the fractional differintegral (the checkbox 
below the plot). 

8.6.1 Advanced peak separating settings 

In some cases, the separation of the peaks can be improved by adjusting the default settings in 
the advanced settings. 
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Figure 226 Advanced settings for peak separation 

The order of the differintegral is specified in the fractional derivative order text box. By default, 
the 0.5 semi-derivative is used to separate the peaks from each other. The peaks are best 
separated when they do not or barely overlap in the differintegral view and when the beginning 
and end of the peaks are on the same level / the baseline is not slanted. 

 

Figure 227 Results of the peak separation with the default settings. Notice that the baseline 
(purple curve) is slanted in the differintegral view (right), this often leads to sub optimal 
results (the purple curve deviates from the original blue curve). 

 

Figure 228 Increasing the order of the fractional derivative to 0.61 improves the separation of 
the peaks significantly. 

The show as differintegral check box toggles between the regular and differintegral view. 
Toggling back to the differintegral view is useful when optimizing the separation of the peaks. 

The window size of the moving average filter is used to prevent noise from interfering with the 
peak separation. The separation works best with smooth curves, however, there is a trade-off 
between large and small window sizes. Large window sizes can result in an underestimation of 
the peak height and small window sizes can result in errors when separating the peaks. 
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Finally, depending on the type of reaction switching between the reversible and irreversible 
peak model can improve the peak separation. The reversible peak model works best with peaks 
that are symmetrical in the differintegral view and the irreversible peak model works best with 
asymmetrical peaks (peaks where the second half is steeper). 

8.7 Curve operations 
The curve operations window is available in the Curve toolbar and can be opened with the 

button  

 

 

Figure 229 Curve operations window 

1. Select one or multiple curves to apply operations on. 
2. Choose the mode of operation.  

New curves will be generated and added to the corresponding measurement, based on the 
selected operation.  

For more information about the Baseline buttons, see the following sections: 

▪ Linear baseline subtraction on page 197 
▪ Non-linear baseline subtraction on page 198 
▪ Moving average baseline on page 200 

8.7.1 Linear baseline subtraction 

To do a linear baseline subtraction, click on the 'Subtract linear baseline' button in the Curve 

Operations window. This is opened using the  in the plot toolbar. Or in the menu ‘Peaks’ 
→ ‘Curve operations’. 
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Figure 230 The button for starting linear baseline subtraction in the “Perform curve 
operations” window. 

Clicking on this button will open a new window with a plot of the selected curve. Set two 
markers on the curve. As soon as the second marker is set, a preview is shown. A third click on 
the plot will remove the preview, reset the markers and place the first one again. If the preview 
seems satisfactory, click ‘Accept’. 

 

 

Figure 231 Plot showing a preview of a linear baseline subtraction. 

8.7.2 Non-linear baseline subtraction 

To do a non-linear baseline subtraction, click on the 'Subtract non-linear baseline' button in 

the Curve Operations window. This is opened using the  button in the plot toolbar. 
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Figure 232 The button for starting non-linear baseline subtraction in the “Perform curve 
operations” window. 

The following buttons are shown during selection: 

 

Figure 233 Buttons to set the degree for the polynomial baseline  

The selected ‘Max. order’ defines the maximum (n) order, or degree, applied for the 
polynomial: 

𝑎0 + 𝑎1𝑥 + 𝑎2𝑥2 + 𝑎3𝑥3 … +  𝑎𝑛𝑥𝑛 

 

A polynomial with a specified order is fitted through the selected points on the curve. A 
polynomial requires a minimum of n+1 markers. So, a 3rd order polynomial requires three 
markers. 

The number in red represents the current order n applied. When a polynomial is set, the button 
‘Apply’ shows a preview of the subtracted curve using the polynomial as the baseline. Each time 
the polynomial is changed; the ‘Apply’ button should be clicked to update the preview. The 
‘Accept' button should be clicked when the preview is satisfactory. 
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Figure 234 Setting markers on a DPV curve. 

8.7.3 Moving average baseline subtraction 

To do a moving average baseline subtraction, click on the ‘Moving average baseline' button in 

the Curve Operations window. This is opened using the  in the plot toolbar. 

Moving average baseline subtraction is not applicable for Cyclic 
Voltammograms. 

 

Figure 235 The ‘Moving average baseline’ button in the Curve Operations window 
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By clicking on the ‘Moving average baseline’ button, a preview window opens. In this window, 
the window size and the maximum number of sweeps can be adjusted to obtain the desired 
result. The grey line represents a preview of the baseline correction, it is updated instantly after 
changing the window size and the maximum number of sweeps. 

 

 

Figure 236 Moving average baseline settings 

When performing a moving average baseline correction, it is recommended to change the 
window size first. 

Increasing the window size will increase the number of data points that are used to determine 
the new value of the data points with the moving average correction. The ideal window size 
depends on the number of data points in your measurement and the width of the peaks. A 
window size that is too large will result in unwanted rounding errors. 

When the desired result cannot be obtained by increasing the window size the maximum 
number of sweeps (i.e., the iterations of the moving average correction applied to the curve) 
can be increased to achieve the desired effect. 

To see a preview of the moving average baseline correction, click on ‘Apply’. Clicking on 
‘Accept’ will add the curve to the session manager. 

 

 

Figure 237 Plot with result preview of the baseline correction 

8.7.4 Discarding data points 

Using this option, it is possible to create a new curve from a specific selection of a curve. 
Specifying the selection of the curve to keep with the mouse by moving your mouse over the 
sample from where you would like to start or end your selection, then clicking on that sample 
(blue dot) twice. Then move your mouse to the data point where you would like to respectively 
end/start your selection and click on it once. The selected range for the new curve is indicated 
by the solid markers. 
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Figure 238 Discarding datapoints in a curve. 

Alternatively, one or more curve points can be deselected by holding down both the Ctrl-
button and the left mouse button and dragging an area around the outlier(s) with your mouse. 
Repeating this step on the points again will reselect them.  

 

 

Figure 239 Selecting a series of data points in a curve for discarding. 

Click ‘Accept’ to add the new curve based on the selection to the current session. 
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8.8 Curve calculations 

Use the button  top open the Curve calculations window. 

 

 

Figure 240 Curve calculations window 

The values obtained by using the pointer are shown in the ‘Use manual values:’ window so they 
can be fine-tuned and re-applied. These values are saved when PSTrace is closed.  

Using the button ‘Copy to clipboard’ the results can be pasted (usually using Ctrl+V) as plain 
text into any other program. 

The ‘Match X range with selected curve’ button selects the entire range of the curve. 

8.8.1 Cyclic Voltammograms 

In case the targeted curve is a Cyclic Voltammogram, a selection tool appears below the plot 
toolbar, allowing the use to select the Anodic or Cathodic part of the curve for doing the 
calculations on. Use the ‘Finish’ button in the toolbar when done setting the markers. 

 

 

Figure 241 Toolbar for selecting the Anodic or Cathodic part of a CV curve for calculations. 

8.8.2 Extrapolate 

 
See for more information regarding Extrapolate baseline button section: Marking 
peaks manually on page 184. 

The buttons for integration and marking a linear regression line can be found under the Curve 
operations button. 
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Figure 242 Calculations on the curve 

8.8.3 Linear regression 

 
Mark begin and end on the curve for linear regression using linear least squares 
(LLS). 

 

Figure 243 Calculation of a slope using LLS. 

As soon as the line has been drawn, the Curve calculations window with the results is shown: 

 

Figure 244 Calculations window showing the properties of the slope. 

The values shown in the window can be changed manually and applied again on the curve. 

8.8.4 Integration   

 
Draw a baseline for integration on a curve. 
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Figure 245 Result of drawing a baseline for integration. 

The integration result is shown in the Curve calculations window: 

 

 

Figure 246 Calculations window showing the integration results in two different units. 

The values shown in the window can be changed manually and applied again for integration of 
part of the curve. 

The “Match X range with selected curve” button selects the entire range of the curve. This can 
be useful when determining the total charge of a curve for example. 

8.9 Saving data 
All measurements and curves that are present in the Plot and EIS Plot tabs and the method 
present in the Method Editor can be saved to a single ‘.pssession’ file.  
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Figure 247 A PSSession (.pssession) file contains basically all the data available at a given 
moment. 

Data is saved via the menu: ‘Data’ → ‘Save data…’ 

 

 

Figure 248 Data menu 

 

 

Figure 249 Save Data dialog for saving to a PSSession file. 
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In the tree at the right side of the Save Data dialog window data can be selected that will be 
included in the PSSession file. 

8.9.1 CSV 

Files can also be exported to a CSV (Comma Separated Values) format. This is a common file 
format supported by many applications like Excel, OpenOffice Calc and Origin. 

8.9.2 OriginLab 

Files can be exported to a native .OPJ file for use in Origin, from OriginLab Corporation. 

See also section: Files on page 235. 

8.9.3 Legacy curve files 

Since the release of PSTrace v5 and MultiTrace v4, the following file formats can no longer be 
used for saving data: 

.pss, .pst, .mux, .psd and .pseisdata. 

The new “.pssession” file format has been introduced to consolidate and replace the need for 
these various formats. It's important to note that although the old file formats cannot be used 
for saving, they can still be loaded in PSTrace v5 and MultiTrace v4. 

See also section Files on page 235. 

8.10 Exporting curves 
PSTrace allows curves to be exported to third-party software with a single click. 

 

 

Figure 250 Export options shown in the Plot menu. 

8.10.1 Excel 

If Excel version 2007 or newer is installed an ‘Open in Excel’ menu item is added to the Plot 
menu and an extra button is added at the left-hand side of the Plot. Clicking the menu item or 
the button will open an Excel window and automatically export the data of all visible curves to 
the spreadsheet. A graph will be generated for all exported data. The template for the graph 
can be found in the installation folder of PSTrace.  

8.10.2 Origin 

If Origin (from OriginLab Corporation) is installed an ‘Open in Origin’ menu item is added to 
the Plot menu and an extra button is added at the left-hand side of the Plot. Clicking the menu 
item or the button will open an Origin window and automatically export the data of all visible 
curves to a separate book and graphs will be generated for each exported curve.  
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If the button is not showing and Origin is installed, open the General settings window in the 
menu (‘Tools’ → ‘General settings…’) and check in the ‘Plot and data’ tab if the location for 
Origin is properly set. 

 

 

Figure 251 Location for Origin specified in the Settings window. 



PSTrace Manual » Manual Control 

PSTrace Manual 209 

9 Manual Control 

The Manual Control tab enables direct control of the instrument, allowing users to set 
conditions in real time without the necessity of configuring a method.   

9.1 Manual Control tab 
The ‘Manual Control’ tab shows the following options to control the connected potentiostat 
directly.  

 

Figure 252 ‘Manual Control’ tab 

▪ Cell On is used to establish a connection for polarizing the Working Electrode (WE) to 
a specific potential or current. By default, the cell is in the "Off" state, signifying that 
the Counter Electrode (CE) lead is unplugged, and thus there is only a potential 
reading. If the BiPot module is present, WE2 can also be switched on or off. 

▪ Control E or i is used to set the mode of PalmSens. Selecting E is to set the potential 
and to read the current response, i.e. the instrument is used as a potentiostat. 
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Selecting i will allow to control the current and to read the potential, i.e. the instrument 
is set as galvanostat. In short: Potentiostat (E) or Galvanostat (i). 

▪ Potential or Current allows to set either one of these values, depending on the set 
mode with ‘Control E or i’. The scrollbar and textbox are used to specify the potential 
or the current. 

▪ Current Range or Potential Range specifies the sensitivity of the measurement. 

Table 16 The maximum measured currents for each instrument. 

Instrument Max. measured current 

EmStat1, 2 and 3(+) ±2 * selected range 

PalmSens1 and 2 ±2 * selected range 

PalmSens3 ±3 * selected range 

PalmSens4 ±6 * selected range 

EmStat4 LR and HR ±3 * selected range 

EmStat Pico ±0.6 * selected range 

 
An overload warning is given for measured values ≥ 80% of the selected range. 

For all instruments except for the EmStat Pico an underload warning is given for measured 
values ≤ 4% of the selected range. For the EmStat Pico the underload warning is given for 
measured values ≤ 2% of the selected range. 

For instruments that support multiple potential ranges, the table below shows the available 
range for each instrument. 

Table 17 The maximum measured potentials for each instrument. 

Instrument Max. measured potential 

PalmSens4 ±10 * selected range 

EmStat4 LR  ±3 * selected range 

EmStat4 HR ±6 * selected range 

 

▪ Multiplexer Channel is enabled if the use of a multiplexer is enabled in the Settings 
window (Tools → General settings…). In this box the channel which is used for control 
and measurement can be selected. 

▪ The WE2 Potential and WE2 Current Range frames are visible if BiPot is enabled in the 
Configuration window. 

▪ Checking Stirrer On sets the digital ports d0 to high and d1 to low (and vice versa) of 
the auxiliary port of the instrument. See the instrument-specific sections in this manual 
for the auxiliary port pin-out. 

▪ Analog In reads the voltage applied on the auxiliary analog input port of the connected 
instrument.  
See the instrument-specific sections in this manual for the auxiliary port pin-out. The 
function of the Analog In is determined by the Auxiliary input settings found under the 
menu: ‘Tools’ → ‘General settings…’ → ‘Auxiliary input’ 

▪ Analog Out set a specific potential between on the auxiliary analog output port of the 
connected instrument.  
See the instrument-specific sections in this manual for the auxiliary port pin-out. 

▪ In case the ‘Speed control’ for the stirrer is enabled, Analog Out controls the stirrer 
speed. 

▪ Digital Output allows for setting the digital output lines on the auxiliary port manually. 
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See the instrument-specific sections in this manual for the auxiliary port pin-out. 
▪ Digital Input allows for reading the digital output lines on the auxiliary port manually. 

See the instrument-specific sections in this manual for the auxiliary port pin-out. 
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10 Analytical mode 

 

 

The analytical extension of program PSTrace for Voltammetric Analysis provides the possibility 
to do quantitative analysis by means of Standard addition or using a Calibration curve. 

 

10.1 Supported techniques 
The supported electrochemical techniques for voltammetric analysis are shown in the 
Technique list: 

▪ Linear Sweep voltammetry 
▪ Differential Pulse voltammetry 
▪ Square Wave voltammetry 
▪ Chronopotentiometric Stripping 

 

Figure 253 List showing available techniques for the Analytical mode 

The other available techniques for PalmSens or EmStat are not listed when PSTrace is set in 
Analytical mode. These techniques are identical to those found in the Scientific Mode, 
employing the same signal and adhering to the same specifications. The only distinction lies in 
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the outcome, as the data results are directed to calculation tools for concentration 
determination in the Analytical Mode. 

10.2 Setting up parameters 
When the program is set to ‘Analytical mode’ in the Settings window or the top left of the main 
window, new tabs called ‘Analysis’ and ‘Analytical result’ are shown. The ‘Analysis’ tab in the 
Method Editor is used to enter analysis parameters beforehand for a series of measurements. 
The ‘Analytical result’ tab is used to show the standard addition or calibration curve(s) and the 
calculated peak heights as well as the obtained concentration. In this tab, it is also possible to 
edit the analysis parameters of existing measurements. The parameters of the standard 
solution as well as the analyte(s) or component(s) to be determined can be defined in the 
‘Analysis settings’ group in the top left of the tab. The program allows measurement of up to 
four analytes using up to four standard solutions.  

PSTrace allows subtraction of a separately measured blank voltammogram. This blank 
voltammogram can be measured before the other curves or can be loaded as data file. 

See for more information about using blank curves, section: Blank subtraction on page 45. 

Analysis parameters can be entered before a measurement in the ‘Analysis’ tab of the Method 
Editor or edited for existing measurements in the ‘Analysis settings’ group of the ‘Analytical 
result’ tab.  

There is no use in changing the parameters in the ‘Analysis’ tab 
of the Method Editor after the measurement have been carried 
out. 

 

    

Figure 254  ‘Analysis’ tab in Method Editor (left) and the ‘Analysis settings’ group in the 
‘Analytical result’ tab (right). 
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The mode of the determination is either Standard addition or Calibration. The content of the 
table is either Added volumes or Concentration in the cell. 

   

Figure 255 Volumes added for each analyte 

To specify the concentration unit, choose from the provided list. It's important to clarify that 
the selection of the concentration unit does not impact the calculations derived from the 
curves. The software does not execute a unit conversion between the calibration and the result. 
Therefore, the chosen unit primarily serves as a format for display purposes and does not alter 
the numerical outcomes. 

The column Id is used to specify which analyte(s) or component(s) has to be determined, e.g. 
Cd, Pb, Cu, antibiotics, pesticides. If an Id field is empty, the column is marked in grey and the 
specified values are not used. 

The Id’s of the peaks are also given in the voltammetric plots in the peak values, after the 
‘Recalculate’ button was used.  

 
Figure 256 Peaks found for each Id showing in the Plot tab 
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10.2.1 Specifying added volumes 

If the Table content is Added volume in µl then the fields St. n of the table contains the added 
volumes of standard solutions in µl for up to 4 additions. In the conc line the concentration 
given in the specified concentration unit of each analyte in the standard solution must be set. 
In case more than 1 analyte is measured, a standard solution may contain 1 or more analytes if 
they have the same concentration. If an analyte is added from another solution or has another 
concentration than the previous, a new Solution number (Sol nr.) has to be specified.  

So if for example only 1 analyte is determined, the Sol nr. can be 1. In case 4 analytes are 
determined and four different standard solutions are used, the Sol. nr values can be different 
so for instance 1, 2, 3 and 4. If a standard solution contains more than 1 analyte, the next row is 
automatically set to the first value. 

10.2.2 Specifying concentrations in cell 

If concentration in cell was chosen in the Analytes section, the absolute concentration of 
analyte in the cell according to the specified unit needs to be put into the table assuming that 
the original sample contained no analyte. 

The cell volume is used to correct peak heights or peak areas for dilution effects due to addition 
of standard solutions. So the cell volume is the total volume in which the measurement is 
performed, which can for instance be the sample + separate base electrolyte. If the cell is filled 
with sample solution only, then the cell volume and sample volume are equal. This dilution 
factor due to the standard additions is shown in the ‘Analytical result’ window. 

10.2.3 Peak settings 

Three different peak features can be used for determination: 

▪ Peak height 
▪ Peak area 
▪ And the sum of the peak’s slopes 

 

Figure 257 Peak locations for each analyte with options for manual baselines 

The column ‘E peak’ gives the expected peak potential. If a peak is found in the peak window E 
peak +/- Peak window, it will be assigned to the given Id.  

If a manual baseline should be used for the specific analyte, E left and E right can be specified 
by entering values in the corresponding cells. As soon as the values are entered the peaks will 
be updated in the plot window. It is also possible to draw a baseline manually using the manual 
peak options in the Plot toolbar. 
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See also section: Marking peaks manually on page 184. 

The ‘Auto peak search window’ determines the maximum width of the peak. The peak for each 
analyte will be searched in E peak +/- Peak window. 

If a peak is not assigned, the peak potential is wrong, or the peak window is too narrow; change 
the peak parameters in the Peaks tab on the left and click the Mark peaks button to apply the 
new peak parameters.  

 
Figure 258 Mark peaks button 

The sample volume is needed in order to calculate the concentration of the analyte(s) in the 
sample. The program first calculates the concentration of the analyte(s) in the cell. These values 
are shown in the tables of Analytical result under cCell. The value of the concentration in the 
sample is simply found by multiplying cCell by the factor ‘Cell volume / Sample volume’. Thus, 
the sample volume cannot exceed the cell volume. 

Please note that in case the addition of the standard solutions have a negligible effect on the 
cell volume, the final cell volume is not relevant.  

 

Figure 259 Table showing results of each analyte 

10.3 Running a measurement 

Before starting a new determination, click the New button  in the toolbar, or select ‘New 
analysis’ in the Analysis menu. 

 

 

Figure 260 Analysis measurement toolbar 

For a determination, a ‘Sample’ and at least one ‘Standard’ curve is required. The type of curve 
measured after pressing the green ‘Start’ button is shown as selected item in the list next to this 
button. If blank correction is required, the ‘Blank’ solution also has to be measured or the blank 
curve has to be loaded from file. After a blank curve has been measured, it can be saved as blank 
file by using ‘Save blank’ in the Analysis menu.  

The ‘Plot’ tab shows the voltammograms and the ‘Analytical results’ tab gives the calibration or 
standard additions plots. Please note that the correlation coefficient for linear least squares 
lines is given. Also, the slope of the calibration or standard addition curves are shown. This value 
of the slope is an important value for the sensitivity of the electrode or sensor.  
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Figure 261 Analytical Result tab 

10.3.1 Standard addition measurement 

A determination by means of standard addition requires at least two curves: sample and one 
standard addition. As soon as both curves are available, the analytical results can be obtained 
in the window ‘Analytical result’. It is advised to use at least two additions in order to check the 
linearity of the curve. The standard additions have to be done before a standard curve is 
measured. 

10.3.2 Measurement by using a calibration curve 

The calibration curve is measured or loaded before a sample is measured. If only one standard 
is measured, the calibration curve is calculated with c=0 and Ipeak=0 as second point. 

After the sample has been measured, the calibration plot will show lines from which the 
concentration is obtained. 

10.3.3 Using Blank subtraction 

See section Blank subtraction on page 45. 

10.4 Result analysis 
After measurements of the curves, parameters in the Analysis window can be changed if 
required. New calculations of the analytical results are shown after pressing the button 
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‘Recalculate’. Secondly the peak labels are updated with their corresponding analyte after 
pressing the ‘Recalculate’ button. 

 

Figure 262 The ‘Recalculate’ button 

It is possible correct for a blank curve and also to undo blank correction afterwards by using 
the ‘Use blank’ box. 

Results of measurements can be stored by using the ‘Analysis’ menu. Results can be printed 
with the ‘Print’ button in the ‘Analysis Result’ window or copied to another program (e.g. Excel) 
by using the button ‘All to clipboard’. 

If a point in the calibration or standard addition curve has to be neglected, the corresponding 
checkbox in the ‘Results for each analyte’ window can be used. 

 

Figure 263 Uncheck to remove this value from the linear plot 

10.4.1 Standard Addition 

The Standard Addition Method is performed in the sample’s matrix, thus the influences of other 
species on the sensitivity are already taken into account. A known volume of the sample and a 
known volume of the supporting electrolyte are added to the cell. The measurement is 
performed. A fixed volume of standard solution with a known concentration is added. The 
measurement is repeated. These two steps are repeated until a sufficient amount of standard 
additions have been measured. From these values a linear regression is calculated. The zero 
point of this function is the analyte’s concentration in the cell. 

To create the points for the linear regression, the concentration of the artificially added analyte 
in the cell cCell must be known after each addition of standard. For the measurement of the 
sample no standard was added, so the value is 0. For the other measurements cCell is calculated 
as follows: 

 

𝑐𝐶𝑒𝑙𝑙 =  
Total Added Volume in µL ∗ Conc 

Cell Volume +  Total Added Volume in µL
 

 

Conc is the concentration of the standard solution. 

After the IPeak is plotted versus cCell the slope of the linear regression is calculated with the 
general equation: 
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𝑆𝑙𝑜𝑝𝑒 =  
∑(𝑥 − 𝑥̅)(𝑦 − 𝑦̅)

∑(𝑥 − 𝑥)̅̅ ̅2
 

 

The IPeak values are y and ȳ is the average of all known y values. The cCell values are x and x̄ is 
the average of all known x. The intersection of the linear regression is:  

 

𝐼𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛 =  𝑦̅ − 𝑆𝑙𝑜𝑝𝑒 ∗ 𝑥̅ 

 

With these two parameters you can calculate the null of the curve. The concentration of 
cCellSample  is the null * (-1). This means: 

 

𝑐𝐶𝑒𝑙𝑙𝑆𝑎𝑚𝑝𝑙𝑒 =  
𝐼𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛

𝑆𝑙𝑜𝑝𝑒
 

 

For the concentration of the Analyte in the Sample cSample, the dilution by the supporting 
electrolyte needs to be considered: 

 

𝑐𝑆𝑎𝑚𝑝𝑙𝑒 =  
𝑐𝐶𝑒𝑙𝑙𝑆𝑎𝑚𝑝𝑙𝑒 ∗ 𝐶𝑒𝑙𝑙 𝑣𝑜𝑙𝑢𝑚𝑒

𝑆𝑎𝑚𝑝𝑙𝑒 𝑣𝑜𝑙𝑢𝑚𝑒
 

10.5 Example data files 
The program comes with two example files. These files are stored in the default PS Data folder, 
which is typically: 

“My Documents\PSData\Analytical mode examples”.  

You can load these in PSTrace using the menu: ‘Data → ‘Load data file…’  

The file “Standard Addition Example.pssession” shows a determination of some heavy metal 
ions in a nickel galvanic bath. This determination is based on standard. The measurement was 
done by adding 1 ml sample to a base electrolyte with a final cell volume of 10 ml and using 3 
different standard solutions. 

The file “Calibration Example.pssession” shows a determination by using a calibration curve. In 
this file the table ‘Analysis’ contains the concentration values of the analytes in the cell.  
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11 Corrosion mode 

 

The Corrosion mode in PSTrace allows the user to run specific corrosion measurement 
techniques and use analytical tools for corrosion research on the measurement data. 

11.1 Supported techniques 
The available electrochemical measurement techniques in the Corrosion mode are: 

▪ Potentiostatic (apply constant potential, equivalent to Chronoamperometry) 
▪ Galvanostatic (apply constant current, equivalent to Chronopotentiometry) 
▪ Linear Polarization (potential sweep, equivalent to Linear Sweep Voltammetry) 
▪ Cyclic Polarization (bi-directional potential sweep, equivalent to Cyclic Voltammetry) 
▪ Corrosion Potential (open circuit potential, equivalent to Open Circuit 

Potentiometry) 
▪ Impedance Spectroscopy 

These techniques are identical to those found in the Scientific Mode, employing the same 
signal and adhering to the same specifications. The only distinction lies in the display and 
outcome, as the data results are directed to calculation tools for corrosion determination. 

 

Figure 264 List showing available techniques 
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The other standard available electrochemical techniques that do 
not apply to corrosion research are not listed when PSTrace is set 
in the Corrosion mode. 

11.2 Running a corrosion measurement 
The sequence of a corrosion measurement is: 

1. f tCond1 > 0 s then Econd1 is applied for tCond1 s. 
2. If tCond2 > 0 s then Econd2 is applied for t Cond2 s. 
3. The cell is switched off if the measurement of Eoc or OCP is required. 
4. Now the value of Eoc is continuously measured until either ‘Max. OCP time’ is reached 

OR until the stability criterion is met OR the button ‘Force continue’ is pressed. 
5. Now the cell is switched on at the value of E or E begin for ‘t eq’ s, after which the actual 

measurement starts. 

 

 

Figure 265 Waiting for the OCP to meet the stability criterion. 

11.2.1 Measure versus OCP 

Corrosion measurements can be done by specifying the potential scan with respect to the 
Open Circuit Potential OCP or with absolute values versus the reference electrode. 

In case one or more potentials are specified with respect to the OCP, the open circuit potential 
must be determined before the actual measurement is done. This OCP measurement requires 
a variable time, which is determined by the drift of the open circuit potential and the maximum 
time to measure the OCP value. The OCP value is set as soon as the drift is lower than the 
specified value for the ‘Stability criterion’ or when the ‘t Max. OCP’ has elapsed. 
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Figure 266 OCP parameters 

It is possible to condition the electrode or the corrosion sample before this OCP is obtained. 
For this purpose two potentials can be applied: ‘E cond1’, during a period of ‘t cond1’ and ‘E 
cond2’ during a period of ‘t cond2’. In case the value of ‘t cond’ is set to 0 s, the corresponding 
conditioning potential is not applied. So, if both values for ‘t cond’ are 0, the electrode is not 
conditioned at all. 

11.3 Result analysis 
The ‘Corrosion’ tab in the plot window is used for analysis of linear polarization and 
electrochemical impedance spectroscopy measurements. The supported measurements are 
shown in the legend on the right and the material settings of the selected measurement are 
shown on the left. 

 

 

Figure 267 The Corrosion analysis tab 

11.3.1 Setting up material parameters 

The material parameters required for analysis can be entered before the measurement in the 
Method Editor or after the measurement in the ‘Corrosion’ tab.  
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Figure 268 Tab with Material properties in the Method Editor 

The values set in the ‘Material’ tab of the Method Editor are copied to the tab for Corrosion 
analysis when a measurement is started. 

In the ‘Corrosion’ tab, the material parameter input fields are found beneath the plot. 

  

Figure 269 Material parameters used for calculations in the Corrosion tab 

The material parameters are required to determine the corrosion rate. Linear polarization 
measurements require surface area, equivalent weight and density and impedance 
measurements also require the anodic and cathodic Tafel slopes, 𝛽𝑎𝑛𝑜𝑑𝑖𝑐 and 𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐. 

▪ Surface area is the area of the sample in cm2. 

▪ Equivalent weight is the equivalent mass of one mole of the sample material in g/mol. 
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▪ Density is the density of the sample material in g/cm3. 

▪ 𝛽𝑎𝑛𝑜𝑑𝑖𝑐 and 𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐 are the Tafel slope parameters for the sample material, these can be 
determined from a linear polarization measurement or from literature. 

11.3.2 Linear polarization 

Linear polarization is typically used to study the corrosion response of metallic coatings. The 
following analysis techniques are supported for the estimation of the corrosion rate based on 
linear polarization measurements: 

▪ Auto Butler-Volmer fit: Fitting the Butler-Volmer model over an automatically 
detected range. 

▪ Manual Butler-Volmer fit: Fitting the Butler-Volmer model over a manually selected 
range. 

▪ Manual Tafel slope fit: Fitting Tafel slopes in the linear regions of the anodic and 
cathodic slopes. 

Note: To achieve an accurate estimation of the corrosion rate it is recommended to use a 
measurement with at least one linear Tafel slope that ranges over one decade in current 
density. Additionally, the distance between the Tafel slope and the corrosion potential should 
at least be 50 mV.  

The results of these analysis techniques are presented in the Tafel fit results table. 

 

Figure 270 Table with Tafel fit results 

▪ The corrosion potential (E corrosion) is the potential at which the anodic and cathodic 
reaction rates are equal. The measured current approaches zero at the corrosion 
potential, because all the electrons released by the dissolving of the metal are 
consumed by reduction reactions. For the Butler-Volmer techniques the corrosion 
potential is determined as the potential where the log the measured current is the 
smallest. In the Tafel slope method the corrosion potential is the potential where the 
anodic and cathodic Tafel slopes intersect. 
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▪ The corrosion current (I corrosion) is a measure of the rate of corrosion, measuring it 
directly is not possible. The corrosion current can be estimated the current at which 
the Tafel slopes intersect or by fitting the Butler-Volmer equation on a linear 
polarization measurement. 

 

▪ 𝐼 = 𝐼𝑐𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛(𝑒
(

2.303(𝐸−𝐸𝑐𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛)
𝛽𝑎𝑛𝑜𝑑𝑖𝑐

⁄ )
− 𝑒

(
−2.303(𝐸−𝐸𝑐𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛)

𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐
⁄ )

) 

 

▪ 𝛽𝑎𝑛𝑜𝑑𝑖𝑐 and 𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐 are the Tafel slopes, these represent the change in Volts per 
decade of current in the Tafel plot. 

 

▪ When plotting current over potential a linear slope is equals resistance (i.e. R=U/I). The 
slope close to the corrosion potential is approximately linear, this is referred to as the 
polarization resistance. The polarization resistance is inversely proportional to the 
corrosion current, assuming that the Tafel slopes are constants (Stern-Geary 
equation). 

 

▪ 𝐼𝑐𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 =
𝛽𝑎𝑛𝑜𝑑𝑖𝑐∙𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐

𝑅𝑝𝑜𝑙𝑎𝑟𝑖𝑧𝑎𝑡𝑖𝑜𝑛(𝛽𝑎𝑛𝑜𝑑𝑖𝑐+ 𝛽𝑐𝑎𝑡ℎ𝑜𝑑𝑖𝑐)
 

 

▪ The corrosion rate in mm/year can be calculated according to the standard practice 
described in the ASTM Standard G 102. To calculate this an estimation of corrosion 
current is needed as well as the following material parameters: equivalent weight (EW) 
in g/mol, the density (d) in grams/cm3, and the sample area (A) in cm2 of the study 
sample. Combined with a constant (K) defined by the ASTM (3272 mm/(amp*cm*year)) 
this information is used to determine the corrosion rate in mm/year. 

 

▪ 𝐶𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛 𝑅𝑎𝑡𝑒 =  
𝐼𝑐𝑜𝑟𝑟𝑜𝑠𝑖𝑜𝑛∙𝐾∙𝐸𝑊

𝑑∙𝐴
 

11.3.3 Selecting a curve for corrosion analysis 

On the right-hand side of the screen is a legend which contains all compatible corrosion 
measurements. To perform a Butler-Volmer or Tafel slope fit select a Linear Polarization 
measurement from the legend. The checkbox in front of the measurements indicate whether 
they are also visible in the plot window. 

 

 

Figure 271 The legend to select measurement data for performing a model fit 
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11.3.4 Performing an automatic Butler-Volmer fit 

The auto Butler-Volmer fit is automatically applied after selecting a Linear Polarization curve 
from the legend and after changing the value of one of the material parameters. Alternatively, 
clicking on the Auto Butler-Volmer fit button in the toolstrip above the plot also applies the fit. 

 

Figure 272 Toolstrip in the ‘Corosion’ tab with buttons for data fitting 

11.3.5 Performing a manual Butler-Volmer fit 

By selecting the Manual Butler-Volmer fit from the toolstrip above the plot the range for the 
Butler-Volmer can be set manually. 

Usage: click two points on the curve to mark start and end point 

 

Figure 273 Marking two points for a logarithmic fit 

11.3.6 Performing a Tafel slope fit 

To perform a Tafel slope fit click on the Manual Tafel slope fit button in the toolstrip above the 
plot. The Tafel slopes (Evan’s diagram) are drawn in the plot, they are either fit automatically or 
loaded from the previous fit. The ranges of the slopes can be adjusted in two ways. The range 
can be specified by clicking twice on a linear section of either the anodic or cathodic part of the 
corrosion measurement. 



PSTrace Manual » Corrosion mode 

228 PSTrace Manual 

Usage:  mark two points for the anodic slope line and/or two points for the cathodic slope line. 
After selecting two points a green line is drawn representing the Tafel slope. 

 

Figure 274 Setting the anodic and cathodic slope lines for Tafel plot analysis. 

Alternatively, the ranges of the slopes can be adjusted using the Tafel slope settings. Either by 
adjusting the ranges of the slopes using sliders or by entering the potential ranges in the text 
boxes. 

 

 

Figure 275 Adjustments of the Tafel slope settings 

To confirm the fit of the Tafel slopes click on Confirm in the top left corner of the plot. 

11.3.7 Correcting for the potential of the reference electrode 

In the corrosion mode it is possible to apply a reference electrode correction to the measured 
potential. Click on the downward arrow of the Show E corrected button in the toolstrip above 
the plot and select Determine E offsets. 
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Figure 276 From this menu you can select a correction for the potential of the reference 
electrode. 

11.4 Impedance Spectroscopy 
Electrochemical Impedance Spectroscopy (EIS) can be used to study corrosion and the effects 
of a wide range of coatings. For example, anodized coatings (anodized aluminium), conversion 
coatings (Chromate conversion coating), or organic coatings (paint). The corrosion rate and 
the pitting/disbanding of coatings are studied by fitting equivalent circuit models on the EIS 
measurement. 

 

 

Figure 277 Fitting an equivalent circuit on measured corrosion data 

11.4.1 Selecting a curve for corrosion analysis 

On the right-hand side of the screen is a legend which contains all compatible corrosion 
measurements. To perform an equivalent circuit fit select a EIS measurement from the legend. 
The checkbox in front of the other EIS measurements indicate whether they are also visible in 
the plot window. 
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Toggling visibility in the plot window 

11.4.2 Selecting an equivalent circuit 

To change the selected equivalent circuit either click on the ‘Load corrosion model presets’ 
button above the plot window to open the circuit library or click on the downward arrow of the 
button to quickly select a circuit. 

 

Figure 278 Corrosion circuit library. 

 

Figure 279 Corrosion circuits quick access. 

Loading a circuit from the circuit library or the quick select menu will update the circuit model 
settings. A graphical representation of the selected equivalent circuit is displayed, below the 
image is a table with circuits corresponding parameters. When selecting one of the four 
corrosion rate circuits the corrosion parameters are added to the table: polarization resistance 
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(R polarization in Ohm (Ω)), corrosion current (I corrosion in Ampere (A)) and corrosion rate 
in mm/year. 

Note: for the corrosion parameters to be calculated all material parameter values must be 
greater than 0.  

11.4.3 Fitting the equivalent circuit 

Before fitting a circuit, the frequency range on which to perform the fit can be selected. By 
default, a fit is performed over the entire measurement. To select a frequency enter the desired 
range in frequency range text boxes below the plot. 

 

 

Figure 280 The frequency range to fit EIS data on. 

Alternatively, it is possible to specify the frequency range in the plot by selecting the ‘Select fit 
range’ mouse pointer button from the toolstrip left to the plot and clicking in the plot. 

 

 

Figure 281 Selecting a frequency range for data fitting 

Selecting the fit frequency range. Double-click on a point in the plot. Then select the point to 
where the fit should be performed. 

To fit the model on the measurement, click on the ‘Fit model’ button. The result of the fit is 
stored in your measurement, but to store the fit result it is necessary to save your 
measurement. Simple circuits with few components will often fit directly, but more complex 
circuits will require fine tuning of the circuit parameters before a good fit is obtained. To fine 
tune the model, you can either use your prior knowledge of the cell or you can estimate certain 
parameter values from the Bode and Nyquist plots. For more information on circuit fitting 
please refer to the help section on circuit fitting on page 165. 
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11.5 Exporting results 
There are three ways to export the results from your Tafel or circuit fit: 

 

 

Figure 282 Left: Copying Tafel fit results to clipboard. Right: Copying circuit fit results to 
clipboard. 
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1. Exporting a Tafel plot or a circuit fit curve to Excel (Bode or Nyquist) by pressing the 
export to Excel button on the left-hand side of the plot. 

2. Printing/saving a report as a .rtf file by clicking on the print report button or selecting 
the save report button in the toolstrip above the plot. 
 

 

   

Figure 283 Left: Tafel fit report. Right: Circuit fit report. 

11.6 Example data files 
The program comes with an example file stored in the default PS Data folder: 
“My Documents\PSData\Corrosion mode examples\Corrosion.pssession”.  

You can load this file in PSTrace using the menu ‘Data → ‘Load data file…’  
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12 Files 

PSTrace uses a number of different file formats. This chapter describes which file types are used 
by PSTrace. 

12.1 File types 
PSTrace creates a number of different files in ASCII format. 

The files are default stored in the folder:  

My Documents\PSData 

The following files are currently supported by PSTrace and Multitrace 

 

Table 18 Supported file types in PSTrace and Multitrace 

Method .psmethod 

Raw meaurement data, curves and 
methods 

.pssession 

Script .psscript 

MultiTrace project file .psproject 

12.1.1 Obsolete file formats  

The following list of file formats has become obsolete. They can still be loaded in latest versions 
of PSTrace, but no longer be saved in the particular format. 

Table 19 Obsolete file types 

Method (old style) .pms (scans) or pmt (vs time) 

Curve .pss (scans) or .pst (vs time) 

EISdata .pseisdata 

Multiple curves .mux 

Analysis curves .pds 

Info .rtf 
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12.1.2 Method files 

Methods can be saved separately or are automatically saved with a curve.  

12.1.3 Curve files (obsolete) 

If a curve (.pss, .pst) is saved or multiple curves (.mux, .pds) are saved, a method file with the 
same name and corresponding extension is always saved. This method file also contains the last 
plot view window used (zoom).  

The curve file contains measured data of potential and current or time and current. 

12.1.4 EIS data files (obsolete) 

Electrochemical Impedance Spectroscopy data is saved in an .pseisdata file. These files are plain 
text and contain values for frequency, current range, Z, phase, Idc and Iac. 

12.1.5 Session files 

Session files can contain all the data available at any time in a PSTrace session. 

All available measurements, corresponding curves and method, including the active method in 
the method editor can be stored to a single .pssession file format. 

 

Figure 284 A PSSession (.pssession) file contains basically all the data available at a given 
moment. 

12.1.6 PSScript files 

The .PSScript files are plain ASCII files containing a script that can be loaded and run in the Script 
window of PSTrace. (See section Scripting on page 243) 

12.2 Loading and saving data 
Methods and measurements can be loaded and stored from and to a hard-drive or other 
storage solution. 

12.2.1 Loading methods 

There are three ways to load a method (.psmethod) file: 

1. Selecting the load method file button from the toolstrip; 
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2. Selecting load method from the method menu; 

 

 

Figure 285 The ‘Method’ menu 

3. Selecting a recently loaded method from the recent methods list; 

 

 

Figure 286 Recent methods in the ‘Method’ menu 

4. Drag and drop a method file to the PSTrace window from the Windows File Explorer. 

12.2.2 Saving methods 

Methods can be saved as psmethod files by: 

1. Selecting the save method file button from the toolstrip; 

 

 

Figure 287 Button for saving methods 

2. Selecting save method from the method menu; 

 

 

Figure 288 Menu item for saving methods 
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12.2.3 Loading measurements 

Measurements and sessions can be loaded or added to your current session, i.e. loading a 
pssession/pss/pst/pseisdata/mux/pds file will replace all other data in your current session. 

There are different ways to load measurements: 

1. Selecting the load data button from the toolstrip. 

 

 

Figure 289 Button for loading methods. 

2. Selecting load data file from the ‘Data’ menu. 

 

 

Figure 290 ‘Load data file’ menu item in the ‘Data’ menu. 

3. Selecting a recently loaded data file from the recent data files list. 

 

 

Figure 291 The recent data files list in the ‘Data’ menu 

The ‘Load data’ dialog shows a ‘Preview’ tab and a ‘Details’ tab.  The ‘Preview’ tab contains some 
additional settings that influence the assignment of colors for the loaded curves. The available 
settings are: 

▪ ‘Default’: use the setting stored with each curve. 
▪ ‘Do not auto assign’: ignores automatically assigning of colors and assigns last color 

stored with the curve. 
▪ ‘Auto assign all’: ignores the colors stored with the curves and auto assign new colors 

for all curve. 
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Figure 292 The ‘Load data’ dialog with curve color settings in the ‘Preview’ tab. 

 

Data files can be added to your current session by: 

1. Selecting the add curve button from the toolstrip. 

 

 

Figure 293 Button for adding existing data to the current session 

2. Selecting load data file from the data menu; 

 

 

Figure 294 Menu item for adding existing data to the current session 

3. Dragging and dropping data files to the PSTrace window from the Windows File 
Explorer. 

12.2.4 Saving measurements 

The measurements in your current session can be saved in a pssession file. In the save dialog 
you can specify the measurements and curves that should be stored in the pssession file. The 
save dialog can be opened by: 

1. Pressing CTRL+s on the keyboard; 

2. Selecting the save data button from the toolstrip; 
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Figure 295 Button for saving data 

3. Selecting save data from the data menu; 

 

 

Figure 296 Menu item for saving data 

On the right-hand side of the save dialog you can (un)check the data that you would like to 
save, only checked measurements/curves are saved. 

 
Figure 297 Save data window with list to select the data to include 

12.3 Exporting data to other file formats 
Measured data can be exported to different file formats. The export options are available in the 
‘Curve’ menu. 
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Figure 298 Curve menu showing export options 

12.3.1 CSV 

The CSV (Comma Separated Values) is a popular format in plain ASCII, supported by many 
applications like Excel, OpenOffice Calc and Origin. To change the values exported for EIS data, 
open the ‘Settings’ window (menu: ‘Tools’ → ‘General settings…’) and click the ‘Plot and data’ 
tab. Then click the button ‘Set columns for exporting EIS data’.  

12.3.2 Origin 

Origin from OriginLab is scientific graphing and data analysis software widely used at 
universities.  

See for more information: http://www.originlab.com/ 

To change the values exported for EIS data, open the ‘Settings’ window (menu: ‘Tools’ → 
‘General settings…’) and click the ‘Plot and data’ tab. Then click the button ‘Set columns for 
exporting EIS data’. 

Origin does not need to be installed on the PC to export curves to the Origin format.  

http://www.originlab.com/
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13 Scripting 

PSTrace provides a straightforward and user-friendly interface for executing individual 
measurements. The Script menu extends this functionality, allowing users to perform more 
complex workflows and include additional commands. One of the versatile applications of the 
Script feature is the ability to execute a sequence of diverse methods, establish loops, introduce 
wait periods, and define specific parameters. 

An example script file is available in the default data folder, typically located at 'My 
Documents\PSData.' 

In the default data folder (normally ‘My Documents\PSData’) a script file is available as example. 

 

13.1 Features 

 

Figure 299 Scripting main window 

Available commands.
Click to add to the script

File where script output is saved in

Script output log

Start, pause and stop the script

Settings of selected command
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13.1.1 File menu 

 

Figure 300 The ‘File’ menu 

The table below explains each menu item. 

Table 20 The menu items in the ‘File’ menu. 

Menu item Action 

New Clears the script present in the editor. 

Load script Loads a saved script. 

Save script Saves a script to a specific location. All the file references to 
method or curve files in the script will be made relative to the 
location of the script file. For example, if the script file is in 
location: 
C:\directory A\script.psscript 
 
and the script refers to files in location 
C:\directory A\directory B\ 
 
the file references in the script file will be relative: 
directory B\file1.psmethod 
directory B\file2.psmethod 
and not to the absolute path: 
C:\directory A\directory B\file1.psmethod 
C:\directory A\directory B\file2.psmethod 
 
So, if the directory A including script and sub-directory is copied 
to another location or PC, the references will still be intact. 

Export all to single 
folder 

Copies all files that are referred to and the actual script file to the 
folder chosen to save the new script file into. So, if a script file is 
at location: 
C:\directory A\script.psscript 
 
and file references in the script are for example to: 
C:\directory B\file1.psmethod 
C:\directory C\file2.psmethod 
 
All files will be copied to a single folder and all file references will 
be changed to this folder. This allows you to save all relevant files 
to a single location for back-up purposes. 
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Export all and pack to 
ZIP 

This function does the same as ‘Export all to single folder’ as 
described above, but instead of targeting a folder all files are 
saved to a single ZIP file. 

 

13.1.2 Composing a script 

The script contains of a sequence of commands which is run from the top down. Add 
commands using the list of available commands shown at the left of the script.  

The order of the commands in the script can easily be changed by dragging and dropping 
them. Click and hold on the text of a command and drag the command to a location where you 
want. The black arrow shows where the command will be dropped. 

In the picture below the ‘Wait’ command is dragged above the ‘Measure’ command: 

  

Figure 301 Inserting a ‘Wait’ command. 

From PSTrace version 5.10, the Scripting validates the compatibility of the current command 
with the connected device. If the command is not compatible, it will be highlighted in red, and 
an accompanying error message, also displayed in red, will provide an explanation for the 
encountered incompatibility. 

13.1.3 Changing parameters 

The parameters for each command can be changed in the panel at the right side of the script. 
This panel shows the settings for the selected command. Click the ‘?’ button to get help for the 
selected command. 

13.1.4 Using the output file 

The output file can be specified by typing in the textbox or using the ‘Browse’ button.  

 

Figure 302 Setting the script output file. 

If one of the following commands is used in the script and the output checkbox is checked, the 
corresponding results are appended to the text file provided. 

▪ ReadCurrent 
▪ ReadPotential 
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▪ FindPeaks 
▪ ReadAnalog 
▪ ReadDigitalIO 

 

The file can be read using any text editor like Notepad, or they can be loaded in Excel. The 
columns are separated using tabs. 

13.2 Measure command 
This command loads a Method file and runs it, like a standard run in the main PSTrace window. 
This command is designed to operate as a standalone instruction, eliminating the need to 
incorporate additional commands for a complete method run. Other commands such as ‘Cell’, 
‘Read current’, ‘Set potential’, etc., are intended for users who need to create alternative 
workflows or customize the measurement sequence. However, if the objective is to run the 
measurement as a typical operation in the main PSTrace, there is no requirement to include 
additional commands. 

 

Figure 303 Panel with options for the ‘Measure’ command. 



PSTrace Manual » Scripting 

PSTrace Manual 247 

▪ Clear plot before start measurement: If checked; the plot and legend will be cleared 
before the measurement is started. In case a Blank is measured first or afterwards, both 
the Blank and the actual measurement curve will be displayed in the plot. 

▪ Load method from specified file: The specified method will be loaded for this 
measurement. A new method can be created and saved instantly using the ‘Create new 
method…’ button. The ‘Edit…’ button allows to make changes in the method file and 
save (overwrite) these changes to the specified file.  

If the same method file is assigned in multiple scripts, any 
alterations made will be applied since the method file is loaded 
at the initiation of each measurement. If you need to modify a 
single parameter from a method, please refer to ‘Override’ 
command. 

▪ Subtract Blank: If subtract blank is checked a Blank curve will be subtracted from the 
measured curve. This curve can be an existing curve (‘Load existing Blank curve’) or 
can be measured (‘Measure using method’). 

▪ Measure Blank first: When this option is checked, the method designed for the Blank 
will be loaded initially and employed for measurement. Subsequently, the actual 
measurement will take place. Upon completion, the system will automatically subtract 
the Blank curve from the measured data. 

▪ Save result: When checked, the measured curve (or curves in case a Blank was used) 
will be saved using the prefix, followed by a number. This number automatically 
increments if multiple curves are saved with the same prefix. If curves are not saved 
from within the Script, all curves in the PSTrace plot can be saved manually to a single 
session file (.pssession) using the ‘Data’ menu as well. 

▪ Cell on after measurement: In case a method is used with the setting 'Cell on after 
measurement' together with 'cell off after n seconds', the latter setting is ignored in 
the script so the cell can be turned off after a specific period in the script.  

To keep the cell on after a measurement for a period, you should use the 'Wait' command in 
combination with the ‘Cell’ command. 

13.3 FastMode command 
When a potentiostat is idle, it normally sends an idle status package with voltage, current and 
auxiliary readings every second. If an instrument receives a command while measuring the 
values for the idle status package it will not be able to process the received command 
immediately. Setting ‘FastMode’ on disables the idle packages being sent every second. This 
way the response time of the instrument is always optimal. 

13.4 Cell command 

 

Figure 304 Panel with options for the ‘Cell’ command. 
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Turns the cell on or off. By default, the potentiostat is initialized with the cell turned off. In this 
state, only the Working Electrode (WE) or Sense (S) and Reference Electrode (RE) leads are 
connected to the potentiostat, enabling the reading of its Open Circuit Potential (OCP). Upon 
turning the cell on, the Counter Electrode (CE) lead is connected, resulting in polarization of 
the cell. 

It's important to note that this command is not necessary for preceding or succeeding 
'Measurement' commands, as it automatically manages the cell state as needed, turning it on 
or off accordingly.   

Example: 

 

Figure 305 Example showing the use of the ‘Cell’ command. 

13.5 SetCurrent command 

 

Figure 306 Panel with options for the ‘SetCurrent’ command. 

The ‘SetCurrent’ sets the connected device in galvanostatic mode and applies a constant 
current at the specified current range. It is important to note that this command is not 
supported by certain models without galvanostatic capabilities (i.e., EmStat1/2/3 series, EmStat 
Pico, and Sensit series). 
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13.6 ReadCurrent command 

 

Figure 307 Panel with options for the ‘ReadCurrent’ command. 

The ‘ReadCurrent’ command should be used when the cell is on. It reads the current and stores 
the value in the text file specified at the bottom of the script window. 

13.6.1 Auto ranging 

If the ‘Use auto ranging’ checkbox is used, the current range will be evaluated at each interval 
time and changed if necessary. If the correct current range has been found or the minimum or 
maximum range is set, the current will be read. 

The first current range to evaluate is the highest current range.  

If ‘Use auto ranging’ is not used the ‘ReadCurrent’ command will leave the current range 
unchanged. The current range can be changed in the script using the ‘Current range’ 
command. See next section. 

13.6.2 Output 

If there is no column in the text file yet, it will add the line with columns first and then the line 
with values. The same columns are used for potentials. 

The values are all separated by a TAB and can be imported in Excel. 

Example output: 

Script output 12/07/2012 - 17:42:43: 

Time   Potential in V   Current in uA 

12/07/2012 17:42:45   -3.313E-5 

12/07/2012 17:42:46   -7.501E-6 

12/07/2012 17:42:47   5.250E-5 

12/07/2012 17:42:48   -4.250E-5 
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13.7 SetPotential command 

 

Figure 308 Panel with options for the ‘SetPotential’ command. 

The ‘SetPotential’ command sets the connected device in potentiostatic mode and sets the 
potential to the given value. The cell state (on or off) is not changed. 

13.8 ReadPotential command 

 

Figure 309 Panel for the ‘ReadPotential’ command. 

The ‘ReadPotential’ command outputs the potential to the output file. Depending on the 
potentiostat model, certain potential ranges or other options may become available. These 
options are equivalent to those encountered in the OCP (Open Circuit Potentiometry) 
technique. 

13.8.1 Output 

If there is no column in the text file yet, it will add the line with columns first and then the line 
with values. The same columns are used for currents. 

The values are all separated by a TAB and can be imported in Excel. 

Example output: 

Script output 12/07/2012 - 17:45:59: 

Time   Potential in V   Current in uA 

12/07/2012 17:46:01 -1.501   

12/07/2012 17:46:02 -1.401   

12/07/2012 17:46:03 -1.299   

12/07/2012 17:46:04 -1.200   

12/07/2012 17:46:05 -1.098   
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13.9 Wait command 

 
Figure 310 Panel with options for the ‘Wait’ command. 

The ‘Wait’ command places the script in and idle state for a specified period or until a specified 
event occurs. 

▪ Wait for: The script continues after the specified number of seconds. 
▪ Resume today at: The script continues at the specified time of day (this can go on for 

multiple days) 
▪ Wait until user resumes: The script shows the message in the script result box (see 

Features) and waits until the user clicks the active Pause button to resume. 
▪ Wait until digital line: The script waits until the IO input D0 on the auxiliary port is set 

HIGH or LOW. This feature can be used to let an external device determine if the script 
can continue. When waiting for the digital line to be HIGH or LOW, the pin status is 
polled about every 20 ms. 
In case a quicker response is required using MethodSCRIPT™ might be preferable.  
Please refer to the instrument-specific sections in this manual for more information 
about the positions of the digital and analog I/O pins on your instrument’s auxiliary 
port. 

13.10 Repeat command 

 

Figure 311 Panel with options for the ‘Repeat’ command. 



PSTrace Manual » Scripting 

252 PSTrace Manual 

The ‘Repeat’ command allows for the repetition of a set of commands. To repeat specific 
commands, attach them to the 'Repeat' instruction in the list. This can be done by clicking and 
dragging the desired commands into the 'Repeat' command or by adding a new command with 
the 'Repeat' option selected to include it in the repetition. The commands earmarked for 
repetition must be presented as a branch within the 'Repeat' command. 

Example: 

 

Figure 312 An example script involving a nested ‘Repeat’ command. 

Since PSTrace 5.10 a Repeat branch can also contain nested 
Repeat branches, for creating a ‘loop-in-a-loop’. 
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13.11 FindPeaks command 

 

Figure 313 Panel with options for the ‘FindPeaks’ command. 

The ‘FindPeaks’ command performs a peak search over the last measured curve available. This 
instruction is therefore logically preceded by the Measure command. 

The peaks found are written to the output file specified. 

▪ All peaks: All peaks are searched using the parameters as specified in the method 
editor. This command always uses the default algorithm for peak search and may give 
different results compared to using the auto-detect peaks button in the main window. 

▪ Use window: The number of peaks must be specified and for each peak the left and 
right of the search window must be provided. 

▪ Manual baseline: The provided left and right values for each peak are used as left and 
right of the peak baseline, therefore forcing the finding of a peak. 

13.11.1 Output 

If there are no columns set yet in the output file, a line with columns will be added first. All values 
are separated by a TAB and can be exported to Excel. 

13.12 SetChannel command 

 

Figure 314 Panel with options for the ‘SetChannel’ command. 

The ‘SetChannel’ command sets the channel of a CH8, MUX or MUX8-R2 multiplexer. 
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13.13 NextChannel command 
The ‘NextChannel’ command sets the connected CH8, MUX or MUX8-R2 multiplexer to the 
next channel in sequence. If this command is executed when the multiplexer is already at the 
last available channel, it will wrap around and set to the first channel. 

13.14 PrevChannel command 
The ‘PrevChannel’ command sets the connected CH8, MUX or MUX8-R2 multiplexer to the 
previous channel in sequence. If this command is executed when the multiplexer is already at 
the first available channel, it will wrap around and set to the last channel. 

13.15 Stirrer command 

 

Figure 315 Panel with options for the ‘Stirrer’ command. 

A stirrer can be controlled by any instrument from PalmSens BV that has an auxiliary port. This 
command sets the stirrer on or off by using the D0 and D1 digital lines.  

13.16 SetAnalog command 

 

Figure 316 Panel with options for the ‘SetAnalog’ command. 

The ‘SetAnalog’ command sets a potential on the Analog output of the auxiliary port of the 
connected instrument. The output range depends on the connected instrument.  

Please refer to the instrument-specific sections in this manual for more information about the 
positions of the digital and analog I/O pins on your instrument’s auxiliary port. 

13.17 ReadAuxiliary command 
The ‘ReadAuxiliary’ command reads the value for the auxiliary input port of the connected 
device and appends the result to the output file. The input range depends on the instrument 
connected and/or the auxiliary input type connected.  

Please refer to the instrument-specific sections in this manual for more information about the 
positions of the digital and analog I/O pins on your instrument’s auxiliary port. 
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See for setting the type of auxiliary input: Configuring PSTrace on page 6 

Output example for a temperature sensor: 

Script output 18/08/2023 - 10:00:32: 

18/08/2014 10:00:32 Aux. In: T = 29.276 °C 

18/08/2014 10:01:32 Aux. In: T = 30.275 °C 

18/08/2014 10:02:32 Aux. In: T = 30.388 °C 

18/08/2014 10:03:32 Aux. In: T = 30.497 °C 

18/08/2014 10:04:32 Aux. In: T = 30.613 °C 

 

13.18 SetDigitalIO command 

 

Figure 317 Panel with options for the ‘SetDigitalIO’ command. 

Set the digital IO ports of the connected device. Selected and highlighted buttons stand for a 1 
otherwise 0, so in the example above the digital lines set are: 0101 

Please refer to the instrument-specific sections in this manual for more information about the 
positions of the digital and analog I/O pins on your instrument’s auxiliary port. 

13.19 ReadDigitalIO command 
Reads the digital input states of the 3 or 4 digital lines of the connected device and appends the 
result to the output file. 

Output example: 

Script output 12/07/2023 - 18:15:56: 

12/07/2012 18:15:56 Digital lines:  0 0 0 0 

12/07/2012 18:15:57 Digital lines:  0 0 0 1 

12/07/2012 18:15:58 Digital lines:  0 0 1 0 

 

Please refer to the instrument-specific sections in this manual for more information about the 
positions of the digital and analog I/O pins on your instrument’s auxiliary port. 

13.20 Override parameter command 
The ‘Override parameter’ command is always attached to a Measure command. The value 
provided can either be 'Fixed' or an ‘Added value'.  
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Figure 318 Panel with options for the ‘Override parameter’ command. 

The command can be found under the ‘advanced’ tab. This command is helpful, if you want to 
repeat the same methods in one experiment several times with different parameters each time. 

▪ Parameter: The method parameter to override. 
▪ Original value: Refers to the parameter value retrieved from the loaded method. This 

value is presented in a muted grey shade for clarity and differentiation from user-
modified values. 

▪ New value: Refers to the value intended to replace the original value when the option 
'New Value is Fixed' is selected. Alternatively, if the option 'New Value is Added' is 
selected, it represents the quantity/amount to be added (summed) to the original 
value. In case 'New Value is Added’ is selected, and the measure command is used 
within a Repeat block as shown in the example below (Pseudo Polarography), this 
means that the result of the previous iteration will be used for each new value.  
If the resulting value is not valid, because it exceeds the parameter limits, the script will 
continue using the last valid value. 

▪ Skip first iteration: This option is designed for use when there is an Override 
command within a Repeat and is visible only when 'New Value is Added' is chosen. 
When checked, it ensures that the first measurement (iteration) applies the original 
value instead of adding (summing). If no Repeat is associated, selecting this option 
will render the Override without effect. 

13.20.1 Using the override parameter for Pseudo Polarography 

The override parameter can be used to change the deposition potential for each iteration in a 
repeat loop.  In the example below the deposition potential (E dep) is read as 1.000 V in the 
method provided for the Measure command. The Override parameter command is attached 
to the Measure command. The Override parameter command adds 0.1 V with each iteration to 
the deposition potential.  This results in a deposition potential in the first iteration of -0.4 V, in 
the second of -0.3 V, etc. 
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Figure 319 Using the ‘override parameter’ for pseudo polarography. 

13.21 Running a script from the command line 
Running PSTrace from the command line provides the following options: 

 

> pstrace.exe ["path to .psscript file"] [-q] [-d#] [-h] 

 

If a script file is specified, PSTrace will do the following automatically at startup: 

▪ Connect to the first known device (PalmSens or EmStat) found. 
If -d# is used it will connect to the device on position # as shown in the devicelist . So -
d1 will connect to the first device in the list, -d2 to the second, etc. 
(If -h is used in combination if -d#, PSTrace and the script window will remain invisible 
to the user.) 

▪ Open the script window. 
▪ Load the specified script file. 
▪ Start the script. 
▪ If -q  is provided then PSTrace will be closed when the script has finished. 

Make sure to use quotes around the file path if it has spaces. 

Example: 

The following two command lines could be included in a batch file (.BAT) or run from an 
external application to automate a measurement sequence: 

 

cd "C:\Program Files (x86)\PalmSens BV\PSTrace 5.9" 

pstrace.exe "C:\Users\John\Documents\PSData\script.psscript" -q 
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14 MethodSCRIPT 

 

14.1 About MethodSCRIPT 
MethodSCRIPT™ is the language our latest generation of potentiostats speaks. MethodSCRIPT 
gives you full control over the instrument or potentiostat module.  

The script language is in plain text, uses SI units where possible and has a shallow learning curve.  

The script can be sent directly to our instruments through PSTrace, a terminal, or virtually any 
software written in any programming language. Once the instrument receives the script, it 
compiles and executes it on-board, with no pre-processing required beforehand. 

MethodSCRIPT allows you to customize and combine measurement techniques or to create 
custom techniques. It also allows for programming an instrument with a script to function 
stand-alone, without any host (PC or smartphone) intervention. MethodSCRIPT supports 
actions for: 

▪ storing data on the internal storage; 
▪ going to a sleep mode; 
▪ waking up on time, digital or physical triggers; 
▪ controlling external peripherals; 
▪ doing calculations; 
▪ using conditional statements; 
▪ doing data analysis (e.g. peak detection); 
▪ and more. 

 

14.2 Generating MethodSCRIPT in PSTrace 
PSTrace can be used to generate MethodSCRIPT from the parameters set in the Method Editor. 
This can be done by clicking the “Show MethodSCRIPT” button, which is found underneath the 
Method Editor. 
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Figure 320 The Show MethodSCRIPT button 

14.2.1 MethodSCRIPT button visibility 

In case the MethodSCRIPT button is not showing, there can be several reasons: 

1. There is no instrument connected 
2. The connected instrument does not support MethodSCRIPT 
3. A setting needs to be changed in the General Settings window. 

To change the setting for showing the MethodSCRIPT button, open the Settings window via the 
menu ‘Tools’ → ‘General Settings … ‘. The first tab ‘Hardware’ shows a checkbox for “Show 
MethodSCRIPT Editor”. 

 

 

Figure 321 Setting in General Settings window for showing the MethodSCRIPT button  

14.2.2 Adding more generated MethodSCRIPT  

When the button is clicked it will open the MethodSCRIPT Generator window. This window 
allows to add some additional MethodSCRIPT for certain functionality. 
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Figure 322 The MethodSCRIPT window showing generated script 

The following functionality can be added to the generated script: 

▪ “Send data during pretreatment” 
The pretreatment part (present if t > 0) consists of maximum three ‘meas_loop_ca’ 
commands, which is basically a chronoamperometry measurement. One for 
conditioning, one for depositioning and one for equilibration. During each 
pretreatment stage, the measured current data can optionally be sent by the 
potentiostat. If the checkbox is set, PSTrace will generate curves for each pretreatment 
stage. 

▪ “Add time data” 
When enabled, each ‘meas_loop_’ command will receive an extra variable for time. In 
PSTrace an extra column in the data tab will appear with the time for each datapoint, 
starting at 0 s for the first datapoint. 

▪ “Hibernate and repeat” 
This checkbox is particularly useful when using the Sensit Wearable. It creates an 
infinite loop around the measurement where it first sets the device in hibernation at 
the start of each iteration. As soon as the device is woken up it runs the measurement 
and resumes hibernation for the next iteration. The device will wake up by any form of 
communication by default. Connecting the device to USB and trying to connect for 
instance will wake the device up from hibernation. 
The following options are available for waking the device from hibernation. 

o “Wake on double tap” 
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If the device’s hardware, like the Sensit Wearable, has ‘tap detection’ this 
checkbox will make it wake up from hibernation when double tapped 
(physically) by the user.  
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o “Wake on pin/button” 
Will wake up the device if the device’s hardware has a push button or a 
dedicated IO pin for waking up. Supported devices include, Sensit BT, Sensit 
Wearable and the EmStat Pico Development Board. 

o “Wake after … s” 
Will make the device wake up as soon as the given time has passed. 

“Store script in permanent memory“ 

This will add a command at the end of the script to place the script in non-volatile memory 
making it remain there when the device is powered off. In combination with the “AUTO-RUN” 
function it will allow the device to work independently and run the script always when it is 
powered on.  

Be careful with this option and make sure to test your script first 
to see if it can be interrupted, before placing it in the permanent 
memory and enabling the AUTO-RUN option. 
 
A faulty script in permanent memory in combination with the 
AUTO-RUN function enabled can brick your device! 

To ensure that a hibernating device can always be woken up, the first bit of the ‘hibernate’ 
command must be enabled. You can easily verify this by checking if the argument passed to 
the hibernate command is an odd number. The MethodSCRIPT generator in PSTrace 
automatically handles this by default. 

14.3 Running a MethodSCRIPT 
It is not possible to run scripts directly from the MethodSCRIPT generation window. The 
generated script first needs to be transferred to the MethodSCRIPT Editor so it can be ran as a 
“MethodSCRIPT Sandbox” measurement. To do this, simply click on the “MethodSCRIPT Editor” 
button. 
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Figure 323 The “Open in Editor” button which opens the generated script in the Editor, 
allowing it to be edited and run 

Now that the script is in the Editor, it can be ran by clicking the ‘Start Measurement’ green 
triangular button at the top of the main window. 

PSTrace parses and stores the variables sent in ‘pcks’. Curves are generated automatically for 
each meas_loop that defines a pck with two or more variables, scripts with multiple meas_loops 
will generate multiple curves. The first variable in the pck will be set as the X-axis and a curve is 
created for each subsequent variable in the pck. Please note that to plot data versus time you 
will need to add a variable with the time to the pck. 

For altering the script please refer to the MethodSCRIPT documentation which can be found 
under the Help button and on our website. 

See for more information and documentation and example scripts: 

www.palmsens.com/methodscript 

 

http://www.palmsens.com/methodscript
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15 MUX8 and MUX16 multiplexers 

 

Figure 324 MUX multiplexer 

The MUX8 and MUX16 are used to switch electrodes to the EmStat or PalmSens potentiostat. 

Please note that a potentiostat with a multiplexer is not the same as a multi-channel 
potentiostat. 

The EmStat-modules up to 3 (and 3+) were offered in combination with the MUX8-R2 
multiplexer integrated in a single housing as the model “EmStat MUX”. 

For the PalmSens and EmStat Blue the multiplexers come optional in a separate housing. The 
multiplexers require an available auxiliary port (AUX) DE-15. These products were discontinued 
and replaced by the MUX8-R2.   

15.1 MUX8 multiplexer 
The MUX8 multiplexer is used with 2- or 3- electrode sensors or cells up to 8 channels.  

15.1.1 Functional diagram 

The figure below shows the functional diagram of the MUX multiplexer. 
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Figure 325 Functional diagram of the MUX multiplexer 

15.1.2 Cell connector pin-out 

The connector on the MUX8 circuit board and the DSUB connector have the pinout as shown 
in the figure below. 

 

 

Figure 326 MUX8 multiplexer cell connector pin-out 

15.1.3 Specifications 

The following table shows the main specifications of the MUX8 multiplexer. 

Table 21 MUX8 multiplexer specifications 

Number of channels 2-8 
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Multiplexer modes  Sensorarrays with up to eight working, reference and 
counter electrodes  

Sensorarrays with up to eight working and eight combined 
reference/counter electrodes  

Sensorarrays with up to eight working electrodes all sharing 
the same reference and the same counter electrode  

Sensorarrays with eight working electrodes all sharing the 
same combined reference/counter electrode  

On resistance WE, CE and RE channels: 2 Ω typical 

Leakage current 10 pA typical at 25 ºC  

Charge injection 20 pC typical 

Connections: Shielded flat cable, with stripped end leads or 
by means of the MUX8 Connection Terminal (in shielded 
housing) 

8x WE 

8x CE 

8x RE 

one CE used when all WE’s share one counter electrode 

one RE used when all WE’s share one reference electrode 

analog ground for shielding 

15.1.4 Sensor configurations 

The multiplexer can be used in different modes. Each mode is set by several jumpers on the 
board or by means of the corresponding switches found at the bottom of the instrument.  

 

 

Figure 327 Jumpers on the MUX8 circuit board 
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Figure 328 Switches at the bottom of the MUX8 

Possible sensor configurations are: 

1 Sensorarrays with (up to) eight working, reference and counter electrodes  

2 Sensorarrays with eight working and eight combined reference/counter electrodes  
3 Sensorarrays with eight working electrodes sharing a reference and a counter 

electrode  
4 Sensorarrays with eight working electrodes sharing a combined reference/counter 

electrode  

In all configurations the sensors can be multiplexed, leaving the not-selected sensors or cells 
at open circuit. Sensor configurations 2, 3 and 4 have the possibility to leave not-selected 
sensors or cells at open circuit or to apply the same potential to all sensors or cells. 

15.1.5 Jumpers / switches 

J1: RE to CE  

 Set ON when the sensor has a combined reference and counter electrode. 
This jumper therefore connects RE to CE. 

J2: CE Direct  

Set ON if the sensor array has more than one working electrode, but only one shared 
counter electrode. The CE from the potentiostat is switched directly to pin 1 and pin 2 
of the cell connector. 

J3: RE Direct  

Set ON if the sensor array has more than one working electrode, but only one shared 
reference reference. The RE from the potentiostat is switched directly to pin 13 and 14 
of the cell connector. 

J4: CE MUX  

Set ON if CE must be multiplexed. This is the case when each of the sensors has its own 
counter electrode (using pin 3 to 10 of the cell connector). 

J5: RE MUX  

Set ON if RE has to be multiplexed. This is the case when each of the sensors has its 
own reference electrode (using pin 15 to 22 of the cell connector). 



PSTrace Manual » MUX8 and MUX16 multiplexers 

PSTrace Manual 269 

J6: Unselected WE to GND:   

Set ON if all unselected working electrodes or sensors must remain polarized at the 
potential as set by the potentiostat. If J6 is OFF only the selected channel is polarized, 
and all the idle channels will be in open circuit.  

In case CE and RE are multiplexed as in Conf 1, so when J4 and J5 are ON, this 
jumper/switch is not relevant since only the selected channel’s WE, CE and RE are 
polarized. 

J7: Unselected WE to standby potential  

 Always leave it OFF when using the PSTrace. 

15.1.6 Recommended settings for the available configurations 

- Conf. 1: Sensor array with up to eight working, eight reference and eight counter 
electrodes: 

o Jumpers to be ON: J4 and J5 

The potential is only applied to the selected channel. All other (idle) channels will 
remain at open circuit. (See remark below * ) 

 

- Conf. 2a: Sensor array with up to eight working and eight combined reference/counter 
electrodes: 

o Jumpers to be ON: J1, J4 and J5 

Note: all leads CE1-8 and RE1-8 are connected together and this combined lead is 
connected to all eight combined reference/ counter electrodes. 

The potential is only applied to the selected channel. All channels NOT selected 
are at open circuit. (See remark below * ) 

When J6 is also ON, the potential is applied to all working electrodes continuously. 

 

- Conf. 2b:  Sensor array with up to eight working and eight combined 
reference/counter electrodes: 

o Jumpers ON: J1, J2 and J3 

Note: the combined reference/counter electrodes are connected to the leads CE 
Direct and/or RE Direct 

When J6 is also ON, the potential is applied to all working electrodes continuously. 

 

- Conf. 3: Sensor array with up to eight working electrodes all sharing one reference and 
one counter electrode: 

o Jumpers ON: J2 and J3 

Note: the reference and counter electrodes are connected to RE Direct and CE 
Direct respectively. 

When J6 is also ON, the potential is applied to all working electrodes continuously. 
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- Conf. 4: Sensor array with up to eight working electrodes all sharing one combined 
reference/counter electrode: 

o Jumpers ON: J1, J2 and  J3 

Note: the reference/counter electrode is switched to RE Direct and/or CE Direct. 

When J6 is also ON, the potential is applied to all working electrodes continuously. 

* IMPORTANT REMARK 
It is not possible to apply a potential simultaneously to more 
than one sensor or cell each with three electrodes. This requires 
a multi-channel potentiostat, one potentiostat for each channel. 
This is however possible with two electrode sensors or cells, so 
when combined counter and reference electrodes are applied. 

15.2 MUX16 multiplexer 
The MUX16 multiplexer is used with 2 electrode sensors or cells up to 16 channels. It can have a 
shared counter and reference electrode, or each working electrode with each its own 
combined reference/counter electrode. 

15.2.1 Functional diagram 

The figure below shows the functional diagram of the MUX multiplexer. 
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15.2.2 Cell connector pin-out 

The connector on the MUX16 circuit board and the DSUB connector have the pinout as shown 
in the figure below. 

 

Figure 329 MUX16 multiplexer cell connector pin-out 

15.2.3 Specifications 

The following table shows the main specifications of the MUX16 multiplexer. 

Table 22 MUX16 multiplexer specifications 

Number of channels 2-16 

Multiplexer modes Sensorarrays with up to 16  working electrodes all sharing the 
same counter and same reference electrode 

Sensorarrays with up to 16 eight working and the same 
combined reference/counter electrode  

Sensorarrays with up to 16 working electrodes, each with its 
own combined reference/counter electrode  

On resistance WE channels: 2 Ω typical  

Leakage current 10 pA typical at 25 ºC 

Charge injection 20 pC typical 

Connections Shielded flat cable, with stripped end leads or 
by means of the MUX16 Connection Terminal (in shielded 
housing) 

16x WE 

1x CE 

1x RE 

RE and CE can be connected together  
and in this case connected to up to 16 combined CE/RE 
electrode 

analog ground for shielding 
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Dimensions of PCB 76 x 74 mm 

 

15.2.4 Sensor configurations 

 

Figure 330 Jumpers on the MUX16 circuit board 

 

 

Figure 331 Switches at the bottom of the MUX16 

Possible sensor configurations are: 

1 Sensorarrays with up to 16 working and 16 combined reference/counter electrodes  

2 Sensorarrays with up to 16 working electrodes all sharing a reference and a counter 
electrode  

3 Sensorarrays with up to 16 working electrodes sharing a combined reference/counter 
electrode  

So the sensor configuration with 16 WE’s all having their own reference and separate counter 
electrode is NOT applicable with the MUX16 multiplexer. 

In these configurations the sensors or electrodes can be multiplexed, leaving the not-selected 
sensors at open circuit when J3 in not ON. 

J3 is ON when the potential has to be applied to all working electrodes simultaneously. 
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15.2.5 Jumpers / switches 

J1: RE to CE  

Connects the CE and RE leads when ON. Use J1 when only a combined CE and RE is 
applied. An alternative is to leave J1 OFF and always connect both the CE and RE leads 
to your RE/CE electrode. 

J2: Active 

 Leave ON 

J3: (unselected WE) to AGND  

Keeps all WE’s at applied potential when ON. If OFF only the selected WE has an applied 
potential leaving not-selected WE’s at open circuit. 

J4: (unselected WE) to standby potential 

 Leave OFF 

15.2.6  Recommended settings for the available configurations 

- Conf. 1:  Sensor array with up to 16 working and 16 combined reference/counter 
electrodes: 

o Jumpers to be ON: J1 and J2 

When J3 is also ON, the potential is applied to all working electrodes continuously. 

(Use pin 1, 3, 5 …. to 31 of the cell connector to connect all combined RE/CE 
electrodes.) 

- Conf. 2: Sensor array with up to 16 working electrodes all sharing one reference and 
one counter electrode: 

o Jumper to be ON: J2 

When J3 is also ON, the potential is applied to all working electrodes continuously. 

Use pin 1, 5, 9, 13, 17, 21, 25 or 29 of the cell connector to connect RE. 

Use pin 3, 7,11, 15,18, 23, 27 or 31 of the cell connector to connect CE. 

- Conf. 3: Sensor array with up to 16 working electrodes all sharing one combined 
reference/counter electrode: 

o Jumpers to be ON: J1 and J2 

When J3 is also ON, the potential is applied to all working electrodes continuously. 

Use pin 1, 3, 5….. to 31 of the cell connector to connect RE/CE. 

 

* IMPORTANT REMARK 
It is not possible to apply a potential simultaneously to more 
than one sensor or cell each with three electrodes. This requires 
a multi-channel potentiostat, one potentiostat for each channel. 
This is however possible with two electrode sensors or cells, so 
when combined counter and reference electrodes are applied. 





PSTrace Manual » MUX8-R2 multiplexer 

PSTrace Manual 275 

16 MUX8-R2 multiplexer 

The MUX8-R2 multiplexer can be used to expand a PalmSens3, PalmSens4, EmStat4X, EmStat3 
Blue or EmStat3+ Blue potentiostat.  
The multiplexer allows to increase productivity by automatically switching between multiple 
electrochemical cells each with their own WE, RE and CE electrodes. Additionally, it can be 
employed to automatically switch the active Working Electrode (WE) within a cell containing 
multiple WEs, while utilizing a shared RE/CE. 
The MUX8-R2 model has replaced both the MUX8 and MUX16 models. This new version 
incorporates a new feature of electronic switching, enabling sensor configurations (such as the 
combination or merging of channel leads) through software, eliminating the need for manual 
switchers or jumpers. 

 

Figure 332 PalmSens4 connected to MUX8-R2 multiplexer 

The MUX8-R2 multiplexer is designed for up to 128 channels (by stacking a maximum of 16 
MUX8-R2’s) with 2- or 3- electrode sensors or cells.  
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16.1 MUX8-R2 functional diagram 
The figure below shows the functional diagram of the MUX multiplexer. 

 

 

Figure 333 Functional diagram of the MUX8-R2 multiplexer 

16.2 Specifications 
The following table shows the main specifications for the MUX8-R2 multiplexer. 

Table 23 MUX8-R2 specifications 

number of channels 8 (up to 128 channels when daisy chained) 

multiplexer switches 8 x (WE, S, RE and CE) 

on resistance for WE  1.5 Ω typical 

charge injection on WE 20 pC typical 

leakage current < 20 pA (5 pA typical) at 25 ºC 

switching time 2 ms 

compliance voltage ±10 V 

max. frequency for EIS 100 kHz when switching WE/S, RE and CE 
1 MHz when switching WE/S and RE+CE combined (2-
electrode configuration) 

16.3 Configurations 
The MUX8-R2 multiplexer is designed for use up to 128 channels with 2- or 3- electrode sensors 
or cells. 

The multiplexer can be used with different electrode or sensor configurations: 

1 Eight separate cells or sensors each with a working/sense, reference and counter 
electrode. 

2 Eight separate cells or sensors each with a working/sense and combined 
reference and counter electrode. 
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3 Cell or sensor array with eight working/sense electrodes sharing one reference 
and one counter electrode. 

4 Cell or sensor array with eight working/sense electrodes sharing one combined 
reference/counter electrode. 

 

In all configurations the cells can be multiplexed, leaving the non-selected working electrodes 
either at open circuit (individually floating) or at Ground potential. 

When in configurations 3 and 4, the unselected channels are switched to Ground, they will have 
the working electrode’s potential. This is due to the fact that the active WE is always at Ground 
potential. 

You can easily change the hardware configuration of the MUX8-R2 as part of the measurement 
settings in our PSTrace software or the PStouch app for Android.  

 
 

 

Figure 334 The MUX8-R2 multiplexer settings can be changed in the Multiplexer tab. 

16.4 Connections 
The table below shows which connectors are available on the MUX8-R2 for making connections 
to the instrument, cell or other MUX8-R2 multiplexers. 

Table 24 MUX8-R2 available connectors 

Connector Function 

Input Y-cable connects to both potentiostat sensor connector and (digital) 
AUX 

AUX Can be used to measure auxiliary input like temperature or pH, and 
to switch external hardware using two digital control lines that can be 
set in PSTrace 

Link Connects to Input of next multiplexer, for daisy-chaining multiple 
multiplexers. 
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USB-C For providing extra power in case more than 2 multiplexers are 
connected to a single instrument. 

Channel 1-4 Connects to sensor cables 1-4 

Channel 5-8 Connects to sensor cables 5-8 

 

16.5 MUX8-R2 Pin-outs 

(male front view) 

The table below shows the pin-out for channel 1-4. 

Table 25  Channel 1-4 connector pin-out 

Pin Function  Pin Function  Pin Function 

1 CE4  11 RE1  21 AGND 

2 RE4  12 RE_SHIELD1  22 SENSE2 

3 RE_SHIELD4  13 NC  23 WE1 

4 CE3  14 WE4  24 AGND 

5 RE3  15 AGND  25 SENSE1 

6 RE_SHIELD3  16 SENSE4  

7 CE2  17 WE3  

8 RE2  18 AGND  

9 RE_SHIELD2  19 SENSE3  

10 CE1  20 WE2  

(male front view) 

The table below shows the pin-out for channel 5-8. 
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Table 26  Channel 5-8 connector pin-out 

Pin Function  Pin Function  Pin Function 

1 CE8  11 RE5  21 AGND 

2 RE8  12 RE_SHIELD5  22 SENSE6 

3 RE_SHIELD8  13 NC  23 WE5 

4 CE7  14 WE8  24 AGND 

5 RE7  15 AGND  25 SENSE5 

6 RE_SHIELD7  16 SENSE8  

7 CE6  17 WE7  

8 RE6  18 AGND  

9 RE_SHIELD6  19 SENSE7  

10 CE5  20 WE6  

 

  



PSTrace Manual » MUX8-R2 multiplexer 

280 PSTrace Manual 

16.5.1 AUX port 

The diagram below shows the connections available in the auxiliary (AUX) port.  

   

Figure 335 Auxiliary port pin out 

The lead colors in the table below correspond to the standard cable PalmSens provides for use 
with the auxiliary port. 

Table 27 Auxiliary port pin assignment and corresponding lead color 

Ring Lead color Function 

1 Red NC 

2 Black D0 (digital I/O) 

3 Yellow Analog Input 

4 White D1 (digital I/O) 

5 Green GND 

6 Blue 5V 

16.6 Stacking multiple MUX8-R2 
Each multiplexer has a Link connector which can be used to daisy chain to another MUX8-R2 
multiplexer, expanding the number of channels. A maximum of 16 multiplexers can be 
connected in a daisy chain, giving a maximum of 128 channels.  

The PSTrace software detects automatically how many multiplexers are daisy chained and 
shows the available number of channels in the user interface.  

When in configurations 3 and 4, the RE/CE be connected to the CH1 of the first Multiplexer. 

 

Figure 336 The MUX8-R2 has magnetic feet and magnets in the top for easy stacking. 
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17 PalmSens1 and PalmSens2 

 

Figure 337 PalmSens1 and PalmSens2 have the same appearance. 

17.1 Description 
The PalmSens1 (PS1) and PalmSens2 (PS2) are both a hand-held battery powered instrument for 
use with electrochemical sensors or electrochemical cells. The instrument is a low noise and 
low-current potentiostat and galvanostat which controls the potential or current applied to the 
sensor and measures the current or potential response.  

The suffix “1” or “2” refers to its generation and is not present in the instrument label. 

The PalmSens1 and 2 are very similar. The PalmSens1 can be identified having a serialnumber 
between PS0201 to PS04200. The main visible difference compared to the PalmSens1 is the 5V 
DC-input port (barrel connector) present on the PalmSens2 for charging, whereas the 
PalmSens1 is charged through a mini-DIN connector. 

17.2 Operating 
The instrument connects to a PC using its serial RS-232 connector which is found behind the lid. 
See next section for more information about using a serial to USB adapter cable. 

Do not use a screwdriver or tool to open the lid! 

Open the lid at the left-hand side of the PalmSens by pressing the hinge upwards and then 
turning the lid in a single action. 
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Figure 338 Opening the lid of PalmSens1 or 2 

Before the PalmSens is used without the adapter, the batteries must be charged. Connect the 
adapter to the miniDIN-connector (PS1) or dc-in connector (PS2). Switch on the PalmSens by 
pressing the power key until the display shows: “Selftest”. During the self-test the voltage range 
of the instrument is tested and shown. The normal range for PalmSens is approx. –2.035 V to 
+2.047 V. 

After the test the display will show:  

 

> PalmSens              Vs. #.# 
E= #.### V 
        
FsChg                  

Figure 339 Default contents of the PalmSens1 and 2 LCD 

For every reading during idle mode, the < > sign in the upper left corner flips to indicate the 
instrument is actively running. 

If the display shows the text “FsChg”, the batteries are being charged. 

As soon as the display shows “PwrOK”, the batteries are full and the adapter can be 
disconnected. The batteries have to be recharged as soon as “LowBat” is shown and the 
corresponding beep is heard. 

The PalmSens can be used with the adapter connected and the batteries charged. The adapter 
however might increase the noise level. 

The backlight of the LCD is switched on and off by using the key ▲. Please note that the 
backlight will reduce the battery-lifetime of the PalmSens from approx. 8 hours to not more 
than 6 hours. 

The PalmSens is switched off by pressing and holding the power key for a few seconds until the 
display shows “Shutting down”. 

17.2.1 Cell connections 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

17.2.2 Keypad 

During the conditioning, deposition, and equilibration stage two keys of the keypad are active. 
When the stop button is pressed the measurement is ended. The skip key is used to step to the 
next stage. During a measurement only the ESC or ■ key is active. 



PSTrace Manual » PalmSens1 and PalmSens2 

PSTrace Manual 283 

17.3 Using a USB to serial converter 
When using a USB – RS232 adapter, ensure that the adapter's driver is installed in accordance 
with the adapter's manual. The COM number used can be identified in Windows’ Device 
Manager. 

It is crucial to note that a null-modem adapter (female-female) is required between the cable 
and PalmSens when using this adapter. Attempting to connect the PS1 or PS2 directly to a 
standard USB to Serial COM adapter (or with a direct pin-to-pin adapter) will not be successful.  

To open the Device Manager quickly, simultaneously press the Windows key  and the 
Pause/Break key on the keyboard of your computer. Click the Hardware tab, and then click 
Device Manager. The installed COM port and its number are listed under Ports. Specify the 
corresponding COM port in PSTrace before connecting. 

 

 

Figure 340 Make sure the right COM port is used in PSTrace 

17.4 Auxiliary port pin-out 
The following picture and table show the PalmSens1 and PalmSens2 auxiliary port pin-out and 
function descriptions. 

 

 

 

Figure 341 Front view of female port (mini-DIN) 

Table 28 PalmSens1 and PalmSens2 auxiliary port pin-out 

Pin Function 

1 PalmSens1 (serial numbers PS0201 to PS04200):  
Vadapter (6 V- 1.5 A)  
PalmSens2 (serialnumbers PS04201 and higher): d3 digital output  
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2  analog ground 

3 d0 digital output * 

4 d1 digital output *  

5 d2 digital output * 

6 d0 digital input * 

7 auxiliary analog input 0 V - 4.096 V 

8  auxiliary analog output 0 V - 4.096 V 
> 10 kOhm advised resistive load on output 

9 5 V digital power line (maximum current 100 mA) 

shield  digital ground 

* The digital input has a maximum voltage rating of -0.3 V to 5.3 V. The digital outputs have a 
maximum current rating of 5 mA, source or sink. 

17.5 Cell connector pin-out 
The following schematics show the PalmSens1 and PalmSens2 cell connector pin-out. 

 

Front view of male plug on cable:  

 

Front view of female connector on instrument: 

 

Table 29 Cell connector pins 

Pin Function Connector 
color 

1 Working Electrode (WE) Red 

2 Analog Ground (AGND) Green 

3 Working Electrode 2 / BiPot (WE2) 
(if BiPot module is installed) 

Yellow 

4 Counter / Auxiliary Electrode (CE) Black 

5 Reference Electrode (RE) Blue 

17.6 Specifications 
The following tables show the main specifications of the PalmSens1 and PalmSens2. 

Table 30 PalmSens1 and PalmSens2 specifications 

Potentiostat (controlled potential mode) 

dc-potential range ± 2.000 V 
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compliance voltage ± 8.0 V  

dc-potential resolution 1 mV 

dc-offset error 2 mV  

accuracy ≤ 0.2 %  

ac-potential amplitude 1 mV to 250 mV 

current ranges 1 nA to 10 mA (8 ranges) 

maximum current ± 10 mA 

current resolution 0.1 % of current range 

1 pA on lowest current range 

accuracy ≤  0.2 % of current range at 100 nA to 1 mA 

≤  0.5 % at 10 nA   and ≤ 1 % at 1 nA 

all with additional 0.2 % offset error 

 

Galvanostat (controlled current mode) 

current ranges 1 μA to 1 mA  

dc-current range  -2 to + 2 times selected current range 

dc-current resolution 0.1 % of selected current range 

dc-offset error ≤  0.2 % 

current accuracy  ≤  0.4 % 

maximum output voltage ±  8 V 

 

General 

electrometer amplifier input > 100 Gohm // 4 pF 

rise time approx. 50 μs 

Keypad ▲►▼◄ ENTER ESC and Power (7 keys) 

Display 4 lines of 16 characters with backlight 

Dimensions 155 mm x 85 mm x 35 mm 

Temperature range 0º C to + 40º C 

Weight 0.43 kg 

Power 2 AA cells NiMH 2500 mAh for > 8 hours operation. 

Battery charger included (6 V- 1500 mA) 

Interfacing Serial RS232  

Default serial mode: 57600 baud, 8 bits data, no parity, 1 
stopbit. 

 

17.7 BiPot specifications 
The table below shows the specifications of the optional Bipotentiostat module for PalmSens1 
and PalmSens2. 
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Table 31 PalmSens1 and PalmSens2 BiPot specifications 

General 

dc-potential range ± 2.000 V 

dc-potential resolution 1 mV 

dc-offset error 3 mV  

accuracy ≤ 0.3 %  

current ranges 1 nA to 10 mA (8 ranges) 

maximum measured current ± 10 mA 

current resolution 0.1 % of current range 

1 pA on lowest current range 

accuracy ≤  0.3 % of current range at 1 µA to 100 µA 

≤  0.5 % at 100 nA   and ≤  1 % at 10 and 1 nA 

all with additional 0.2 % offset error 

connection Use requires a cable with additionally a (yellow) 
connector for WE2 

17.8 Offset calibration 
When connected to a PalmSens1 or 2, a button for calibrating offsets can be found In PSTrace in 
the menu: ‘Tools’ → ‘Instrument Settings’ → button: ‘Calibrate Offsets’. 

Offset calibration can be done when the measured potential differs more than 0.3% +/- 0.003 
V from the specified potential (when the cell is switched on in E control mode).  

17.9 Battery replacement 
   

This section does not apply to the PalmSens3 or PalmSens4!  
A PalmSens1 or PalmSens2 has a GREEN display. 

 

 

Necessary tools: 
Size 14 spanner 
Phillips or TORX T-10 screwdriver 
Flat screwdriver 
Pointy tool 
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Step 1 

 

Untighten the bolt very carefully with the spanner, 
without scratching the surface of the housing. 
 
Screw it off using your fingers. 
 

 

Step 2 

 

If present remove the two protective caps using 
the pointy tool by sticking it between the cap and 
housing and levering it out.   
 

 

Step 3 

 

Remove the sensor side of the housing. 
 

 

Step 4 

 

Pull out the battery connector using the tongs. 
 
Replace the battery and connect it to the printed 
circuit board. 
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Step 5 Closing the housing 

 

1. Place the ring back over the sensor connector and screw the sensor side of the housing 
back on. 

Do not use too much force while screwing, this may cause the 
screw to slip or break! 

 

2. Place the nut back onto the sensor connector and screw it using your fingers as fixed 
as you can. Then tighten the nut by turning it one quarter more using the spanner. 
Tightening it too much will damage the housing. 

3. If available put the protective caps in place. 
4. New batteries may be empty, so first connect PalmSens to the ac-adapter and charge 

the batteries completely. 
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18 PalmSens3 

 

Figure 342 PalmSens3 

18.1 Description 
The PalmSens3 is a hand-held battery powered instrument for use with electrochemical sensors 
or electrochemical cells. The instrument is a low noise and low-current potentiostat and 
galvanostat which controls the potential or current applied to the sensor and measures the 
current or potential response.  

The PalmSens3 was on the market between 2013 and 2016. The main difference compared to 
the PalmSens1 and 2 are much faster ARM microcontroller and FRA capabilities for 
Electrochemical Impedance Spectroscopy (EIS). The EIS capability was offered as a separate 
option. 

18.2 Operating 
The instrument connects to a PC using its mini-USB port which is found underneath the lid.  

Do not use a screwdriver or tool to open the lid! 

Open the lid at the left-hand side of PalmSens by pressing the hinge upwards and then turning 
the lid. 
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Figure 343 Instructions for opening the lid at the side of the PalmSens3 

 

 

Power button 

PalmSens3 is switched on by pressing and holding the power button. 
If a PalmSens3 Bluetooth extension is used, make sure the Bluetooth 
extension is connected to the PalmSens3 auxiliary port BEFORE turning it 
on. PalmSens3 will detect any extensions during start-up. 
PalmSens3 is switched off by pressing the power button twice.  If PalmSens3 
is not responding, press and hold the power button for a few seconds to 
force it to switch off. 
 

 

Backlight button 

The backlight of the LCD is switched on by using the backlight button next 
to the power button. Please note that the backlight will reduce the battery-
lifetime of PalmSens3.  
The backlight is turned off automatically after a while.  
 
 

 

Charging icon 

PalmSens3 is always charging when connected to a USB port. When 
charging the red battery icon will light up.  
 

 
 

Stop button 

Pushing the stop button will abort any running measurements immediately. 
If the instrument is in ‘fast mode’ it will return to normal mode. 

 
 

Start button 

No use in PSTrace. 

 

Skip button 

This button can be used to skip pretreatment stages and proceed to the 
next stage.  
See also section. Standard measurement sequence on page 32. 
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The PalmSens3 cell connector is a push-pull connector.  
Do not try to twist it! 

18.2.1 Cell connections 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

18.3 Auxiliary port pin-out 
The following picture and table show the PalmSens3 auxiliary port pin-out and function 
descriptions. 

 

Figure 344 The front view of the female port (DE-15) 

Table 32 PalmSens3 auxiliary port pins 

Pin Function 

1 d0 digital output  (5V) 

2  d3 digital output (5V) 

3 auxiliary analog input  
(>0.5 Mohm input inpedance) 

4 Rx (TTL default, or RS232 see pin 12) 

5 Tx (TTL default, or RS232 see pin 12) 

6 d1 digital output (5V) 

7 d0 digital input (5V) 

8  I out (V in current range) 

9 5 V digital power line  
(max.  50mA) 

10 digital ground 

11 d2 digital output (5V) 

12 Connect to pin 10 (DGND) for  
RS232 comm on pin 4 and pin 5 

13 E out (-5 to +5V) 

14 analog ground 

15 DAC out (0-3V) 

Connector 
housing 

digital ground 
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18.4 Cell connector pin-out 
The following schematics show the PalmSens3 cell connector pin-out. 

 

Front view of male plug on cable:  

   

Front view of female connector on instrument: 

 

Table 33 Cell connector pins of the PalmSens3 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Counter / Auxiliary Electrode (CE) Black 

3 Working Electrode 2 / BiPot (WE2) 
(if BiPot module is installed) 

Yellow 

4 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

 

18.5 Specifications 
The following tables show the main specifications of the PalmSens3. 

Table 34 PalmSens3 specifications 

Potentiostat (controlled potential mode) 

dc-potential range ± 5.000 V 

compliance voltage ± 8.0 V 

dc-potential resolution 0.15 mV 

applied potential accuracy ≤ 0.2 %  
with max. 2 mV offset error 

current ranges 100 pA to 10 mA (9 ranges) 

maximum measured current ± 30 mA (typical) 

current resolution 0.01 % of current range 

accuracy ≤ 1 % of current range at 1 nA (≤  5 % at 100 pA) 
≤ 0.5 % at 10 nA 
≤ 0.2 % at 100 nA to 1 mA 
≤ 0.5 % at 10 mA  
all with max. 0.2 % offset error 

max. acquisition rate 200 000 data points/s 
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Galvanostat (controlled current mode) 

current ranges 1 μA to 10 mA 

dc-current range ± 3.000 times selected current range 

dc-current resolution 0.01 % of selected current range 

max. dc-offset error ≤ 0.2 % 

current accuracy (deviation) ≤ 0.4 % 

maximum output voltage ± 8 V 

 

Impedance measurements 

frequency range 100 µHz to 50 kHz 

ac- amplitude range 1 mV  to 0.25 V (rms) 

 

General 

electrometer amplifier input > 100 Gohm // 4 pF 

rise time programmable from min. 0.5 μs 

 

Other 

keypad run, skip, abort, backlight and power 

housing aluminium: 155 mm x 85 mm x 35 mm 

weight 430 g 

temperature range 0º C to + 40º C  

power supply USB or internal Li-ion battery 

battery time >9 hours idle time with Bluetooth extension 

communication USB 

 

18.6 BiPot specifications for PalmSens3 
The table below shows the specifications of the optional Bipotentiostat module for PalmSens3. 

Table 35 PalmSens3 BiPot specifications 

General 

dc-potential range ± 5.000 V 

dc-potential resolution 0.15 mV 

dc-offset error 3 mV  

accuracy ≤ 0.3 %  

current ranges 1 nA to 10 mA (8 ranges) 

maximum measured current ± 10 mA 

current resolution 0.01 % of current range 

0.1 pA on lowest current range 
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accuracy ≤  0.3 % of current range at 1 µA to 100 µA 

≤  0.5 % at 100 nA   and ≤  1 % at 10 and 1 nA 

all with additional 0.2 % offset error 

connection Use requires a cable with additionally a (yellow) 
connector for WE2 

 

18.7 Replacement of PalmSens1 or PalmSens2 battery  
   

This section does not apply to the PalmSens3 or PalmSens4!  
A PalmSens1 or PalmSens2 has A GREEN display. 

 

 

Necessary tools: 

• Size 14 spanner 

• Phillips or TORX T-10 screwdriver 

• Flat screwdriver 

• Pointy tool 

 

Step 1 

 

Untighten the bolt very carefully with the spanner, 
without scratching the surface of the housing. 

 

Screw it off using your fingers. 
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Step 2 

 

If present remove the two protective caps using the 
pointy tool by sticking it between the cap and housing 
and levering it out.   

 

Step 3 

 

Remove the sensor side of the housing. 

 

 

Step 4 

 

Pull out the battery connector using the tongs. 

 

Replace the battery and connect it to the printed circuit 
board. 

 

 

Step 5 Closing the housing 

5. Place the ring back over the sensor connector and screw the sensor side of the housing 
back on. 

Do not use too much force while screwing, this may cause the 
screw to slip or break! 

6. Place the nut back onto the sensor connector and screw it using your fingers as fixed 
as you can. Then tighten the nut by turning it one quarter more using the spanner. 
Tightening it too much will damage the housing. 
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7. If available put the protective caps in place. 
8. New batteries may be empty, so first connect PalmSens to the ac-adapter and charge 

the batteries completely. 
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18.8 EIS Calibration for PalmSens3 

Follow the instructions of this section only if your PalmSens3 has 
EIS capabilities. 

After the PalmSens3 has been restored it is advised to run the EIS calibration procedure.  

To do this open PSTrace. Then go to menu: ‘Tools’→ ‘Instrument settings…’ and click the 
“Calibrate for EIS” button. 

Follow the instructions on the screen. 

A normal calibration procedure takes about 5 minutes. 

18.9 Offset calibration 
When connected to a PalmSens3, a button for calibrating offsets can be found In PSTrace in the 
menu: ‘Tools’ → ‘Instrument Settings’ → button: ‘Calibrate Offsets’. 

Offset calibration can be done when the measured potential differs more than 0.3% +/- 0.003 V 
from the specified potential (when the cell is switched on in E control mode).  

18.10 Performing a hard reset 

Please use this procedure only if your PalmSens3 shows a blue 
screen without characters when turning on:  
 

 

18.10.1 Follow these steps to restore your PalmSens3: 

1. Open the Update Firmware window form the main menu in PSTrace: 

‘Tools’ → ‘Instrument Settings…’ → ‘Update Firmware’ 

2. Make sure the USB cable is connected and PalmSens3 shows in the list next to the 
‘Connect’ button. 
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3. Click the ‘Connect’ button: 

 
 

 

Figure 345 Connect button 

4. The program will say “Could not connect properly.” Ignore this. 

5. Click the ‘Browse’ button. 

 
 

 

Figure 346 Browse button 
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6. Select a .HEX file with the signature PalmSens3_firmware_v##.hex. Where ## is the 
version number.  

7. Click the button ‘Start update firmware’. 

8. The firmware will be restored: 

 
 

 

Figure 347 Firmware update progress window 

Normally it takes only a few minutes to download new firmware 
to the PalmSens3.  
If the update procedure does not start or something is still 
wrong contact PalmSens BV by email: info@palmsens.com 

18.11 Battery replacement 
 

Required tools: 

▪ Torx T10 screw driver + small flathead screw driver 

▪ Blue Lemo tool (DCH.91.121.PA-ND) for the sensor connector nut: 

  

Figure 348 Lemo tool 
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Using another tool (i.e. pliers) will probably scratch the cell cable 
connector. 

Step 1 

 

Remove the LEMO nut using the special LEMO 
tool. 

 

Step 2 

 

Remove both Torx screws 

 

Step 3 

 

Replace the battery.  
The black tape around the end works as a strain 
relief.  
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Step 4 

 

Make sure the grounding rings are place correctly 
before placing the side panel back on. 

 

Step 5 

 

Screw the sensor side panel to the housing. Make 
sure to tighten the screws. 
Tighten the LEMO nut firmly, but do not use too 
much force. 
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19 PalmSens4 

 

Figure 349 PalmSens4 

19.1 Description 
The PalmSens4 is a hand-held battery powered instrument for use with electrochemical 
sensors or electrochemical cells. The instrument is a low noise and low-current potentiostat 
and galvanostat which controls the potential or current applied to the sensor and measures the 
current or potential response.  

The PalmSens4 is on the market since 2016. Main new features added to the PalmSens4, 
compared to the PalmSens3, includes a color display, internal storage and improved FRA for 
Electrochemical Impedance Spectroscopy (EIS). 

19.2 Operating 
Switch on the PalmSens4 by pressing the power button for a couple of seconds. 

A full charge of the PalmSens4 takes about 8 hours. 

The PalmSens4 can be used either on battery using a wireless Bluetooth connection or by 
connecting it via its USB-C port to a PC or Android device. The Bluetooth name of the 
instrument can be found on the bottom of the display when the instrument is idle. The 
Bluetooth identifier always starts with the letters PS, followed by the last 4 characters of its MAC 
address. For example: PS-6AEF.  

When connecting to the USB port of a PC, Bluetooth will switch off automatically unless there 
is a Bluetooth connection active. This allows the instrument to be charged via the PC while a 
Bluetooth connection is present. 

In case a pairing code is requested by the host (PC or Android device), use the pairing code 
1234. If you experience issues with the Bluetooth connection, see also section: Connecting 
using Bluetooth on page 14. 

Switch on the PalmSens4 by pressing the power button for a couple of seconds.  
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A full charge of the PalmSens4 takes about 8 hours. 

19.2.1 Cell connections 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

The PalmSens4 cell connector is a push-pull connector.  
Do not try to twist it! 

19.3 Display and power indicator 
The PalmSens4 has a color display and illuminated white ring around the power button to 
indicate the instrument is powered on.  

 

Figure 350 PalmSens4 display when in idle mode. 

In idle mode (not running a measurement), the display shows the following contents: 

▪ Firmware version 
▪ Connection status (Bluetooth or USB) 
▪ Battery status 
▪ Cell status (ON/OFF) 
▪ Potential controlled mode (PSTAT) or current controlled mode (GSTAT) 
▪ Potential readings (E) 
▪ Current readings (I) 
▪ Bluetooth name 
▪ Time 

For every reading during idle mode, the < > sign in the bottom left corner flips to indicate the 
instrument is actively running. 

The time is updated whenever the instrument connects to PSTrace (Windows) or PStouch 
(Android). The time is used together with the date for timestamping data on the internal 
storage.  
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19.4 iR Compensation 
The PalmSens4 iR Compensation module is an optional accessory available for the PalmSens4 
potentiostat. It needs to be ordered concurrently with the new instrument, or alternatively, it 
can be installed later at the factory. 

This module operates through Positive Feedback, achieved using a 16-bit MDAC in the module 
which scales the output of the current follower to provide a positive feedback voltage that is 
proportional to the current through the cell. The compensation voltage is added to the 
summing point before the control amplifier and thus increases (or decreases) the applied 
potential to counteract the iR drop. 

   

 

Figure 351 Simplified schematical representation of iR compensation circuitry in the 
PalmSens4 

 

Positive feedback allows for fast scan rates up to 10 V/s, depending on the characteristics of the 
cell. If the potential error to compensate for becomes close to the value set for E applied, the 
system might become unstable. Using iR compensation limits the measurement bandwidth to 
10 kHz. 

See also section: Ohmic (iR) compensation on page 46. 

19.5 Auxiliary port pin-out 
The following schematics and table show the PalmSens4 auxiliary port pin-out and pin 
functions. 
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Figure 352 The front view of the female port (DE-15) on the PalmSens4. 

 
 

Table 36 PalmSens4 auxiliary port pin functions. 

Pin Function 

1 d0 digital output (5V) 

2  d3 digital output (5V) 

3 auxiliary analog input -10 to +10 V,  
18 bit, >0.5 MΩ input impedance 

4 RESERVED 

5 RESERVED 

6 d1 digital output (5V) 

7 d0 digital input (5V) 

8  i monitor given as -V in active current range. 

9 5V digital power line  
(max.  300mA) 

10 digital ground 

11 d2 digital output (5V) 

12 RESERVED (NC) 

13 E out (-10 to +10V) 

14 analog ground 

15 analog out (0 to 10 V at 12 bit) ), 1 kΩ output impedance 

Connector 
housing 

digital ground 
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19.6 Cell connector pin-out 
The following schematics show the PalmSens4 cell connector pin-out and pin functions. 

             

Figure 353 Front view of the female Cell connector on the PalmSens4. 

Table 37 Cell connector pin functions. 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Reference Electrode Shield N/A 

3 Counter / Auxiliary Electrode (CE) Black 

4 Working Electrode 2 / BiPot (WE2) 
(if BiPot module is installed) 

Yellow 

5 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

 

The shield of the cable must make contact with the metal case of 
the sensors connector. 

19.7 Self Diagnostics 
PalmSens4 supports Self Diagnostics from firmware v1.8 and on. Check the PalmSens4 LCD or 
the Instrument Settings window in PSTrace to see which firmware version the instrument is 
running. The Self Diagnostics tool generates a report that gives a detailed overview the 
instrument’s functioning. This report can exported to a Word document and sent by email 
(info@palmsens.com) to PalmSens BV in case there’s doubt about the functioning of your 
PalmSens4. 

mailto:info@palmsens.com


PSTrace Manual » PalmSens4 

308 PSTrace Manual 

 

Figure 354 The Self Diagnostics window 

To run the Self Diagnostics tool go to the menu: ‘Tools’ → ‘Instrument Settings…’ and click the 
button Self Diagnostics. 

 

Figure 355 Menu ‘Instrument Settings’ found in ‘Tools’ 

 

 

Figure 356 The ‘Self Diagnostics’ button found in ‘Instrument Settings’ 
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19.8 Performing a hard reset 
The instructions in this section should be followed if the PalmSens4 is in a state where the LCD 
remains black after switching on and the instruments does not show up in the list with 
instruments in PSTrace or the Firmware Update program as “PalmSens4” or as “Programmable 
Device”. 

 
Follow these instructions only if the PalmSens4  
does not show as a “Programmable Device” in the device list. 
 

 
 
If it shows as “Programmable Device”, continue with Step 5. 

 

Required tools:  

▪ Screwdriver: Torx 8 

▪ Paperclip 

Step 1: Remove battery lid and battery 

 

Figure 357 PalmSens4 with the battery lid removed.  
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Step 2: Connect the PalmSens4 to USB 

Connect the PalmSens4 to your PC with the USB cable. Place the PalmSens4 up-side-down on 
your desk. 

Step 3: Short the two ‘Rst’ pads 

Bend the paperclip in such a way that you can short the two ‘Rst’ pads in the battery 
compartment, as shown in the photo below. 

 

Figure 358 Shorting the two ‘Rst’ pads on the PalmSens4 for recovery.  

Step 4: Unplug and plug back in 

Remove the USB cable from the PalmSens4, wait a few seconds and then connect the 
PalmSens4 back to the PC again.  

Step 5: Upload new firmware 

▪ Open PSTrace and go to menu: Tools → Instrument Settings… and click button 
“Update firmware”. 

 

 

Figure 359 PalmSens4 listed as ‘Programmable Device’ 

▪ You should see “Programmable Device” selected next to the “Connect” button.  

▪ Click “Connect” 

▪ Click “Browse” and select file “PalmSens4_firmware_v##.hex” 
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Figure 360 Verifying the loaded firmware and the button to start the update procedure. 

▪ Make sure the text shows it is firmware suitable for PalmSens4. 

Make sure the text shows the selected firmware is suitable for 
PalmSens4! 

▪ Click the button “Start update firmware”. 

 

Figure 361 The firmware upload progress window. 

 
▪ Wait until the Uploader gives the message “UPDATE COMPLETE” and close the 

window. 

Step 6: Place the battery 

Connect the 3000 mAh battery and place it in the battery compartment with the wires folded 
at the side of the battery.  
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Step 7: Close housing 

Put the lid and the gasket back in place and close the housing. Do not use excessive force when 
tightening the screws. 

 

19.9 Battery replacement 
Required tools:  

▪ Screwdriver: Torx 8 

Step 1: Open the battery compartment 

Unscrew the four screws and remove the battery lid and gasket. Then gently pull on the battery 
connector to disconnect it. 

 

Figure 362 PalmSens4 with the battery lid removed.  

Step 2: Place new battery 

Connect the new 3000 mAh battery as received from PalmSens BV and place it in the battery 
compartment with the wires folded at the side of the battery.  

Step 3: Close housing 

Put the lid and the gasket back in place and close the housing. Do not use excessive force when 
tightening the screws. 

19.10 Specifications 
The following tables show the main specifications of the PalmSens4. 

Table 38 PalmSens4 specifications 

General 

dc-potential range version PS4.F#.05 PS4.F#.10 

 ±5 V  ±10 V  
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compliance voltage ±10 V 

maximum current ±30 mA (typical) 

max. acquisition rate 150000 points/s 

 

Potentiostat (controlled potential mode)  

applied dc-potential resolution 75 µV 

applied potential accuracy ≤ 0.1%   ±1 mV offset 

current ranges 100 pA to 10 mA (9 ranges) 

measured current accuracy ≤ 0.1% at Full Scale Range 

measured current resolution 0.006% of current range (5 fA on 100 pA range) 

 

Galvanostat (controlled current mode) 

current ranges 1 nA to 10 mA (8 ranges) 

applied dc-current range ± 6 times applied current range 

applied dc-current resolution 0.005% of applied current range 

measured dc-potential resolution 75 µV at ±10 V (no gain) 
7.5 µV at ±1 V (gain 10) 
0.75 µV at ±0.1 V (gain 100) 

measured dc-potential accuracy  ≤ 0.05% or ±1 mV (for |E| < ±9 V) 
≤ 0.2% (for |E| ≥ ±9 V) 

 

FRA / EIS (impedance measurements)  

frequency range PS4.F1.## PS4.F2.## 

10 µHz to 100 kHz  10 µHz to 1 MHz 
 

ac-amplitude range 1 mV to 0.25 V rms, or 0.6 V p-p 

* Instruments with part number PS4.F0.## do not include EIS capability. 

 

Electrometer  

electrometer amplifier input > 1 TΩ // 10 pF 

bandwidth 1 MHz 

 

Other 

housing aluminium body with rubber sleeve:  
15.7 x 9.7 x 3.5 cm3 

weight +/- 500 g 

temperature range 0 ºC to +50 ºC  

power supply USB or internal LiPo battery 

communication USB and Bluetooth 
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battery 11.1 Wh capacity 
> 16 hours idle time  
(> 5 hours with BiPot installed) 
> 4 hours with cell on at max. current 
Extendible by means of power bank 

internal storage space 8 GB  
(or >100 million data points) 

19.10.1 EIS contour accuracy plot 

 

Figure 363 EIS contour accuracy plot for the PalmSens4  
Note: The accuracy contour plot was determined under lab conditions and should be used for 
reference purposes. Please note that the true limits of an impedance measurement are 
influenced by all components in the system, e.g. cables, the environment, and the cell. 
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20 EmStat instruments series 

 

Figure 364 The EmStat instrument series 

This section describes the housed models of the EmStat-series. The EmStat-series is also 
available in the form of modules (bare PCBs) for OEM purposes.  

▪ For more information about our products for OEM, please see the OEM section in 
our website. 

▪ See also section: EmStat Pico Based Instruments on page 347. 

20.1 EmStat-based instruments overview 
The EmStat instruments are used with electrochemical sensors or electrochemical cells with 
three or four electrodes: working electrode, reference electrode and auxiliary or counter 
electrode and sense electrode. In the so-called two-electrode configuration the counter and 
reference electrodes can be combined to a single electrode. In that case the counter and 
reference connectors are tied together.  

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

The EmStats are used in different hardware configurations. 
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20.1.1 EmStat Basic models 

 

Figure 365 EmStat3 and EmStat4S 

The basic models allow for powering and connecting via USB only. They are connected to the 
cell using a 1-meter cable with a high-end LEMO connector. A single multi-color LED gives an 
indication of the status of the instrument. 

20.1.2 EmStat Blue and EmStat4X 

  

Figure 366 EmStat3 Blue and EmStat4X LR 

The EmStat Blue and the newer EmStat4X models allow to connect via USB or Bluetooth. They 
have an integrated battery and an additional auxiliary port which can be used with a MUX8-R2 
multiplexer for example. The connection to the cell is either by means of a standard 1-meter 
cable with high-end LEMO connector or using the connector compatible with wide collection 
of screen-printed electrodes (SPEs). 

The EmStat4X also allows for iR compensation. 

20.1.3 EmStat4R 

 

Figure 367 EmStat4R 

The EmStat4R model has a ruggedized design, for use in the field. It allows to connect via USB 
or Bluetooth and has an integrated battery. The modular front-end can be exchanged for use 
with either a standard 1-meter cable with high-end LEMO connector or a connector 
compatible with a wide collection of screen-printed electrodes (SPEs). This instrument is also 
available for OEM with options for a tailored front-end to match a specific electrode form 
factor. 
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20.1.4 Multiplexer-integrated EmStat models 

 

Figure 368 EmStat3-MUX8 

The EmStat-modules up to 3 (and 3+) were offered in combination with the MUX8-R2 
multiplexer integrated in a single housing as “EmStat MUX”. This instrument is powered and 
communicates via its USB port. Cell connections are made with eight 1-meter high-end cell 
cables divided in two sets of 4-cables which connect to two DSUB-25 connectors.  

Refer to the respective Potentiostat and/or Multiplexer model(s) for more details. 

20.1.5 Multi-channel EmStat models 

The EmStats can also be configured as MultiEmStat where a single instrument contains 4, 8 or 
12 individual EmStat modules. These instruments can be controlled simultaneously or 
individually in a single overview with MultiTrace for Windows. Only one channel at a time can 
be controlled in a PSTrace instance. 
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21 EmStat1 and EmStat2 

 

Figure 369 EmStat1 (right) and EmStat2 (left) 

21.1 Description 
The EmStat1 and 2 are a USB-powered potentiostat-only devices. It means that these devices 
are specifically designed for potentiostatic applications and do not possess the capability to 
control currents, distinguishing them from galvanostats. The EmStat-series (Embedded 
potentioStat) are available in a standard shielded housing or as bare PCB. The EmStat 
communication protocols are well described and made available to allow users to embed the 
potentiostat as part in another system. The EmStat1 was enclosed in a blue/gray plastic 
enclosure, while the EmStat2 was enclosed in an aluminium enclosure. The EmStat1 and 
EmStat2 were sold from 2005 to 2012.  

With their reliable communication protocols and versatile form factors, the EmStat-series 
devices are well-suited for a variety of laboratory and research applications. 

21.2 Operating 
The EmStats1 and 2 are powered and controlled directly by means of a standard mini-USB cable. 
They do not have a power switch or any other type of switch. The cell cable connects to a TRIAD 
connector.  

21.2.1 Cell connections 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

21.3 Status LED indicators 
The EmStats1 and 2 have one or two single color LEDs. The first batch of the EmStat2 was 
produced without a cell LED. Later batches came with a power and cell LED. The red cell LED is 



PSTrace Manual » EmStat1 and EmStat2 

320 PSTrace Manual 

switched on automatically whenever the feedback loop is closed and current can flow through 
the cell. The green LED is on when the device is powered. 

21.4 Cell connector pin-out 
The following schematics show the EmStat1 and EmStat2 cell connector pin-out and pin 
functions. 

 

 

Figure 370 Front view of male plug on the cell cable. 

 

Figure 371 Front view of female plug on the EmStat1 and EmStat2. 

Table 39 Cell connector pins of the EmStat1 and EmStat2 

Pin Function Connector color 

1 Working Electrode (WE) Red 

2 Analog Ground (AGND) Green 

3 Reserved N/A 

4 Counter / Auxiliary Electrode (CE) Black 

5 Reference Electrode (RE) Blue 

 

21.5 Specifications 
The following tables show the main specifications of the EmStat1 and EmStat2. 

Table 40 EmStat1 and EmStat2 specifications 

General 

dc-potential range ± 2.000 V 

compliance voltage ± 4.5 V  

maximum output current ± 20 mA 

 

Potentiostat (controlled potential mode)  

dc-potential resolution 1 mV 

applied dc-potential accuracy
  

≤ 0.2 %  

max. dc-offset error 2 mV  

current ranges 1 nA to 100 µA (6 ranges) 
1 nA to 10 mA (8 ranges) for EmStat2 
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current resolution 0.1 % of current range 

1 pA on lowest current range 

current accuracy ≤  0.3 % of current range at 1 µA to 100 µA 

≤  0.5 % at 100 nA   and ≤  1 % at 10 and 1 nA 

all with additional 0.2 % offset error 

 

Electrometer 

electrometer amplifier input > 100 GΩ // 4 pF 

rise time approx. 200 μs 

 

Other 

dimensions EmStat1:  6.2 cm x 4.6 cm x (1.7 to 2.8 cm) 
EmStat2:  6.2 cm x 4.8 cm x (1.7 to 2.6 cm) 

power 5 V / 60 mA from USB connector (or ac-adapter ¹ ) 

communication USB 

 

21.6 Offset calibration 
When connected to a EmStat1 or EmStat2, a button for calibrating offsets can be found In 
PSTrace in the menu: ‘Tools’ → ‘Instrument Settings’ → button: ‘Calibrate Offsets’. 

Offset calibration can be done when the measured potential differs more than 0.3% +/- 0.003 V 
from the specified potential (when the cell is switched on in E control mode).  
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22 EmStat3 and EmStat3+  

 

Figure 372 EmStat3(+) 

22.1 Description 
The EmStat3 and EmStat3+ are a USB-powered potentiostat-only devices. This means that the 
EmStat3 and 3+ are not capable of controlling currents. The EmStat-series (Embedded 
potentioStat) are available in a standard shielded housing or as bare PCB. The EmStat 
communication protocols are well described and made available to allow users to embed the 
potentiostat as part in another system. The EmStat3+ allows for applying and measuring higher 
voltages and currents, compared to the EmStat3.  

The EmStat3 and EmStat3+ were sold from 2013 to 2022.  

With their reliable communication protocols and versatile form factors, the EmStat-series 
devices are well-suited for a variety of laboratory and research applications. 

22.2 Operating 
The EmStat3 and EmStat3+ instruments are powered and controlled directly by means of a 
standard mini-USB cable. They do not have a power switch or any other type of switch. The cell 
cable connects to the high-end LEMO connector.  

The EmStat3/3+ cell connector is a push-pull connector.  
Do not try to twist it! 

22.2.1 Sense lead 

The Sense lead of the EmStat3+ is only active when the 100 mA range is switched in. In case low 
current measurements are performed, it is advised to leave the Sense connector disconnected. 
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22.3 Status LED indicators 
The EmStat3 and 3+ have two single color LEDs. The red cell LED is switched on automatically 
whenever the feedback loop is closed and current can flow through the cell. The blue LED is on 
when the device is powered. 

22.4 Cell connector pin-out 
The following schematics show the EmStat3 and EmStat3+ cell connector pin-out and pin 
functions. 

 

Figure 373 Front view of male plug on the cell cable 

        

Figure 374 Front view of female plug on the EmStat3(+) 

Table 41 Cell connector pins of the EmStat3(+) 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Counter / Auxiliary Electrode (CE) Black 

3 Working Electrode Sense (Sense) 
(active in 100 mA only) 

Yellow 

4 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

22.5 Specifications 
The following tables show the main specifications of the EmStat3 and EmStat3+. 

 

Table 42 EmStat3 and EmStat3+ specifications 

 EmStat3 EmStat3+ 

dc-potential range  ± 3.000 V   ± 4.000 V  

compliance voltage ± 5 V  ± 8 V  

applied dc-potential 
resolution 

0.1 mV 0.125 mV 

applied potential 
accuracy 

≤ 0.2 %  
with max. 2 mV offset error 

≤ 0.3 %  
with max. 3 mV offset error 

current ranges 1 nA to 10 mA (8 ranges) 1 nA to 100 mA (9 ranges)  
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maximum measured 
current 

± 20 mA typical and  
± 15 mA minimum 

± 100 mA typical 

 

EmStat 3 and 3+ Potentiostat (controlled potential mode)  

current resolution 0.1 % of current range 

1 pA on lowest current range 

current accuracy ≤ 1 % of current range at 1 nA 

≤ 0.5 % at 10 nA  

≤ 0.2 % at 100 nA to 100 uA 

≤ 0.5 % at 1 mA, 10 mA and 100 mA 

all with additional 0.2 % offset error 

 

Electrometer / other 

electrometer amplifier 
input 

> 100 Gohm // 4 pF 

rise time approx. 200 μs 

 

EmStat 3 and 3+ regular model (not Blue) other specifications 

sensor connection shielded cable with circular connector for WE, RE, CE and 
Sense (100 mA for ES3+ only) 

housing anodized aluminium:  
6.7 cm x 5.0 cm x (1.9 to 2.8 cm) 

weight 85 g 

power supply 5 V, min. 130 mA (ES3) or  
500 mA (ES3+) via USB 

communication USB 

 

The EmStat3 Blue and EmStat3+ Blue models have an auxiliary port to control external 
accessories. See next section for more information. 

22.6 Offset calibration 
When connected to a EmStat3 or EmStat3+, a button for calibrating offsets can be found In 
PSTrace in the menu: ‘Tools’ → ‘Instrument Settings’ → button: ‘Calibrate Offsets’. 

Offset calibration can be done when the measured potential differs more than 0.3% +/- 0.003 V 
from the specified potential (when the cell is switched on in E control mode).  
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23 EmStat3 Blue and EmStat3+ Blue  

 

Figure 375 EmStat3(+) Blue 

23.1 Description 
The EmStat3 Blue and 3+ Blue incorporate the EmStat3 and 3+ potentiostat modules, 
respectively, with additional hardware for supporting Bluetooth connections, an auxiliary port 
and battery charging. 

The EmStat3 Blue and EmStat3+ Blue were sold from 2015 to early 2023.  

23.2 Operating 
The EmStat3 Blue and 3+ Blue are battery powered and therefore have a power button. Push 
and hold the button for two seconds to turn it on. Push and hold for 4 seconds to turn it off. 
Connection to the EmStat3 and 3+ Blue can either be made by means of the mini-USB port or 
by means of a Bluetooth connection. Press the power button briefly to turn Bluetooth off or to 
turn Bluetooth on again. 

The name of the Bluetooth device consists of the letters PS and the last four characters of the 
MAC address of the device. For example: PS-CA6F. The MAC address can be found on the 
battery lid of the instrument. 

The cell cable connects to the high-end LEMO connector. 

The EmStat3 and 3+ Blue cell connector is a push-pull connector.  
Do not try to twist it! 

23.2.1 Cell connections and Sense lead 

The Sense lead of the EmStat3+ is only active when the 100 mA range is switched in. In case low 
current measurements are performed, it is advised to leave the Sense connector disconnected.  
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See also section: Connecting a cell to the potentiostat on page 25. 

23.2.2 Connecting 

When connecting to the USB port of a PC, Bluetooth will switch off automatically unless there 
is Bluetooth a connection active. This allows the instrument to be charged via a PC while a 
Bluetooth connection is present. 

23.3 Status LED indicators 
The EmStat3 Blue and 3+ Blue has a keypad with icons and a power button and a red cell LED. 
The follow table explains the different states for the indicators. 

 

Table 43 Indicators on the EmStat3(+) Blue 

 

Power button 
Steady: instrument is on 

 

Bluetooth icon 
Blinking: ready to connect 
Steady: connected 

 

Battery icon 
Blinking red: battery low 
Blinking green: charging battery 
Steady green: battery fully charged 

Cell Steady red: cell is on 

 

23.4 Cell connector pin-out 
The following schematics show the EmStat3 Blue and EmStat3+ Blue cell connector pin-out and 
pin functions. 

 

Figure 376 Front view of male plug on the cell cable 

        

Figure 377 Front view of female plug on the EmStat3(+) Blue 

Table 44 Cell connector pins of the EmStat3(+) Blue 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Counter / Auxiliary Electrode (CE) Black 
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3 Working Electrode Sense (Sense) 
(active in 100 mA only) 

Yellow 

4 Working Electrode (WE) Red 

Connector housing Analog Ground (AGND) Green 

 

23.4.1 SPE connector 

An additional connector for Screen-Printed Electrodes is present at the front of the instrument. 
This connector supports the most common Screen-Printed electrodes that meet the following 
specifications:  

Table 45 Specifications of compatible SPEs 

Connection pads RE, WE, CE 

Pitch 2.54 mm (0.1”) 

Sensor thickness 0.1 to 0.8 mm 

Max. sensor width 11 mm 

Ceramic substrates can have very sharp edges that might 
damage the SPE connector. 

23.5 Auxiliary port pin-out 
The EmStat3 Blue and EmStat3+ Blue auxiliary connector has the following pin-out and pin 
functions. 

 

Figure 378 The front view of the female port (DE-15) 

Table 46 EmStat3(+) Blue auxiliary port pins 

Pin Function EmStat PCB pin  
(CON-PIN) 

1 d0 digital output (5V) 1-4 

2  d3 digital output (5V) 1-1 

3 auxiliary analog input  
( 0 – 4.095 V) 

2-9 

4 Rx (TTL comm) 2-2 

5 Tx (TTL comm) 2-1 

6 d1 digital output (5V) 1-3 

7 d0 digital input (5V) 1-4 

8  RESERVED - 
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9 5 V digital power line  
(max.  50mA) 

2-12 

10 digital ground 2-11 

11 d2 digital output (5V) 1-2 

12 RESERVED - 

13 RESERVED - 

14 analog ground 1-9 

15 DAC out (0-3V), 0.5Ω typical 2-10 

Connector 
housing  

digital ground - 

 

23.6 Specifications 
The EmStat Blue models have similar specifications as the regular EmStat3 and 3+, but they are 
extended with Bluetooth connectivity, a battery and auxiliary port. 

See: EmStat3 and EmStat3+ specifications on page 320 

 

Table 47 EmStat 3 Blue and 3+ Blue specifications 

housing anodized aluminium: 100 mm x 60 mm x (27 to 34 mm) 

weight 85 g 

power supply USB or internal Li-Po battery 
5 V, min. 130 mA (ES3) or 500 mA (ES3+) 

battery time > 8 hours with cell off 
> 5 hours with continuous cell on at 1uA current 
full charge takes approx. 3 hours 

communication USB or Bluetooth 

 



PSTrace Manual » EmStat4S 

PSTrace Manual 331 

24 EmStat4S  

 

Figure 379 EmStat4S LR (left) and EmStat4S HR (right) 

24.1 Description 
The EmStat4S LR and HR are a USB-powered potentiostat / galvanostat and impedance 
analyzers. The EmStat-series (Embedded potentioStat) are available in a standard shielded 
housing or as bare PCB. The EmStat communication protocols are well described and made 
available to allow users to embed the potentiostat as part in another system. 

With their reliable communication protocols and versatile form factors, the EmStat-series 
devices are well-suited for a variety of laboratory and research applications. 

The EmStat4S LR and HR are the market since 2021. They are the successor of the EmStat3 and 
EmStat3+ models. 

The EmStat4S comes in two different versions; the Low Range (LR) and High Range (HR) 
version.  

▪ Low Range: for lower currents and potentials. This version can be identified by its blue 
bottom shell. 

▪ High Range: for higher currents and potentials. This version can be identified by its 
black bottom shell. 

24.2 Operating 
The EmStat4S is powered and controlled directly by means of a standard USB-C cable. They do 
not have a power switch or any other type of switch. The cell cable connects to the high-end 
LEMO connector. 

The EmStat4S cell connector is a push-pull connector.  
Do not try to twist it! 
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24.2.1 USB Power Considerations for EmStat4S HR 

During measurements in the 100 mA range, the EmStat4S HR may demand more current than 
what is officially provided by standard USB 2.0 ports (5V at 500 mA). In cases where the available 
USB port cannot deliver 5V at 900 mA (or more), or if there is uncertainty about the power 
output of the USB port, it is essential to utilize the provided USB Y-cable with an additional USB 
port. This special cable configuration allows the instrument to draw additional power from a 
second USB port, ensuring optimal performance and accurate measurements. 

24.2.2 Sense lead 

The EmStat4 HR version comes with an additional Sense lead. In contrast with the EmStat3+, 
the Sense lead of the EmStat4S HR is active for every current range and should always be 
connected. This allows the Sense lead to be used in four-electrode measurements. 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

24.3 Status LED indicator 
The EmStat4S has a multi-color status indicator. The following table explains the meaning for 
each color. 

Table 48 EmStat4S status led indicator 

Color State 

Steady green Booting 

Steady blue Cell off (at open circuit) 

Steady red Cell on 

Blinking green Uploading new firmware 

Blinking orange Error state 

Blinking red Fatal error (not responding) 

 

24.4 Cell connector pin-out 
The EmStat4S LR and HR Lemo cell connector has the following pin-out and pin functions. 

      

Figure 380 Front view of male plug on the cell cable 

        

Figure 381 Front view of female plug on the EmStat4S 
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Table 49 Cell connector pin functions 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Reference Electrode Shield N/A 

3 Counter / Auxiliary Electrode (CE) Black 

4 Working Electrode Sense (Sense) Yellow 

5 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

 

24.5 Specifications 
The Emstat4S comes in two versions: LR (Low Range) and HR (High Range). The version of your 
EmStat4S can easily be recognized by the color of the bottom shell. The HR as a black bottom 
shell, and the LR has a blue bottom shell.  

The following table shows the main differences between the LR and HR versions. 

 

Table 50 EmStat4S LR and EmStat4S HR specifications 

 

 
EmStat4S LR 

 
EmStat4S HR 

Potential range ±3 V ±6 V 

Max. compliance 
voltage 

±5 V ±8 V 

Current ranges 1 nA to 10 mA (8 ranges) 100 nA to 100 mA (7 ranges) 

Max. current ±30 mA ±200 mA 

Electrode 
connections 

WE, RE, CE, 
and ground, 
2 mm banana plugs 

WE, RE, CE, S, 
and ground, 
2 mm banana plugs 

 

See the EmStat4S product page on our website for more detailed specifications. 
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25 EmStat4X 

  

Figure 382 The EmStat4X LR (left)  and EmStat4X HR (right) 

25.1 Description 
The EmStat4X LR and HR are on the market since 2023. They are the successor of the EmStat3 
Blue and 3+ Blue. Like the EmStat4S, the EmStat4X comes in two different versions: the Low 
Range (LR) and High Range (HR) version.  

▪ Low Range: for lower currents and potentials. This version can be identified by its blue 
bottom shell. 

▪ High Range: for higher currents and potentials. This version can be identified by its 
black bottom shell. 

25.2 Operating 
The EmStat4X is powered via USB-C or by its internal battery. The cell cable connects to the 
high-end LEMO connector. 

25.2.1 Cell connections and Sense lead 

The EmStat4 HR version comes with an additional Sense lead. In contrast with the EmStat3+, 
the Sense lead of the EmStat4S HR is active for every current range and should always be 
connected. This allows the Sense lead to be used in four-electrode measurements. 
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For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

The EmStat4X cell connector is a push-pull connector.  
Do not try to twist it! 

25.2.2 Switching on and off 

A single touch button next to the display can be used to switch the instrument on and off again. 
Put your finger on the button (no force needed) and hold it for a few seconds to turn in the 
instrument on. Do the same for turning the instrument off again. 

25.3 USB power and charging 
The EmStat4X can be used with any USB port. However not all USB-ports can provide enough 
power to prevent discharging the battery when using the EmStat4X HR at the highest current 
range. In order to prevent the EmStat4X HR battery to discharge when using the 100 mA range, 
please make sure to use the USB-C cable as provided connected to a USB-C port of the PC.  

The EmStat4X requires to be connected to a  
USB-C charger or host for charging with the maximum current of 
1A.  

When the EmStat4X is connected to a USB-C charger or host, charging the battery from 
depleted to full takes less than 3 hours. With the instrument being powered off or connected 
to another type of USB port, the charge current is maximum 500 mA.  

25.4 Display and status LED indicator 
The EmStat4X has a small display and a multi-color status indicator. The following table explains 
the meaning for each color. 

Table 51 EmStat4X status led indicator 

Color State 

Steady green Booting 

Steady blue Cell off (open circuit) 

Steady red Cell on 

Blinking green Uploading new firmware 

Blinking orange Error state 

Blinking red Fatal error (not responding) 
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25.4.1 Display 

The EmStat4X display shows the following information: 

▪ Battery status 
▪ Bluetooth identifier 
▪ Connection status 
▪ Firmware version during boot 

25.5 iR Compensation 
The EmStat4X iR Compensation module works using Positive Feedback. This is achieved using 
a 12-bit MDAC in the module which scales the output of the current follower opamp to provide 
a positive feedback voltage that is proportional to the current through the cell. The 
compensation voltage is added to the summing point before the control amplifier and thus 
increases the applied potential to counteract the iR drop. 

   

 

Figure 383 Simplified schematical representation of iR compensation circuitry in the 
EmStat4X 

Positive feedback allows for fast scan rates up to 10 V/s, depending on the characteristics of the 
cell. If the potential error to compensate for becomes close to the value set for E applied, the 
system might become unstable. Using iR compensation limits the measurement bandwidth to 
160 kHz. 
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See also section: Ohmic (iR) compensation on page 46. 

25.6 Auxiliary port pin-out 
The following schematics and table show the EmStat4X auxiliary port pin-out and pin functions. 

 

Figure 384 The front view of the female port (DE-15) 

Table 52 EmStat4X auxiliary port pins 

Pin Function 

1 d0 digital output (3.3 V) * 

2  d3 digital output (3.3 V) * 

3 auxiliary analog input -10 to +10 V, 16 bit, >0.5 MOhm input impedance 

4 RESERVED 

5 RESERVED 

6 d1 digital output (3.3 V) * 

7 d0 digital input (3.3 V) * 

8  i monitor given as V in active current range. 
(-5 to +5 V for LR and -8 to +8 V for HR) 
The following ranges give an output that is divided by 10. 
LR: 1 mA, 10 uA, 100 nA, 1 nA 
HR: 1 mA, 10 uA, 100 nA 

9 5V digital power line  
(max.  300mA) 

10 digital ground 

11 d2 digital output (3.3 V) * 

12 d4 digital input / output (3.3 V) *  
configurable through MethodSCRIPT 

13 E monitor, scaled to a voltage between 0 and 3 V,  
centered around 1.5 V, where: 
LR: VRE = -2.1 * (VAUX - 1.5) 
HR: VRE = -4.2 * (VAUX - 1.5) 

14 analog ground 

15 auxiliary analog out (0 to 6 V at 12 bit) 

Connector 
housing 

digital ground 

* All digital outputs have a 470 Ohm series resistance. 
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25.7 Cell connector pin-out 
The EmStat4X LR and HR Lemo cell connector has the following pin-out and pin functions. 

      

Figure 385 Front view of male plug on the cell cable 

        

Figure 386 Front view of female plug on the EmStat4X 

Table 53 Cell connector pin functions 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Reference Electrode Shield N/A 

3 Counter / Auxiliary Electrode (CE) Black 

4 Working Electrode Sense (Sense) * Yellow 

5 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

* Available for EmStat4X HR only 

25.8 SPE connector 
An additional connector for Screen-Printed Electrodes is present at the front of the instrument, 
for the version LR only. This connector supports the most common Screen-Printed electrodes 
that meet the following specifications:  

Table 18 Specifications of compatible SPEs 

Connection pads RE, WE, CE 

Pitch 2.54 mm (0.1”) 

Sensor thickness 0.1 to 0.8 mm 

Max. sensor width 10 mm 

Ceramic substrates can have very sharp edges that might 
damage the SPE connector. 
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25.9 Specifications 
The EmStat4X LR and HR models have similar specifications as the regular EmStat4S LR and HR, 
but they are extended with a display, Bluetooth connectivity, a battery and auxiliary port. 

See the EmStat4X product page on our website for more detailed specifications. 

 

Table 54 EmStat4X specifications 

EmStat4X specific 

model LR HR 

▪ electrode connections WE, RE, CE, 
and ground, 
with 2 mm banana plugs 

WE, RE, CE, S 
and ground, 
with 2 mm banana plugs 

▪ power consumption Typical: 1W (idle) 
Max: 1.6W (cell on at  
30 mA) 

Typical: 1.5W (idle) 
1.6W (cell on at 10 mA) 
Max: 4.6W (cell on at  
200 mA) 

▪ power source USB-C or internal LiPo battery 

▪ battery 
  

11.1 Wh capacity 
80% charge in 2.5 hours, full charge in 3 hours. 

▪ communications USB-C or Bluetooth (4.0 - Dual-Mode) 

▪ housing aluminum body: 11.4 x 8.0 x 4.5 cm 

▪ weight +/- 500 g 

▪ internal storage space 500 MB, equivalent to >15M datapoints 
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26 Sensit series 

 

Figure 387 The Sensit Smart (left) and Sensit BT readers (right) for use with Screen-Printed 
Electrodes 

26.1 Description 
The Sensit series comprises two models: Sensit Smart and Sensit BT. Both models are equipped 
with the EmStat Pico module, sharing identical main specifications and available techniques. 

26.1.1 Sensit Smart 

This model is a straightforward configuration featuring the EmStat Pico module housed with 
USB-C and SPE connectors. It serves as a compact, ready-to-use potentiostat that can be 
directly inserted into a smartphone or tablet. Control is achieved through the Android app 
PStouch. Alternatively, the Sensit Smart can be connected to a classic USB port on a PC using 
the USB-C Female to USB-A cable, allowing control through our PC software PSTrace. 

26.1.2 Sensit BT 

This model includes all features of Sensit Smart and extends functionality with additional 
components. It incorporates a battery, Bluetooth connection, internal memory, power switch, 
trigger button, and indicative lights. The Sensit BT connects to smartphones or tablets via 
Bluetooth, controlled through the Android app PStouch. Charging or PC connection is 
facilitated through the USB-C port, enabling control via PC software PSTrace.  



PSTrace Manual » Sensit series 

342 PSTrace Manual 

26.2 Operating the Sensit Smart 
The Sensit Smart is communicating and is powered via the USB-C connector 

The LEDs indicate in which state the device is in. The follow table shows which LED behaviour is 
linked to which device state. 

Table 55 Sensit Smart status LEDs indicators 

State Blue LED Red LED 

Powered and cell off ON OFF 

Cell on ON ON 

Fatal error Blinking 5x per second Blinking 5x per second 

Warning Blinking 1x per second Blinking 1x per second 

The Sensit Smart can be used with Screen-Printed Electrodes with the following properties: 

Table 56 Specifications for compatible SPEs 

Connection pad pitch 2.54 mm 

Electrode connections 

 

Allowed sensor thickness between 0.1 mm and 0.8 mm 

Maximum sensor width 11 mm 

For more information about making a connection to the cell, see section: Connecting a cell to 
the potentiostat on page 25. 

26.3 Operating the Sensit BT 
The Sensit BT comes in two different versions: SPE and SNS.  

The Sensit BT.SPE can be used for running sequential measurements on two different Screen-
Printed Electrodes (SPE’s) each with their own Reference, Counter and Working electrodes. 
The second channel can also be used in Bipotentiostat mode, functioning as second Working 
Electrode versus the Reference and Counter electrode of channel 1. Both Working electrodes 
are recorded simultaneously in the Bipotentiostat mode. A connector for a SPE with 2WEs is 
available under request. 

The Sensit BT.SNS has a lead connected to the WE of channel 2 and can be used out-of-the-box 
for BiPotentiostat measurements. The second Working Electrode (WE2) can either be set at a 
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potential offset with respect to WE1 or at a fixed potential with respect to RE1.The Bipotentiostat 
mode is supported in Low Speed mode for all techniques, excluding EIS and OCP.  

 

Table 57 Sensit BT specifications 

Sensit BT.SPE Sensit BT.SNS 

 
 

Sensor pitch 2.54 mm Cable length 40 cm 

Electrode 
connections 

2x  
CE, WE, RE 

Connectors 2 mm banana 

Allowed sensor 
thickness 

between 0.1 and 0.8 
mm 

Electrode connections RE, WE, WE2, CE 

Maximum sensor 
width 

11 mm  

 

26.4 Sensit BT trigger button 
The Sensit BT trigger button is not supported natively in PSTrace, but can be used with custom 
MethodSCRIPTs. The button can be configured in such a way that each push starts a 
measurement and stores the measured data on the on-board storage. 

 

Figure 388 Trigger button on Sensit BT 

See also section: MethodSCRIPT Sandbox on page 107.  

See our MethodSCRIPT trigger button example found on:  

www.github.com/palmsens. 

http://www.github.com/palmsens
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26.5 Sensit Smart and Sensit BT specifications 
The following table shows the specifications of the Sensit Smart and Sensit BT for each 
operational mode. 

Table 58 Sensit Smart and Sensit BT specifications 

 Low Speed Mode High Speed Mode Max Range Mode 

dc-potential range -1.2 to +2 V -1.7 to +2 V -1.7 to +2 V 

Dynamic dc-potential range * 2.2 V 1.2 V 2.6 V 

Compliance voltage -2.0 to 2.3 V 

Maximum current ± 3 mA 

Max. acquisition rate 
(datapoints/s) 

100 1000 100 

Supports FRA/EIS NO YES NO 

* The dynamic range is the range that can be covered during a single scan within the full 
potential range. For example, a linear scan can start at -1.5 V and end at 1.1 V or vice versa, 
covering 2.6 V dynamic range. 

See the corresponding product pages on our website for detailed technical specifications. 

26.5.1 Compliance voltage limitation 

The Sensit series are based on the EmStat Pico modules which have a limited compliance 
voltage. The compliance voltage is the maximum voltage that can be applied between the 
working and counter electrode. Another name could be the maximum cell potential.  

The Sensit series are based on the EmStat Pico modules which 
have a limited compliance voltage. 

The higher the current at the working electrode, the higher the current required at the counter 
electrode. To increase the current the potentiostat increases the potential difference between 
the working and counter electrode. At some point, the maximum cell potential is reached and 
cannot be increased further. 

This means the working electrode’s potential might not be correct anymore, because the 
correct current cannot flow through the counter electrode anymore. The potentiostat ran into 
its compliance voltage. The potential of the working electrode will stay at the last value it could 
reach. 
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During DPV or SWV this means the differential is 0 and thus the curve shows a sudden drop in 
current and stays at 0. In a Cyclic Voltammogram reaching the compliance voltage is clearly 
visible. The constant potential will lead to a current following the Cottrell equation: 

 

Figure 389 Typical CV showing an exceeded maximum compliance voltage 

26.6 Calibration 
The Sensit series has an internal automatic calibration routine which can be started in PSTrace. 
When connected to a Sensit-series device or EmStat Pico-based device, you can navigate via 
the menu: ‘Tools’ → ‘Instrument Settings…’ → button ‘Calibrate’.  

Your device is already calibrated. It is not recommended to run 
the calibration procedure, unless specifically advised by 
PalmSens BV. 

See also section: EmStat Pico Calibration on page 347. 
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27 EmStat Pico based instruments 

 

Figure 390 EmStat Pico potentiotat module  

The EmStat Pico is a small potentiostat module which is available as separate product but is also 
at the heart of housed instruments like the Sensit Smart and Sensit BT. EmStat Pico modules 
with correct license can be used with PSTrace. 

The EmStat Pico is built together with our partner Analog Devices Inc. 

27.1 EmStat Pico specifications 
See the OEM section on our website for detailed EmStat Pico specifications. 

27.2 Calibration 
The EmStat Pico (and Sensit-series) has an internal automatic calibration routine which can be 
started in PSTrace. When connected to a Sensit-series device or EmStat Pico-based device, you 
can navigate via the menu: ‘Tools’ → ‘Instrument Settings…’ → button ‘Calibrate’. 

Your device is already calibrated. It is not recommended to run 
the calibration procedure, unless specifically advised by 
PalmSens BV. 

The following parts of the signal chain will be calibrated: 

▪ ADC offset and gain; 
▪ LPTIA gain (100 nA is calibrated externally); 
▪ HSTIA offset and gain (100 nA and 1 uA are calibrated externally); 
▪ HSDAC offset and gain. 
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The auto-calibration will not affect the 1 uA and 100 nA calibrations values, which require an 
external reference. The complete procedure takes around 60 seconds.  
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28 Troubleshooting 

28.1 Running self-diagnostics 
The PalmSens4 has a built-in diagnostics tool which can be executed in PSTrace. This tool 
generates a detailed report showing any issues which might be present in the hardware. 

See for more information section: Self Diagnostics on page 307. 

28.2 Verifying your potentiostat 
Your instrument can be tested by using the test sensor or dummy cell supplied with the 
instrument.  

 

Figure 391 PalmSens Dummy Cell supplied with the EmStat4R SNS version. 

The easiest way to verify the functioning of your instrument is to use the “WE B” circuit, which 
consists of a resistor with a value of 10 kΩ with a max deviation of 0.1%. 

In case you are using the EmStat4R SPE version, connect the SPE dummy cell. Keep in mind that 
this SPE has a simplified Randles Circuit with an extra 560 Ω resistor in series with the 10 kΩ 
resistor.  
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Figure 392 The SPE dummy cell supplied with the EmStat4R SPE version. 

The WE lead is connected to one side and both RE and CE to the other side of the resistor.  

If your instrument has a Sense lead, make sure to connect the 
Sense lead to the WE lead as well. 

Any of the electrochemical techniques can be applied. The current response obtained with a 
resistor with value R is equal to the applied potential or potential pulse divided by the value of 
R. So, if a potential of 0.5 V is applied on a resistor of 10 kΩ, the obtained current should be 0.5 
V / 10 kΩ = 50 µA. 

Contact PalmSens BV if the problems are found: info@palmsens.com and report the problems 
as detailed as possible. 

28.3 Noise  
Our instruments are designed with hardware noise suppression filters to reject noise from 
internal and external sources. If a higher level of noise is your issue, the solving strategies are 
rather numerous, but the sources for noise are also numerous. Here we describe the most 
successful and common methods for noise reduction. 

To determine the noise levels for your instrument, please refer to section “Measuring the noise 
level of the instrument” of the PSTrace Manual. 

28.3.1 Power grid 

Your power grid is usually using an alternating current. This undulating current influences the 
measured currents. PSTrace and PStouch have a filter for this mains frequency. In PSTrace, 
check in the ‘Tools’ menu under ‘General Settings’ if the mains frequency is set correctly. 

28.3.2 Electrical fields 

Our environment is filled with electrical fields. Some of them are created by devices around us 
as side effects or in case of wireless communication on purpose. Although it is a bad idea to 
measure directly next to an electric arc furnace, it is usually not possible to have a workspace 
free of electrical fields, especially not during point-of-care measurements. A Faraday cage is 
usually sufficient to create a field-free environment. A metal box or cage out of metal mesh is a 
good Faraday cage. Even a shield out of aluminum foil can help. Place your electrochemical cell 
inside the Faraday cage and connect the cage to the ground lead (green) of the potentiostat. 

mailto:info@palmsens.com
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The cable delivered with your EmStat or PalmSens has an inbuilt shield and should protect your 
signal outside the Faraday cage. This is one of the most effective methods to reduce noise. 

28.3.3 Cables 

Cables should not be unnecessarily long, since they act as antennas for noise, but the cable 
delivered with your EmStat or PalmSens has an inbuilt shield and as long as you use the original 
cable, there is little reason to worry about cable induced noise. 

28.3.4 Grounding 

Ground your measurement equipment. The best way to connect your equipment is star-
shaped, that is all parts are connected with the ground at the same point. In an electrochemical 
lab that point is usually one small space of the faraday cage. This way earth loops that induce 
noise are avoided. 

28.3.5 Contacts 

Check if the contacts are corroded. If so, remove the stains, for example with sandpaper.  
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29 Updating firmware 

The firmware which runs on your instrument might need to be updated when a new version of 
PSTrace is installed. PSTrace will prompt a message and take care of the firmware update if this 
is necessary. 

29.1 Firmware update 
If a specific version of the firmware should be downloaded the firmware can be updated using 
the firmware update window found in PSTrace via the menu ‘Tools’ → ‘Instrument settings’... 

Normally this should not be necessary because PSTrace will prompt a message and take care of 
the firmware update if this is necessary. 

 

 

Figure 393 Instrument settings menu 

The ‘Update firmware’ button is found at the right top of the window: 

 

Figure 394 Instrument settings window 
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1. If not already connected; connect the instrument to the PC and in case applicable for 
your instrument; please make sure to connect the ac-adapter as well. 

It is essential that the instrument is not switched off or 
disconnected during the process of updating the firmware. 
 
In case of a PalmSens1 or PalmSens2:  
Be sure that the batteries are full or that PalmSens is connected 
to the ac-adapter. 

1. Now click the ‘Browse…’ button and select the appropriate HEX file. 
2. Now press the ‘Start update firmware’ button. 

3. In case of a PalmSens1 or PalmSens2 only: The window now tells you to press the four 
keys ‘Enter + Esc + < + > ‘ simultaneously. 

 
DO THIS ONLY ONCE! The updating process will start immediately after pressing the 
four keys. 

 

 

Figure 395 Instruction showing in case of a PalmSens1 or PalmSens2 to press the four keys 
simultaneously. 

4. If the instrument is in download mode, the status bar of the firmware update is shown. 
If this screen does not appear, the program can be closed and started again. 
 

5. After completing the update, the program will show “UPDATE COMPLETE”. 
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30 Maintenance and compliance 

30.1 Lithium-Polymer batteries 
The typical estimated life of a Lithium-Polymer battery is about two to three years or 300 to 500 
charge cycles, whichever occurs first. One charge cycle is a period of use from fully charged, to 
fully discharged, and fully recharged again. Consider a two-to-three-year life expectancy for 
batteries that do not run through complete charge cycles. 

Rechargeable Lithium-Polymer batteries have a limited life and will gradually lose their capacity 
to hold a charge. This loss of capacity (aging) is irreversible. As the battery loses capacity, the 
length of time it will power the product (run time) decreases. Lithium-Ion batteries continue 
to slowly discharge (self-discharge) when not in use or while in storage. 

30.2 Temperature compliance 
Our instruments are designed for indoor use at ambient temperatures between 0 °C and 45 °C. 
All the components of PalmSens products (except their batteries) are rated to the industrial 
temperature standard of -40 °C to +85 °C. 

The battery of the potentiostat is rated -20 °C to +60 °C when discharging 0 °C to +45 °C when 
charging. 

30.3 Humidity compliance  
PalmSens instruments have not been tested in high humidity environments. 

Elevated humidity however may cause measurement errors if condensation forms on the 
electronics. This affects measurements in the nA ranges or lower. Prolonged exposure to a 
condensing environment may severely decrease the life expectancy of the instrument and void 
its warranty. 

30.4 Temperature drift 
PalmSens instruments are calibrated at 21 °C. The most sensitive components of the instrument 
have temperature drift of 50 ppm. For instance at 1 °C or  41 °C, measurement drift of up to 0.1% 
may be experienced. 

30.5 Atmospheric pressure 
PalmSens instruments are not intended for use in safety-critical applications. Consequently, the 
power supplies utilized are not selected based on a specific pressure rating. 
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30.6 Cleaning 
Make sure to disconnect your instrument from any cell or power source, if applicable, prior to 
cleaning. Use a cloth lightly dampened with either clean water or water containing a mild 
detergent to clean the outside of the instrument. Alternatively, you can use isopropyl alcohol. 
Avoid using a wet rag and prevent any fluids from entering the instrument. It is crucial not to 
immerse the instrument in any cleaning solution.  

30.7 Periodic calibration and preventive maintenance 
PalmSens instruments are designed in a way that eliminates the need for periodic calibration. 
While not mandatory, PalmSens does provide a calibration service for users with specific 
demands such as QC/ISO purposes. This service includes a new calibration certificate. 

It's important to note that PalmSens instruments do not require preventive maintenance, 
further simplifying their use and reducing the overall maintenance demands on users. 

30.8 Service and repair 
Except for the battery in some models, your PalmSens instrument contains no user-serviceable 
parts internally. Any service or maintenance needs should be directed to a qualified service 
technician employed by PalmSens BV. Attempting to access or modify internal components 
without proper expertise may result in additional damage to the instrument and void 
warranties. It is recommended to rely on authorized service personnel for any required 
maintenance or repairs. 

30.9 RoHS Compliance 
All instruments from PalmSens have been built using lead free components and lead-free 
solder. They are in compliance with the European RoHS initiative. 
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Appendix A. CE Declarations of conformity 
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Appendix B. EU Waste Electrical and Electronic Equipment (WEEE) Directive  

 

 

The pictogram shown above, located on the product(s) and / or accompanying documents 
means that used electrical and electronic equipment (WEEE) should not be mixed with general 
household waste. For proper treatment, recovery and recycling, please take this product(s) to 
designated collection points where it will be accepted free of charge.  

Alternatively, in some countries, you may be able to return your products to your local retailer 
upon purchase of an equivalent new product. Disposing of this product correctly will help save 
valuable resources and prevent any potential negative effects on human health and the 
environment, which could otherwise arise from inappropriate waste handling. Please contact 
your local authority for further details of your nearest designated collection point. Penalties 
may be applicable for incorrect disposal of this waste, in accordance with your national 
legislation. 

 

 



PSTrace Manual » Index 

PSTrace Manual  365 

31 Index 

.pssession ................................................ 205, 235 

ac-voltammogram .......................................... 126 

Add notes ........................................................184 

amperometric measurement ........................... 32 

Analog In ........................................................ 209 

Analog Out ..................................................... 209 

Analytical mode .............................................. 214 

Auto peak search window ............................... 214 

auto ranging ..................................................... 34 

auto-ranging .................................................... 34 

autosave ........................................................... 36 

Autosave settings window ............................... 36 

Auxiliary port (PalmSens) ................................283 

auxiliay input ...................................................... 8 

backlight ........................................................ 289 

BiPot ............................................................. 8, 44 

Blank ................................................................. 45 

blank curve ........................................................ 35 

Bluetooth ..........................................................14 

Calibration curve ....................................... 213, 217 

capacitor ......................................................... 153 

CDC circuit editor .......................................... 140 

Cell On ........................................................... 209 

Cell volume ..................................................... 214 

chi-squared ..................................................... 165 

Chronopotentiometric Stripping ..................... 96 

circuit components ......................................... 137 

circuit editor ................................................... 137 

Circuit menu .................................................... 145 

Constant Phase element .................................. 153 

Control E or i .................................................. 209 

Corrosion ....................................................... 223 

Corrosion current ........................................... 223 

Corrosion potential ........................................ 223 

Corrosion rate ................................................ 223 

CSV ................................................................. 205 

Current Level or Peaks ...................................... 39 

current range ..................................... 34, 117, 209 

Curve calculations ................................... 184, 203 

Curve calculations window ............................. 203 

curve operations ............................................. 197 

Cycles .................................................. 80, 93, 101 

Cyclic Polarization ........................................... 221 

Data tab ........................................................... 176 

DC current ........................................................ 63 

decimal separator ............................................. 10 

differintegral............................................. 192, 195 

Digital Input .................................................... 209 

Digital Output................................................. 209 

double layer capacitance ................................. 153 

Dummy Cell ....................................................... 17 

E ac ............................................................. 63, 119 

E begin ....................................... 54, 63, 65, 72, 119 

E cond1 ........................................................... 222 

E cond2 ........................................................... 222 

E dc ........................................... 75, 82, 84, 101, 119 

E end.......................................... 54, 63, 65, 72, 119 

E equilibration .................................................. 82 

E level [n] ......................................................... 80 

E peak ............................................................. 214 

E pulse ........................................................ 65, 84 

E start .......................................................... 57, 61 

E step ............................... 54, 57, 61, 63, 65, 72, 119 

E step 1 .............................................................. 98 
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E step 2 ............................................................. 98 

E vertex1 ...................................................... 57, 61 

E vertex2 ...................................................... 57, 61 

E1(measure)...................................................... 86 

E2...................................................................... 86 

E3 ...................................................................... 86 

Edit Mode ........................................................ 136 

EIS Plot tab ...................................................... 175 

EIS Spectrum Analyzer .................................... 129 

Emstat4S ......................................................... 333 

Enable options for E corrections ...................... 10 

equivalent circuits .................................... 135, 229 

Excel ............................................................... 207 

Exporting curves ............................................ 207 

Extrapolate baseline ........................................184 

fast mode ....................................................... 289 

fit ..................................................................... 135 

Fit Mode .......................................................... 136 

Fixed baseline ..................................................184 

fractional derivative order ............................... 195 

Free baseline ...................................................184 

Frequency .................................................. 63, 119 

Frequency type ............................................... 119 

Gerischer element ........................................... 153 

i ac ................................................................... 123 

i applied ..................................................... 89, 101 

i begin ........................................................ 91, 123 

i dc ................................................................... 123 

i end ........................................................... 91, 123 

i forward/reverse ............................................. 69 

i level [n] ........................................................... 93 

i step ........................................................... 91, 123 

inductor .......................................................... 153 

Integration ..................................................... 203 

IUPAC ......................................................... 10, 179 

ladder .............................................................. 165 

Levels .....................................................39, 80, 93 

Linear Polarization ............................. 221, 223, 229 

linear regression ............................................. 203 

Linear Sweep Potentiometry ............................ 91 

Linear Sweep Voltammetry ....................... 54, 223 

Mains Frequency ................................................ 8 

Manual Control’ .............................................. 209 

Manual level.................................................... 184 

manually mark peaks ...................................... 184 

Max. frequency ................................................ 119 

Maxwell ........................................................... 165 

Measure vs OCP ............................................... 119 

Measurement tab ............................................ 117 

Min. frequency ................................................ 119 

Minimum Peak Height ...................................... 39 

Minimum Peak Width ....................................... 39 

mode ............................................................ 7, 84 

Multiplexer Channel ....................................... 209 

Multiplexer tab ................................................. 39 

n frequencies ................................................... 119 

noise level .......................................................... 51 

Non-linear baseline ........................................ 184 

Notes .......................................................... 29, 117 

Number of scans............................................... 57 

OCP ................................................................ 222 

Open Circuit Potential ............................... 33, 222 

Origin ....................................................... 131, 207 

Overlapping peaks .......................................... 192 

overload ........................................................... 22 

Override parameter’ ........................................255 

overstep ........................................................... 22 

Oxidation or Reduction .................................... 39 

peak separation window .................................. 192 

Peak window ................................................... 214 

Peaks ......................................................... 39, 190 

Plot tab ............................................................ 175 
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Polarization resistance .................................... 223 

Polarographic convention .......................... 10, 179 

Potential or Current ....................................... 209 

potential range ......................................... 34, 209 

printing ........................................................... 179 

Pseudo Polarography ...................................... 255 

real E step ......................................................... 29 

Recalculate ...................................................... 218 

resistor ............................................................ 153 

Sample volume ................................................ 214 

scaling ............................................................. 179 

Scan rate ................................ 54, 57, 61, 63, 65, 72 

Scan type ................................................... 119, 123 

script .............................................................. 243 

Settings .............................................................. 6 

simulate ........................................................... 135 

smart scaling ................................................... 179 

Smooth Window ............................................... 39 

Solution number ............................................. 214 

solution resistance .......................................... 153 

Stability............................................................ 119 

Standard addition ...................................... 213, 217 

status ................................................................ 22 

status bar .......................................................... 22 

stirrer ................................................................. 8 

Stirrer On ....................................................... 209 

stirrer speed ................................................... 209 

Stripping chronopotentiometry ...................... 96 

Stripping Current ............................................. 96 

sweep rate ........................................................ 54 

t [n]............................................................. 80, 93 

t 1 ...................................................................... 98 

t 2 ..................................................................... 98 

t cond1 ............................................................. 222 

t cond2 ............................................................ 222 

t interval .................................... 75, 80, 82, 84, 119 

t pulse .................................................... 65, 72, 84 

t run .................................... 75, 82, 84, 86, 119, 123 

t1 ....................................................................... 86 

t2 ...................................................................... 86 

t3 ....................................................................... 86 

Tafel slopes ..................................................... 223 

techniques list .................................................. 29 

TestSensor ......................................................... 17 

Three points ................................................... 184 

time domain .............................................. 119, 123 

underload ......................................................... 22 

Voigt ................................................................ 165 

Voltage overload .............................................. 22 

Voltammetric Analysis ..................................... 213 

voltammetric measurement ............................. 32 

Warburg element ............................................ 153 

warning message (method) ............................. 29 

WE2 Current Range ........................................ 209 

WE2 Potential.................................................. 209 

ZView ......................................................... 10, 130 

 

 


